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Tutorial Overview

Overview

In this tutorial you will be introduced to the OpenEdge Architect development
environment and how its features and tools make it easy to develop OpenEdge
applications.

When you complete this workshop, you should be able to:

Group and organize application files using Architect’s project-based environment.
Use Workspace Preferences and Project Properties to configure a development
environment.

Use Views and Perspectives to navigate and maintain resources.

Use the DB Navigator tool to view and modify database schema.

Use the OpenEdge Editor and its features to write application code.

Use Architect’s Debugger to debug applications.

Use the Tools for Business Logic to create ProDataSet and Temp-table models and
auto-generate ABL code from them.

Use the Visual Designer to create OpenEdge GUI for .NET application screens.
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Lab 1 — Setting up the Environment

Overview

OpenEdge Architect uses workspaces and projects to store and group application files.
Together, these features provide a robust way to organize and maintain source code and
other files associated with an application. Workspace Preferences and Project Properties
are used to configure and manage the working environment. The goal of this lab is to set
up a working environment for the AutoEdge application by creating a workspace and a
project, importing files, setting the Propath, and connecting databases.

The AutoEdge application is an example implementation of the OpenEdge Reference
Architecture (OERA). The application revolves around a fictitious automobile dealer
company and two dealerships. Information from each dealership is shared with the parent
company that handles consumer facing functions.

For more information about the AutoEdge application and the OERA, please visit the
Progress Software Developers Network at www.psdn.com.

Prerequisites

4

The OpenEdge Architect product and the AutoEdge application source code and database
files should reside in the following directories before starting this lab:

1. OpenEdge 10.2A (Enterprise Architect, OpenEdge Ultra .NET Controls) installed
in the C:\Progress\OpenEdge directory

2. AutoEdge application located in the C:\OpenEdgeTutorial2009 directory with
the following sub-directories:

— AutoEdge - This directory contains the source files for the AutoEdge
application.

— AutoEdgeDB - This directory contains the different AutoEdge databases in
their own subdirectories (autoedge, oerpcore, temp-db). This directory also
contains the two scripts for starting and stopping the databases (Startdbs.bat
and stopdbs.bat).

— Tmp - This directory is used to store temporary files, such as log files, for the
environment. If this directory does not already exist, please create it.

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting Architect and creating your first Workspace

This section shows how to start OpenEdge Architect.

1.

Start Architect by selecting Start->Programs->OpenEdge-> OpenEdge
Architect. The Workspace Launcher dialog appears.

Set the Workspace to C:\OpenEdge\WRK\AutoEdgeWS. This will create a new
physical directory at that location (if it does not already exist) and set up the basic
Workspace environment.

@'Workspace Launcher x|

Select a workspace

Openkdge Architect stores wour projects in afolder called aworkspace.
Choose aworkspace folder to use for this session.

j Browse... |

Workspace:

™ Use this as the default and da nat ask again /

K [1 I Cancel

®Tip: As shown above, there is an option to set the currently configured
workspace as the default workspace. Setting this option will stop Architect from
prompting for a workspace every time you open the tool and automatically open
the given workspace. You can switch to other workspaces at any time by selecting
File->Switch Workspace. It’s common for developers to work with multiple
workspaces, so many leave this option unchecked since they find it convenient to
be prompted for the workspace to open when starting Architect. This option,
along with many other workspace options, can be modified using Workspace
preferences, which will be covered later in the lab.

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting Architect and creating your first Workspace, continued

E}Note:

The following are some important notes regarding workspaces:

Multiple projects, even of different types, can co-exist within a
workspace.

All files created during the application development process using
Architect are contained in a workspace.

Architect monitors changes made to any resource files and keeps
information about those files. This includes code errors, file
reference dependencies, and file locations. This information is kept
in the Workspace’s state data files.

Changes made to source code files outside of Architect’s
environment will not be reflected in Architect until a refresh is
made on the workspace. This is usually accomplished by selecting
the File—>Refresh menu option.

Y ou may have multiple workspace areas set up for your
development environment.

Workspaces can be physically located anywhere on your system or
on a network drive. However, workspaces can only be used by one
developer at a time. Because of this, it makes sense to keep your
workspaces local to your computer. However, a workspace’s
projects and resources can be shared either through
exporting/importing or by using Source Code Management plug-
ins.

E}Note: What if you want to move a Workspace to a different physical directory?
This can be done, but you will need to make a few changes. Use Windows
Explorer to either move or make a copy of the workspace. Start Architect and
enter the directory location for the new Workspace in the Workspace Launcher
dialog. Once you start Architect, you will need to change any properties that were
pointing to the old physical directory such as the PROPATH. The changes can be
minimized by using Configuration Variables (see on-line help for information on
Configuration Variables). One area that will need to be changed is the working
directory in the project settings. To change the working directory, go to the
OpenEdge project properties and select the Browse button.

6
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Lab 1 — Setting up the Environment, continued

Starting Architect and creating your first Workspace, continued

3. Click OK. An Architect splash screen will display the loading status.

OpenEdge. Architect 10.2

1t n_II_II_I_II_I L]
dEEEEEEEEE

Loading com.openedge. pdt text

Progress Saftware Corporatian
All rights raserved SOFTWARE
ERRERENNNNNNRENEN

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting Architect and creating your first Workspace, continued

4. A Welcome to OpenEdge Architect screen appears with links to common tutorial
and help resources for the Architect product. Select the Go to Workbench icon in
the top right corner of the screen.

@ OpenEdge Editor - OpenEdge Architect - C:\OpenEdgetwWRKiAutoEdge
File Edit Mawigate Search Project OpenEdge  Run Window  Help

2

Go to Workbench

OpenEdge Product Tour

Ge rted by taking a tour of OpenEdge

What's New

Learn about what's new in this release of OpenEdge Architect

OpenEdge Architect Help

Learn more in the extensive help system

OpenEdge Education

Visit Progress Education for information about available training courses

OpenEdge Documentation

Download documentation and Web papers for any OpenEdge product

PSDN

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting Architect and creating your first Workspace, continued

The Workbench is displayed showing the OpenEdge Editor perspective. The workspace
will have been created and you are ready to create your first project.

@'DpenEdge Editor - OpenEdge Architect - C:\Ope
File Edit MNawvigate Search Project OpenBdge Bun Wi

| it | LW H -0~~~ |5~

4

E |3§E OpenEdge Editar
£ Besources B2 . = 0
e

o= Outline 22 [EF¥DBSt. Ol Prop.. | — 0O
An utline g nanenoilghiRea sttt tonial st i it

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting Architect and creating your first Workspace, continued

g‘l-\' 1-.‘\"1"""------__-_-1-u----ur-..|.-..,.__.,| e e e e T -— o B [-

'E\i = M. FProblems | Tasks =B -rj= 50

Mo consoles to display at this time.

] o
5
)

N
J I o]

@Tip: The Welcome screen is hidden and can be easily recalled by selecting the Return
to Welcome icon (@) in the lower right corner of the screen. Also shown above is the
OpenEdge Architect Help icon (@) which opens the OpenEdge Architect Help screen.
Both of these icons can be removed by right-clicking on the icon and selecting Close.
Another way to open the Welcome screen or the OpenEdge Architect Help screen is to
select their respective options from Workbench’s Help menu.

continued on next page
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Lab 1 — Setting up the Environment, continued

Creating an OpenEdge Project

A project is a collection of associated application development files. These files can be
source code files, data files, documentation files, images, etc. Folders can be used in a
project to organize these files. Architect also keeps some metadata for your application
files in a project. This section shows you how to create a project.

1. From the Architect menu bar, select File>New—>Project.

2. Inthe New Project dialog, expand the OpenEdge node and select OpenEdge
Project. Click Next.

@ New Project x|

Select a wizard

Create a new OpenEdge project

YWizards:
|type filter text

B- General

seos @
EH& OpenEdge

g OpenEdge Project

7) zEze NexﬂEI Frien || caneal |

®Tip: A common feature in many Architect screens is the fill-in (@) at the top
of a selection which allows you to filter the selection list. For example, in the
above screen a user could type an “O” in the Wizards fill-in to reduce the selection
list to show only the OpenEdge folder of options. For this case, where there are
only three entries, this feature is of limited use. However, if you are working with

a lengthy list of options, the filter can be used to quickly locate the selection for
which you are searching.

continued on next page
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Lab 1 — Setting up the Environment, continued

Creating an OpenEdge Project, continued

®Tip: You can skip the New Project wizard screen and move directly to

OpenEdge Project dialog by selecting File->New->OpenEdge Project or the
New button and selecting the OpenEdge Project option as shown below:

@'DpenEdge Editor - OpenEdge Architect -
File Egff MNawvigate Search Project OpenEdge

| | A LB | H~0 -~ |45 §

F 7 Project.

&= OpenEdge Project k I =
|c] ABL Class B v
[ ABL Interface
|F| ABL Procedure
[i' ABL Include
[ = Folder
“ File
SR AL FRrE e P P
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Lab 1 — Setting up the Environment, continued

Creating an OpenEdge Project, continued

3. In the New OpenEdge Project dialog, enter AutoEdge for the Project Name.

@ New OpenEdge Project =15
New OpenEdge Project

I —

Create anew OpenEdge project.

Froject name: |AutDEdge

M Use default location
Location: |C:ROpenEdge'xWF{K\,»-‘-\utDEdgeWS“ﬁutDEdge ErEwee... |

~Froject Layout

% Use project root directary for source and rcade.
" |se separate source and rocode directaries.

I EachanE ront: |5r|:

I | Erade ditectan: |bin

~Fackage

I Initial package: |

7) <Back e Finish” Cancel |

“Tip: The directory path for the new project is shown in the Location area(®).
This is the location where the project and its associated files will be stored
physically. By default, Architect creates a subdirectory in the current workspace
directory using the name of the project. You can choose to locate the project in a
different directory by un-checking the Use default location box and then entering
a directory in the Location fill-in.

continued on next page
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Lab 1 — Setting up the Environment, continued

Creating an OpenEdge Project, continued

4,

Click Finish. The project will be created. The Powered by Progress splash screen
will appear briefly showing that a Progress session is started for the Project.

Powered by

PROGRESS

2l

SOFTWARE

Once the run-time has started, you will see the project listed in the Resources
view:

[d OpenEdge Editor - OpenEdge Architect -
File Edit MNavigate Search Froject OpenEdge R

e | AL B [H-0-Q@- |5~

@J_ﬁﬂ‘ OpenFdoe Editar

£ Resources B2 = 0
=

A= s

AutoEdge
---J L Procedure Likbraries

...... .prDjEC’[ -/

_J.t.“_____‘_q__?r--\_.___‘,_w_w _..._’_,pl'ﬁ-\...
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Lab 1 — Setting up the Environment, continued

Creating an OpenEdge Project, continued

You will also see a “started successfully” message in the Console box showing that
the AVM was started for the project.

G T | T i R i T L e S
4

ﬁ El Consale Eﬁlt Prn:ublems| g Tasks| % 0d| 4 B0
E_; ABL Consaole

'-}J Project 'AutoEdge' AVH needs to be started first. :I
J'} OpenEdge AVM started successfully for 'AutoEdge’' .

;

%

=
Eol of
F ==
{ J | ==

E}Note: The following are some important notes regarding projects:

e You may have a single source file or many source code and
development files associated with a project.

e All projects have a type. By having a specific type, a project can be
associated with the tools that are needed to manage the project.
Other aspects/details can be tailored for the project, such as how to
store metadata or what special configuration options are needed.
Most of the time, you will use projects that have an OpenEdge type.
However, you could have Sonic, Web, and other types of projects.

e Projects can be shared. They can also be integrated with Source
Code Management (SCM) tools for team development. This makes
logically grouping application files by module or functional unit
very important.

e Projects make coding management easier because project’s
preferences and setup information can be shared among developers
and system wide standards can be implemented.

continued on next page

OpenEdge Architect Tutorial 2009 15
Copyright © 2008 PSC



Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application

The best way to move and/or share a project’s resources is to use Architect’s importing
and exporting capabilities. This part of the lab shows you how to import existing
application files into the project.

1. Before importing files, disable the Build Automatically option by selecting
Project->Build Automatically from the Architect menu. This will uncheck the
option. Disabling this option speeds the importing process, especially when there
are a large number of files.

@'DpenEdge Editor - OpenEdge Architect - C:IDpenEdge\WRKLAt
File Edit Mawigate Search | Project OpenEdge Run ‘Window Help

| | L% |3 @ Praject
iy |3§E OpenEdge Editar D
£ Besources B2 Bl A CirlE

| = Euile Eroject

Build *aorking Set 2
BRE] - toEdge | ?

Clean...

---J L Procedure Likraries

Build Automatically

P |_| .prDjEE’E A
Festart OpenEdge ANhd
Clear OpenEdge Cormpile Errors
Froperies
T S S T R i, gt A e ““"""'"“"‘"‘""""‘vx' o
continued on next page
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Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application, continued

2. Right-click on the AutoEdge Project in the Resources view and select Import.

@'DpenEdge Editor - OpenEdge Architect - C:\Ope
File Edit MNawvigate Search Project OpenBEdge  Bun W
Jf"jv |0'|—0J{|__\_’_.I%Jﬁvav%ngi-v
& |3§E OpenEdge Editar
£ Resources B2 V. = O ||
EEN
---JL Frocec [+ ey *
[ .projec. Golnto
Cpen in Mew Window
= Copy
Fasie
i Delete
Move..
Fename...
o= Outl.. 52 | B9
Anoutline is nota .3 Expoart...
Build Project . P
2 | Refresh
i+ o pgpienns D2 ROIC G e e e g
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Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application, continued

3.

Next.
Ed Import x|
Select

Import resources from the local file system into an existing i ? ! 5 I
project.

In the Import window, expand the General node and select File System. Click

™,

Select an import source:

|type filter tend

== General
 ~[§ Archive File
g% Breakpoints

-1 BExisting Projects into Workspace
R il System

.=l Preferences \
H-= CVE

H-= OpenEdge
F-= Team

(7) < Baeh et » ! Fitirah

Cancel
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Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application, continued

4. Click on the Browse button next to From Directory field and select the
C:\OpenEdgeTutorial2009\AutoEdge directory. Click OK.

File system

Source must not be empty.

Import from directory

I3 OpenEdge
= ) OpenEdgeTutorial 2009

=l . toF e

= sic \
= AutoEdgeDB
) CVSROOT

= tmp

k‘

ISR

continued on next page
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Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application, continued

5. Expand the AutoEdge node and select the check box next to the Src entry. Also
check the box next to the assemblies.xml file entry in the right pane. This file
includes reference pointers to some supporting files needed for the application.

Click Finish.
[ Import =1 E3
File system —
. J 7
Impart resources fraom the local file system. f
-
From directony: IC:'\,OpenEdgeTutDriaIEIZIDB"Vﬂ\utDEdge j Browse... |
= [F = AutoEdge [#] @ assemblies.xml
m-[e] = sre \
Filter Types... | Select All Deselect All
Into falder: |AutDEdge Browse... |
Options

™ Owerwrite existing resources withaoutwarning
" Create complete folder structure
~ Create selected folders only

/

7 <Back s Finish&l Cancel

continued on next page
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Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application, continued

A bar at the bottom of the Import dialog displays the status and progress of the import.

o e e T e '#4__’,,‘_,_...-.,,«-,__,..../----,,\,,..._,_'_.l'__p—--.,,\"_.,.r’--r-v-—w—wnv."u L
[tE e |Autu:uEdge HhEwse...
WaEtiEns

= | iennite existing resaurses withautwarming
) Create complete falder strisine
%] Create selected falders ol

Impaorting: ChOpenEdgeTutorial2009AutoEdgelsroiguitcontralsimscomet? ocx j

7 <Back Mesxt > | Fooh | cancel |

When finished, the new resources will be shown in the Resources view. You can
expand the folder nodes to view the imported resources.

£ Resources B2 = O

A= s

Referenced Assemblie
#-JL Procedure Libraries
B sre

-2 crystal

W qui |
[E: netc
Er server

[Ev shared
\ F-% annicesh ./‘ LI

o

continued on next page
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Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application, continued

6. Next you need to create a directory to store compiled source code. Right-click on
the AutoEdge project in the Resources view and select New->Folder.

[d OpenEdge Editor - OpenEdge Architect - C:\DpenEdge\WRKLAuto
File Edit MNavigate Search Froject OpenEdge FRun  Window Help

Jl=“_7* |¢T¢J41J%Jﬁ"@'%'JJ"J T b T
EJ’|3EE OpenEdge Editor
£ Resources B2 J/ = 5 || L

AutoEdoge

"f}g Fe = OpenEdge Project

m-JL Prc. Golnto = Project...

56 sre - -
i Open in New Window 5 ABL Class
o = Loy 1] ABL Interface
Faste \Fi ABL Procedure
n-= 9% Delete lif ABL Include
@ towve...
E Rename. .. “ File

o= Outine 22 . import =4 ABL Form

ABL Dialog

Anoutline isn .2 Export.
e BXp =2 ABL MDI Farm

Build Project [+*] ABL User Control
2 Refresh [ 1 ABL Inherited Contral
Close Frojedt D
- Other... Ctrl+l [

Clzeellnrelsied Brajects

J I "'"—‘!--\.r“ B il ol bl oy el _\_—‘,.L.‘.L_.h-‘__“_"__

N T

continued on next page

22 Architect Tutorial 2009
Copyright © 2008 PSC



Lab 1 — Setting up the Environment, continued

Importing the AutoEdge application, continued

7. Specify the folder name as rcode and click the Finish button. In the next section,
you will configure Architect to store compiled source code in this directory.

@ New Folder
Folder

Create a new folder resource.

—,

Enter or select the parent folder:

|AutDEdge

it o =

2 AutoEdge

Folder name: Ircude

Acdvanced >» |

/

Finish : I Cancel

& Besources 23 =0
A
= 2 AutoEdge -

H-a® Referenced Assemblies
#-JL Procedure Libraries
----- [= {{alulul=}

[—]Eb srC \
£ crystal

= gui

= netct

= serser

- sharard ;I

R = N e e B

+
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Copyright © 2008 PSC

continued on next page

23



Lab 1 — Setting up the Environment, continued

Setting Project Properties

After importing files into your project, the next thing to do for a new project is to set its
project properties. These properties control how the project interacts with the working
environment, such as where to store compiled files. This section covers how to set some

basic project properties.

1. Make sure that the AutoEdge project is selected in the Resources view. From the
Workbench menu, select Project->Properties.

- server

[d OpenEdge Editor - OpenEdge Architect - C\OpenEdge\WRK\Auto EdgeWws

File Edit MNawvigate Search | Project OpenEdge  Fun ‘Window  Help
v | = J A e Braject
L=;3’|3EE DpenEdge Editor ClE) PSS
& Resources 3 ave BUlEl Al Ctrl+B
Build Project
............................... Build Waorking Set *
H-a? Referenced Assemblie gle.lzn(; -
AL Procedure Libraries uild Autormatically
----- = rcode Festart OpenEdge Al
El[& Src Clear OpenEdge Compile Errars
(= crystal
- netef

F.-[= sharer

““'“M‘“ _‘l_-:rd\-l_u_-._‘_ T R S
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Copyright © 2008 PSC

continued on next page

Architect Tutorial 2009



Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

2. The Properties for AutoEdge dialog appears. Since project properties are
properties for a specific project; the project name appears in the title of the dialog.
In the left pane of the Properties dialog, select OpenEdge to display the OpenEdge
project settings for the selected project.

3 Properties for AutoEdge
|type filter tend DpenEdge
- FResource
- Builders Change Profile | Current profile: Default
- AppBuilagr Currentswersion: 1024 Inst
- Assamblies
- Build Working directaon: |C:f0penEdge,"WFiK,fﬁu
- Custom :
Temp directory: C/OpenEdgefyYRE
- Database Connechion i o I L .
- PROFATH Starup parameters: |
- WehSpeed W Add default parameters:
- Project References ~debugalert-inp 16000 -tok 4000 -reread
- Refactoring Histary _
- Pun/Debug Settings ™ Use TT far runtime
T T N J— Sak _amm o el s e A

The OpenEdge project settings allow a number of OpenEdge options to be set
including the working directory, the temporary directory, and startup parameters
for the AVM.

%}Note: Default startup parameters for projects are inherited from the workspace
preferences. This saves time since most developers use a common set of startup
options for each of their projects. These inherited parameters can be changed or
removed by un-checking Add default parameters.

<> Caution: While you could connect to a database using startup parameters on
this page, it is recommended that you create database connections through
Connection Profiles (discussed later) for a number of reasons. For instance, it is
much more difficult to diagnose connection problems if they occur, using startup
parameters. Plus, Connection Profiles can be shared among multiple projects.

continued on next page
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Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

3. Set the temporary directory to C:\OpenEdgeTutorial2009\tmp. This helps to
separate the temporary files from other files such as logs that are by default located
in C:\OpenEdge\WRK. Note that this directory must already exist and was part of
the pre-requisite setup for this lab.

'_dge !Em
[

{| OpenEdge = T
! e

] Change Praofile | Current profile: Default

| Currentwersion: 10,24 Installation: C/Frogress/OpenEdge

“orking directany: IC:,-’OpenEdgeMRKﬁAutDEdgeWSfAutDEdge Browse. .. |
3

5 Temp directany: IC:"I,OpenEdgeTutDriaIEDElEl“-,tmp
! L

q; Statup parameters: | ™~

{ W Add default parameters:

& -debugalert -inp 16000 -tak 4000 -rereadnolack -5 200 -mmax 65534

¥

!

il T UseTTY far runtime

e MWMAHM-WMMAMMFMW

continued on next page
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Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

4. If not already expanded, expand the OpenEdge node in the left pane and click on

B

uild.

[ Properties for AutoEdge

|1ype filter text

't

Lo g el mnm e s, it

- Resource

- Builders

- OpenEdge

- AppBuilder

\i Assermblies

- Cu st!}g

- Database Connection
- PROPATH

-WehSpeed
- Project References

- Refactaring History
- Fun/Debug Settings

5. Specify the rcode directory that you created in a previous step
(C:\OpenEdge\WRK\AutoEdgeWS\AutoEdge\rcode) for the Build destination

field.
Fdge _[O] x|
} Build P
H
'_-'_I_
:‘ V¥ Save r-code (also enables include file tracking)
;’;' ¥ Build only when source files are newer than r-code /
k Build destination: |nEdge‘-,WRKV—\utDEdgeWSV—\utDEdge\rcude Erowse...
J; Static file destination: | Browse...
¢
{1 XCODE key: |
9
\ FPre-compile callback routine: | Browse... |
g:! [T Create cross-teference files in XhL format
L
¢ XREF <ML destination: | Briawee. I

W‘WW eltn e e nn

continued on next page
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Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

EE:l'Note: You can also set up build directories while creating a project in the New
Project dialog area shown below.

[ New OpenEdge Project

New OpenEdge Project
Create a new OpenEdge project.

v

i |

R e |
|l =i =1 =t |

- —

IR

continued on next page
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Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

6. Select the PROPATH option in the left pane to open the PROPATH options.

3 Properties for AutoEdge

|type filter tend

- FResource

- Builders

= OpenEdge

- AppBuilder
- Assemblies
- Build

- yehSp EE
- Froject References
- Fefactoring Histony

- Custom
‘- Database Connection

PROPATH

uf PROPATH | 32 Source |

-2 @OWORK]

w-JL Standard GUI Libraries
w- L Standard TTY Librarias
---JL Installation Paths

&L Standard WebSpeed Paths

R e L Ll P PR SRR R e Y
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Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

7. Select the Add Directory button. Select the src=>gui entry and then select OK.

[[d Select PROPATH Directory x|

= 2 AutoEdge

[ rcode

B-& stc
E? crystal
[E: hetcf
I.E? server
IEP shared
IEP sonicesh
- winform

] & | Cancel

continued on next page
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Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

8. Repeat this process for the following PROPATH entries:

— src\gui\puredgltv
— src\server
— src\shared

9. Use the Move Up and Move Down buttons to locate the added directories in the

following order and after the @ {WORK} PROPATH entry.

dge O] x|

e

.

e

=

H-JIL Standard TTY Libraries
+- AL Installation Paths
+- AL Standard WebZpeed FPaths

R

e e, S i o ek M, ""'*M\..*‘*-u‘h—-.. »‘%Hﬁq.iaﬂﬂ.qﬂl\&... - -

‘ Add Procedure Library...l

PROPATH =1 T
{  uh PROPATH |3 Sourcs |
5 = @IWORK] Move Up |
B0 E@IROOT archgui
5B @{RO0Thsrciquipuredgity Mowe Down |
M- E{RO0Thsrc\serer
B @{RO0Thsrcishared Pizingyi |
w-JL Standard GUI Libraries Edit_ |
B
[#
B

Add External Library.. |
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Lab 1 — Setting up the Environment, continued

Setting Project Properties, continued

10. Select the Source tab and click on the Add Folder button. Select the src folder

entry and then click OK.

. =Y
fH : - o=
(B ] Solect Source Folder x|

13

FOPA— = 2 AutcEdge

o] il roode %

§ = / Add Folder...l
: E-= crystal

: 5@ oui JREEEEN
5 B netcf =i
4 [E% E=1a%=T

§ [E% shared

L [E% sonicesh

i] &= winform

%

i

:

i

._|:I

i

/

L

%

; W

}

i oK Cancel

| I\f'.- ance |

5 ok |

Cancel

T

et

The directory will be added to the Source list:

-
e

P

o o] x|
%DPATH -
jufs PROPATH 3 Sourc |

B @IROOTHere

\

T p————

P

i e TP I PP ol A e, o "'l-ﬂ""‘-""“"‘----u..h._.__, .

Add Folder...

Remowve

e

Edit...

11. Click OK to close the Properties for AutoEdge dialog.

32
Copyright © 2008 PSC

continued on next page

Architect Tutorial 2009



Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections

This section shows how to start the databases for the AutoEdge application and create
database connection profiles for those databases. These connection profiles are created
using Workspace Preferences and can be used by any projects in the workspace that need
access to those databases.

1. From Windows Explorer, navigate to C:\OpenEdgeTutorial2009\AutoEdgeDB
directory and double click on startdbs.bat file to start all the databases required.
Press the spacebar once the script has finished executing.

BROKER @: Started for 9808 uwusing TCP IPU4 address 127.6.8.1, pid 4512.':

Release 18.2A0 as of Mon MNow 3 22:0%:81 EST ZOH8
BROKER This broker will terminate when session ends. (5485)
: Multi—uszer session begin. (333>

BROKER @&
BROKER #@A: Begin Physical Redo Phasze at 64 . (53262
BROKER @: Physical Hedo Phase Completed at blk 188 off 5328 upd 8. (71
5]
5]
a

BROKER : At end of Physical redo. transaction tabhle size is 128. <135

14:54:07 BROKER : This sevrver is licensed for local logins only. (43%93)>
13;23;?7 BROKER : Started for 9818 uwsing TCP IPU4 address 127.8.8.1, pid 2596.

OpenEdge Release 18.2A as of Mon Mov 3 22:05:81 E:ST 2088
BROKER This broker will terminate when session ends. (5485)
BROKER : Multi—user session begin. <3332
BROKER : Begin Phyzical Rede Phasze at 8 . <5326>
BROKER : Physical Hedo Phase Completed at bhlk 1 off 2687 upd #. (M6l

BROKER : At end of Physical redo,. transaction tahle size is 128. (135

BROKER : This server is licensed for local logins only. <43%93>
BROKER : Started for 9020 wsing TCP IPU4 address 127.8.8.1, pid 5584,

Press any key to continue . .

2. From Architect’s menu bar select Window->Preferences. The Preference dialog
for the Workbench is displayed. Preferences that are set here apply to the entire
workspace.

continued on next page

OpenEdge Architect Tutorial 2009 33
Copyright © 2008 PSC



Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

3. In the left pane, select OpenEdge Architect->Database Connections. The
Database Connections page is displayed on the right.

|type filter text Database Connections
- General
-- Help Cannection Name I Group I Fhysical Mame | Other Farameters
al- InstallflUpdate
= OpenEdge Archit

-- Advanced

£
1
i

PRI S = sr— W““'“‘"“‘M At

4. Click the New button to add a new Profile Connection. The Add Connection
Profile wizard is displayed. This first page of the wizard allows connection
information to be entered for an ABL connection to an OpenEdge RDBMS.

5. For the Connection name enter autoedge. For the physical name enter
C:\OpenEdgeTutorial2009\AutoEdgeDB\autoedge\autoedge.db. The Browse
button can be used to locate the database.

@ Add Connection Profile Hi=

Add OpenEdge Database Connection

Enter the physical name of the database with which wou want to connect.

4
" o

Fhysical name: |C:HOpenEdgeTutDriaIEIZIIZIQk,ﬂxutn:uEdgeDEI\,autoedge\autDedge.

Connection narme: |autn:uedge

Optian
- ‘Lmh -u-..-.u___-,.-.-t M""—""‘“"“\HT-M "r““-\ \_w—""“"“k.-ﬁl“"” -4

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

6. For the other parameters enter:
— Description: Main AutoEdge Database
— Hostname: localhost
— Service/Port: 9000

- b e b e el T i &b 1% i i
- =

T g W g

Caonnection narme: |autn:uedge

Physical name: |C:HOpenEdgeTutDriaIZEIIZIB"Vf-\utDEdgeDBRautDedge\autDedge.

Browse... |

~Dptional

Description; bain AutoEdge Database

[
[

Logical name: | r /"
Service/Port: [3000]

Host name: |Ic|c:alh|:|st
ser D | FPassword: |
Aligses: I Group: I j

Other parameters:

Test Connection

. L

Ijg}Note: The Service/Port field will accept either a service name or a port
number. If using a service name, make sure that it is defined in the services file.

The services file is typically located in the following directory:
CA\WINDOWS\system32\drivers\etc\services.

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

7.

Click the Test Connection button. The OpenEdge ABL database connection is
tested against the AVM associated with the AutoEdge project. If the connection
can be made, a “Connection succeeded” message will be shown. Click OK.

[d OpenEdge Database Connection |

\lj) Connection succeeded.

Ijg}Note: If there are multiple projects in a Workspace, then a Select Project dialog
is displayed and you must pick one of the workspace’s projects to test the
connection against. If no project is defined for the Workspace, the Test
Connection cannot be performed since the connection is tested against an AVM
which must be started by an OpenEdge project.

If the connection fails, then confirm that that database is started and is using the
correct port number. Try the test again.

E}Note: The test connection is made using a unique logical database name that is
generated internally. So even if the selected project’s AVM is already connected
to the database, the test connection can still be run.
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Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

9.

10.

Click Next to go to the next page of the wizard. This page is for entering SQL
Connection information for the database.

[ Add Connection Profile

Specify whether to define a SOL Connection

W Define SOL Connectian
% Add new SOL connection ¢ Use existing SOL connection

Existing SOL connections
Namel LREL | Driverl Databasel Host:

el gt A A g g P e

@Caution: If a SQL connection is not needed, then the Define SQL
Connection can be unchecked and you can move to the next page of the wizard.
However, it is recommended that a SQL connection be configured in most cases
since it is used by a number of the tools in Architect. Without a SQL connection,
some of the tools, such as the DB Navigator, will not connect to that database.
Also, if there is a SQL connection already defined for the database, then you can
select the Use existing SQL connection option and select the entry from the
Existing SQL connections list.

EE}Note: As a general rule, ABL connections are used to run code against the
database, such as through the OpenEdge Editor and OpenEdge Debugger tools.
SQL connections are used to gather schema information and change database
schema, such as through the DB Navigator tool.

Confirm that the option to Add new SQL connection is selected and then click
Next. The Add Connection Profile page for the SQL connection is displayed.

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

11. A nice feature of the wizard is that all of the information that was entered on the
wizard page for the ABL connection is automatically filled in for the SQL
connection. Confirm that the Host name is localhost and that the Port is 9000.
Enter autoedge for the User ID and password for the Password. Finally, check
the Open on Eclipse startup option. This will start the SQL connection each time
the Workspace is opened.

[d Add Connection Profile

Add SOL Connection Profile
Selectto start the connection when OpenEdge Architect starts.

Connection narme: Iautuedge

Driver: IPngress OpenEdge JDEC Driver (DataDirect) j
LIRL: |jdbc:datad?¢enedge:ﬁlncalhn:ust:BElEID;databaseName=autDedge.db
Llzer D |autn:uedge

W Open on Eclipse startup:

/ V¥ Auto-Lagin on cannect

¥ UEL details
~URL details ”

Host name: IIDcthust

Fassword: |uuuu

" Senvic & Port [9000

Database n : Iautuedge.db

S0L parameters: I

Test Connection |

L "‘--~--4—~«t*._r'l"'--r_‘"““ IR e e N "H“"r s ¢*fﬂ

12. Click the Test Connection button. The SQL connection does not require a project,
so no project selection is displayed. If the connection succeeded, a success dialog
will be displayed. Click OK to close the message.

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

13. Click Next. The Define Database Server Configuration page is displayed.

This area allows you to set the database broker to be started whenever the
connection profile is used, such as when opening a project that is tied to the
connection profile. Since there already is a database broker started outside of
Architect for this database (you did this by running the startdbs.bat script), this
option is not needed.

Ijg}Note: For cases in which a database broker is already started and the options
are configured to auto-start a database server, the options are ignored.

@Tip: For cases where you decide to have the database broker started using this
option, the option on the SQL connection wizard page to Open on Eclipse startup
should be unchecked for this database, since a broker will not be running when
Architect initially starts up.

14. Uncheck Auto-start database server.

[ Add Connection Profile

Define Database Server Configuration

Selﬁtyutumaﬂcally start a database server when the DpenEdge Architect runtirg
stal

™ Auto-start database server

Fhwsical name: |C:HOpenEdgeTutDriaI2IZIEIBﬁ,ﬂxutuEdgeDBHautDedgehautDedge.d

Service/Port.  |9000

Farameters:

el . ‘t‘*r“_ﬂﬂ-x;._w__..,ﬂ.ﬂ\.,__m_u ',..A_.H_“_‘_ﬁ_,.q_\_‘_“_‘

E}Note: As noted above, the database has already been started outside Architect
and so you don’t need to start it from here. If you had not started the Database
before, you could leave Auto-start database server check box checked and the
database would be started when you assign the connection to a project.

continued on next page
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Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

15. Click Finish to complete the wizard. The newly created database connection
profile is listed in the Database Connections grid. The connection information also

is shown in the Connection string area.

®

“;’ Database Connections = T
4

I"p Cannection Mame | Group | Physical Name Mew... |
“ autoedoe ChOpenEdoeT...

i Edits. |
{I

; e |
L

¥

£

<

g Import... |
4’:: Export... |
I}

:

AN Kl | [

K Connection string: ‘/

HREL i’

5 C:“-,OpenEdgeTutn:uriaIEEIEIB".AutDEdgeDEi'ﬂ,autcuedge"-,aumedge.db-H_I

R e e

40
Copyright © 2008 PSC

continued on next page

Architect Tutorial 2009



Lab 1 — Setting up the Environment, continued

Starting the Databases and setting up Database Connections, continued

16. Follow the same procedure to create connection profiles for the oerpcore and
temp-db databases.

Oerpcore:

Te

Connection name: Oerpcore

Physical name: C:\OpenEdgeTutorial2009\AutoEdgeDB
\oerpcore\oerpcore.db

Hostname: localhost

Port: 9010

User ID (SQL only): autoedge

Password (SQL only): password

mp-db:

Connection name: temp-db

Physical name: C:\OpenEdgeTutorial2009\AutoEdgeDB \temp-db\temp-
db.db

Hostname: localhost

Port: 9020

User ID (SQL only): autoedge

Password (SQL only): password

17. Check that all of the new entries are listed in the Database Connections grid. Click
OK to close the Preferences dialog.

o] x]
{
? Database Connections LI T
£
}' e e Physca e e P ter B, Mew |
2 g autoedge ChOpenEdgeT... hi i
1 g oerpcore ChiOpenEdgeT.. Edit.. |
A ¢ termp-di CAOpenEdgeT... i
>: N / (0 |
H B E |
%
P
7 Impor... |
2
3 Export... |
\. 4 »
2 Connection string:
i— -dh ChAOpenEdge Tutorial 2009 AutoEdgeDBtemp-dbitemp-db.db :l
o -H localhost-3 9020
q =
1
i
H oK Cancel |
)
WMWW“H PR

continued on next page
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Lab 1 — Setting up the Environment, continued

Associating database connections with projects

42

The previous section of this lab showed how to create a database connection profile.
Connection profiles are very useful since they allow both ABL and SQL database
connections to be defined once for the entire workspace. However, these connection
profiles are only definitions. A connection profile must be associated with a project
before the information can be used to actually make a connection to the database. This
section shows how to make these associations.

rrrrr

keep in mind that system resources are limited. If you have a large number of projects
that are always open and those projects each connect to a number of databases, then it may
take a lot of time to start OpenEdge Architect. Also consider that there are defaults and
limits on the number of allowed database connections, depending on the OpenEdge
products that are installed and how they are configured.

1. Select the AutoEdge project in the Resources view.

2. Right-click on AutoEdge and select Properties. The project properties dialog
opens.

3. Select OpenEdge->»Database Connections in the left pane. The databases that
are defined for the Workspace are displayed in the Database Connections grid.

continued on next page
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Lab 1 — Setting up the Environment, continued

Associating database connections with projects, continued

4. Check the boxes in front of autoedge, oerpcore, and temp-db.

[ Properties for AutoEdge

|lype filter text

- Resource

- Builders

= OpenEdge
E----AppBuiIder

L Assemblies

- Build “,”
Custam

- PROPATH
E----\f\n’ebSpeed
- Project Beferences
- Refactoring Histary
- Fun/Debug Settings

.- "M“A"""’ -

Database Connection

Database Connections

T

" Show selected ™ Show all

Configure database connections.

Connection Namel Gruupl Fhysical Mame

[¥]s autoedge
[¥]39 oerpcare
[#]2 termp-dh

!

e

CAOpenEdge Tutorial200BautoEdogeDBvautoedgetaut
CAOpenEdge Tutorial200MAutoEdoeDBvoerpcoreloer|
CAOpenEdge Tutorial200 BAutoEdoeDBvemp-dbitermp.

LTt O W S SR AR A e bty
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Lab 1 — Setting up the Environment, continued

Associating database connections with projects, continued

5.

Click OK. The Properties dialog closes and the AVM associated with project is
restarted with the new property changes. A splash screen displays briefly as the
AVM is restarted. The Console view will show messages that the runtime was
started and the status of the connections to the autoedge, oerpcore and temp-db
databases that were associated to the project in the project’s properties.

o,

El Consale &2 ]t Pru:nblems| J] Tasks| ol | =B -5 0
ABL Console

OpenEdoge AVM stopped for !'AutoEdge! . _:J
CpenEdogs VN Started sucoesstully for bt oFdogs!

ﬁzﬁject "AutoEdge' runtime conhection to 'autcoedge' @ 0K
Project 'AutoEdge' runtime connection to 'oerpcore' @0 QK
QK

EFDject '"AutoEdge' runtine connection to 'tewmp-dh'
-
4| | b

EE}Note: You may receive an alert box stating that the AVM is busy. Click Yes
to restart the session.

®Tip: It can be useful at times to clear the messages in the Console view in
order to focus just on the newest messages. Click the Clear Console button (@) on
the Console view toolbar to clear all of the messages.

Compile and Run the Application

This section shows how to compile and run the AutoEdge project from OpenEdge
Architect and demonstrates the Run configuration.

1.

In the Architect menu, select Project>Build Automatically selection to restart
the automatic building that was suspended before importing the application files.
In the console view, you will see the compile status for all of the project’s files.

Ijg}Note: The compiled source code will be placed in the src directory that you
created earlier and set up as the build directory. Subdirectories will be created for
you if they do not already exist.
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Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

2. Expand AutoEdge->src in the Resources view and double-click on start.p file to
open the file in the OpenEdge Editor

£ Besources B2

=

&

T

[E: rcode

EIEb srC

-2 crystal

- gui

(= netcf

‘_'57 serser

[Er shared

IE:- sonicesh

[Ev winform

----- = autoedge-gui.ini

[

OpenEdge Architect Tutorial 2009
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Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

3. Select Run Configurations from the Run button’s drop-down menu.

@'OpenEdge Editor - AutoEdgefsrci/start.p - OpenEdge Architect - CAOpe
File Edit Source MNavigate Search Projegte® OpenEdge  Bun Window  Help

| i S | £ | H~-0 -~ |5~ |8 ~il~ -
ﬁf|3§‘ OpenEdoge Editar (i S Tty i A
& Besources 2 ‘ =B  Runas i
SR Fun Configurations... |
- rcode «  Organize Favorites.. : gui/autoedge/sta
: UL o » lnitialize clien
EC’E’ sre Syntax : to be called fro
E’ ':rysml Description @ start procedure
FH-5= QUi Created
= netcf Hotes : need to provide

el *'\-Ai'.* o T e b st -\...._\_T#‘n-‘-n«._,._*—k—ut#“m_-‘-‘-

A Run dialog is shown which allows a developer to configure all of the
information that is needed to run an application independent of any project setting.
This includes information such as startup parameters, database connections,
PROPATH, and the OpenEdge version to be used.

@Tip: You might use Run Configurations as a way to define and save
environments for testing an OpenEdge application. You can have a number of
Run Configurations defined for different types of testing for the same application
code.

continued on next page

46 Architect Tutorial 2009
Copyright © 2008 PSC



Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

4. Click on the OpenEdge Application node and select the New button to create a
new configuration.

3 Run Configurations
c

reate, manage, and run configurations

N

il i,

e b P
3 | =l s Canfigure launch s
ity;\je filter text " -Pressthe 'Ne
OpenEdge Application = -Press the 'Du
\ # -Pressthe 'De
% - Press the 'Filt
N e (el L

5. Enter AutoEdge Complete Application for the Name. Click Apply.

¢ "
fr % W
¢

i

i Y
Nan@utoEdge Cormplete Application)

hain| [ Startup | 1w PROPATH| 4 Databases | [ ABL| & Culture| B4 Performance| .| Logging | P Enviranment| = Comman||

e S —

continued on next page

OpenEdge Architect Tutorial 2009 a7
Copyright © 2008 PSC




Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

6. In Main tab, add or verify the following details:
— Project: AutoEdge

— Run this program: start.p
—  Working directory: C:\OpenEdge\WRK\AutoEdgeWS\AutoEdge

AutoEdge Complete Application|

(Gl Main e ] % N

AutoEdge

{ Workspacs. | File System. | Verisbles. |

|V CAOpenEdgetWREALtoEdyeWShAutoEdge

EE}Note: This start.p program will be used to start the application every time this
configuration is run.

7. Select the Apply button.

continued on next page
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Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

8. Select the PROPATH tab. Expand the AutoEdge node. Verify that all the
PROPATH entries corresponding to the AutoEdge Project have been pulled over
from the project properties settings.

- ol e —— e e e,
/\'_P,,_,._. R o TR e Wl — —e--'f.,.,.-r*‘w' o R A e e AR

4(0e| Main | Startup | u}y PROPATH] 4 Databases | i ABL| W Culture | %4 Perarmance | ] LDggmgl

J}f AutoEdge (default PROPATH) .
'('-j -2 Environment (all) _E
i -[= CADpenEdge\WREMAUtoEdgeWWSAutoEdgetsrc 1
I : y !
'!_x -[= CADpenEdge\WREEMAUtoEdgeWWSAutoEdgesrcigui i
f [ CADpenEdgeWWRELAOEdoge’W'ShAutoEdgelsrchguihpuredglty :
4 -[= CADpenEdge\WREEMAUOEdgeWWS\AutoEdgesrdiserver ':.
J’}) o= ChDpenEdgeiRkAutoEdgewS\AutoEdgelsrcishared 4
L -[= CAFProgress\OpenEdgetgult, 1
‘: -l C\Progress\OpenEdge\guitadecomm pl % f.
5 -l Ch\ProgresshOpenEdge\guiadecomp.pl 1

B T i LTt R - - et Rl 3

9. Select the Startup tab. In the Ini file area, enter
C:\OpenEdgeTutorial2009\AutoEdge\src\autoedge-gui.ini in the field. This
startup file contains setup information for the application’s GUI screens.

i o S T T o Y e v

e =y e o~ e T e

H Mame: |Aut0Edge Complete Application

hain |[5 Startup | wh PROPATH | ¢ Databases| [ ABL| & Culture | 34 Performance | . Logging | P8 Environment| = Common |

Session startup parameter: | “ariahles... |

Ini file: —Y s
|C:\OpenEdgeTutoriaIZDDS\AutoEdge\src\autoedge—gui.ini) |

Workspace...l File System...l Variables...l

Commaon Language Runtime (NET)

¥ Use project settings %

Assemblies directony: |

S T e o e T

YyEtlaspEEe.. FiIeSystem...l Variables...l l

continued on next page
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Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

10. Select the Databases tab and make sure the Use project database connections

option is checked. The individual database will be automatically checked for you.

e g : . 5 _— T
i P -

]Name: |AutDEd e Complete Application
§nup \uf PROPATH 4 Databases| [£] ABL| W Culture

Y W Use project database connections

Peﬁnrmance| N LDgginglE Envir’

Configure ds
& Show selected © Showall © Show from project '

) Connection Name | Group | Fhysical Name Other Pararme*
ill*]y9 autoedge ChOpenEdge Tutorial200%%AutcEdgeDB\autoedgetautoedge.db :
A [lgd oerpoore ChOpenEdgeTutonal200MAutoEdgeDB\oerpocoreloerpoore.dh

{ [#]39 temp-db ChOpenEdgeTutorial2003AutoEdge DB emp-dbitermp-db.dhb

11. Click the Apply button.

12. Click the Run button.
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Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

13. The AutoEdge Login screen will be shown with the User and Password fields
already populated. The Container Style will also be set to Windows .NET GUI.

Click Login.

M AutoEdge Login - x|

AutoEdge

szer Ih:nm

Pazzword; I*****###

Container Style; I'W'inl:laws Met GUI

[

Login ‘E ! Cancel |

@]

The Daily Schedule screen for the AutoEdge application will be displayed.

I™ Hughes, Mamy

¥ Moore, Mancy

™ Shaw, Robert

™ Morth, Mike

I~ “Woods, Richard

I™ Reynolds, Sarah

[ Rth Brothers Corp. [Dealer #2

09 Tuasday

,&E\ Bl - AutoEdge Dealer System - B X
Tasks | Reporing hisc
' 1 Deal
\:/) 2= E);) 1 Dealer
. ’ 8 Employee
Diaily Inwentory  Customer
Schedule
Testdrives Maintenance
Test Diive Schedule x
Test Drive Schedule
iShiller Motors Inc. [Dealer #1] [Unassigned] Moore, Mancy - December 2008

SMTWTFS
1234686

sai| 7 s 9101

s1]14 1516 171

(21 22 23 24 2
282330 A

09 Tuesday

11213
81320
5 26 27

Lzer: tom

. January 2003

Q oo Frank Flores/Silver Potomoc SMITWTFS

“——| Azteck Coupe 1.8 ; 12 3

Roth Brothers Corp, (Dealer #2) Jas5678am

. 111213141516 17

4018192021 2223 24

5|25 2627 282930
) oo
v
uli]

. | W -
402PM 124972008
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Lab 1 — Setting up the Environment, continued

Compile and Run the Application, continued

14. You can continue using the application to familiarize yourself with its
functionality.

E}Note: Although many parts of the AutoEdge application are functional, the
application is not completely implemented as it is a reference application used for
demonstration and training purposes.

[E}Note: Selecting the Windows ABL GUI option for the Container Style will
demonstrate a version of the AutoEdge application that does not use the new
OpenEdge GUI for .NET and Visual Designer functionality.

AutoEdge |

User |torn /

Pazzword: Ihwnxn

Container Style;

Lagin | Cancel |
M AutoEdge - - Testdrive Maintenance O x|
File TestDrive Maintenance Repors Help
¥ x - Filter: IDpen Testdiives VI @
Test Drives

2 123 Test Drive Details
= 13 12/09/2008

P¥€05.00: Flores First Name:  Frank
1241042008 LastMame:  Flores
D12/11/2008 Car. Silver Potomoc Azteck Coupe 1.8
(121202008
12132008 Date- Time: 1270972008 02:00-08:00
C12/14/2008 Employes: [~
I12415/2008 Dealer: Foth Brothers Corp. [Dealer #2)
12 12/16/2008
2 12117/2008
(2 1218/2008
(2 12/19/2008

122 12/20/2002
(2127212002
(2 12/22/2002
(2 12/23/2002

|User: tom
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Lab 1 — Setting up the Environment, continued

Closing and opening projects

Workspaces use varying amounts of system resources depending upon how they are
configured. You can reduce the amount of resources used by a workspace by closing
projects that you are not currently using. Potential benefits of closing unused projects
include freeing up database connections and speeding up certain tasks, such as searching.
The following steps show how to close and open projects.

1.

Select the AutoEdge project in the Resources view.

2. Right-click on the AutoEdge project and select Close Project. The project is

closed.

3 OpenEdge Editor - AutoEdge/srcistart.p -
File Edit Source MNavigate Search Froject Openk

e | £ B[ H~0-q~ |
=] |3§E OpenEdge Editar
£ Resources B2 P

= {1}:{-} = ."ll*____.
ERES - t0F o | | 1
woad B New * gur
w-JL P Golnto i
[Er re Openin Mew Window
,__—_|:5, S|
o
B-G Paste
- & Delete
- kowe
E Fename..
'"E =g Import..,
———=— 2 Expor.
25 Outline {0 »

# | Refresh
Close Project

Clmse Uhrelstend] PhEjests

Console
oEdge Co

Q) varit

Team 2

L, -'H-‘“ e “Mﬁ‘.—.w .y ‘H_‘H‘.
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Lab 1 — Setting up the Environment, continued

Closing and opening projects, continued

If there were any database connections open for this project they would also be
closed. Also, the AutoEdge project node in the Resources view will become
inactive.

[d OpenEdge Editor - OpenEdge Al
File Edit Mawigate Search Project Of

|l | £ % |3~

ﬁf|3§£ OpenEdge Editar

£ Besources B2 = O
=

...... AutoEdge

N

St o i, gt ....,)

3. To reopen the project, right-click on the inactive AutoEdge project entry in the
Resources view and select Open Project. The project is reopened.
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Lab 2 — Working with Views and Perspectives

Overview

OpenEdge Architect implements tools through the use of views, editors, and perspectives.
These components allow developers to easily create, navigate, view, and update the
resources and meta information that comprise an application.

This lab shows how to customize perspectives and create new ones by changing the layout
of the views in a perspective and modifying the options that are available.

Modifying Perspectives
This section covers some of the options available for working with OpenEdge Architect
perspectives.

1. From the Architect menu bar, select Window->Close All Perspectives to close all
the open perspectives.

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued

2. Since all perspectives are closed, you will see a blank screen with a message
indicating that no perspectives are open. Using either the provided button for
opening a perspective or the Window—->Open Perspective menu option, open the
OpenEdge Editor perspective.

[ OpenEdge Architect - C:\OpenEdgetWRK\AutoEdgeWws
File Edit Mavigate FProject “Window Help

No perspectives are open. To open a perspective, press this button:

4 Open Perspective

% Debug

T\ OpenEdge AppBuilder

1¥ OpenEdge Debugger

'S OpenEdge Editor (default)

# OpenEdge Toals for Business Logic
&) OpenEdge Wisual Designer

55 Progress DB Mavigator
Eﬁﬁeauurce

£9Team Synchranizing

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued

3. Choose Window->Customize Perspective. The Customize Perspective dialog
appears. This option lets you customize menus and toolbars for the current
perspective.

4. From the Submenus drop down, select Open Perspective.

3 Customize Perspective - OpenEdqge Editor

shartcuts |Cnmmand5|

=electthe shoreuts that wou want to see added as cascade items to the fallowing sult
affectthe current perspective (OpenEdge Editar).

Submenus: Shorcuts: i

Open Perspective | Shortcut | Description
135 Debug This Dehug
[#] . OpenEdge AppBuilder  This perspe
[#]#F OpenEdge Debugger  This perspect
[ OpenEdge Editor This perspecfi
& OpenEdge ToaolsfarB.. This perspedt
[¥1€;] OpenEdge Wisual Des... This perspe
55 Progress DB Mavigator - This perspect
[l Resource This perspect
At mps e s gl Mh{mi?n.w{ﬁhia [ gaebes

shortcut Cateqories: [

hh]

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued

5. In the Shortcuts list, un-check OpenEdge AppBuilder and check Resource:

penEdge Editor _ O] x|

T

1see added as cascade items to the following submenus. The selections made will anly
{Edge Editor).

e

‘ shorcuts:

‘*';;I Short

Description

Debug This Debug perspective is designed to support appl
~OpenEdge AppBuilder  This perspective supports use of the OpenEdge Apg
## OpenEdge Debugger  This perspective includes tools for testing and debut
[1&F° OpenEdge Editar This perspective includes the OpenEdge ABL Editar
2 OpenEdge Toals for B.. This perspective includes tools for building models t
[¥1& offenEdge Visual Des.. This perspective includes tools for incorporating the.

e T

Li} Frogress DB Mawvigator  This perspective includes toals for connedting to, bre
4 [ Resource This perspective is designed to provide general res
% [ &° Team Synchronizing This perspective is designed to support the synchrol
L MKL?"A.MW.JM—H,_‘__l"r‘%“ R PRSI SPRST
continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued
6. Select the Commands tab in the Customize Perspectives dialog.

7. Un-Check External Tools to remove this option from the menu and toolbar
options. Consider doing this with other options you rarely use.

3 Customize Perspective - OpenEdge Edit:

Shorcuts  Commands

oelectthe command groups thatwvou want to see added
identifies which menu iterms and/or toolbar iterms are ade

Avwailable command groups:; tenubar details:

Annotation Na tion o
[ AppBuilder '
[ Breakpoints ?
Cheat Sheets
Cornvert Line Delimiters
. Debug

Edjar Navigation
O] &itar Presentation
X

EE

External Tools
evhoard Shorcuts

¥] OpenEdge Editor
D CpenEdge Editor G
o M o g gl [ nn, S — W S

8. Click OK to accept the changes.

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued

9. Select the Open Perspective button, which is next to the list of open perspectives.
Notice that the OpenEdge AppBuilder perspective is no longer listed, but the
Resource perspective is listed. Also notice that the External Tools toolbar button
is no longer shown.

3 OpenEdge Editor - OpenEdge Architect - C:AOE
File dit Mawvigate Search Froject OpenEdge Run Y

I~ | LB %~ 0-~ |5l

.
Eﬁ%ﬂ‘ OpenEdge Editar \
33 OpenEdge Debugger Y
&® OpenEdge Tools for Business Logic
&,] OpenEdge Visual Designer
571 Progress DB Mavigator

[ RESOUICE - —

Cither...

. M“*"‘ﬁ. M""‘*"'"! .-"x.-_j,_;f“"-'--\ _‘_r

E}Note: Customizations, such as these, only affect the perspective in which they
were set.

10. From Architect’s menu bar, select Window—->Show View->Other. The Show
View dialog appears.

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued

11. Expand the OpenEdge Meta Catalog node and select the Meta Catalog
Explorer option.

12. Expand the Progress DB Navigator node. Hold down the Ctrl key and select the
Connections option. Use this technique whenever you want to select multiple

options.
3 Show View =] 3
|type filter text
[& Help :I

#-= OpenEdge Debugger

[:"!v OpenEdge Editar

B-E OpenEdge Meta Catalog /
- Ri#] veta Catalog Explarer

(= OpenEdge Support Wiews

-[= OpenEdge Tools for Business Loagic

= Frogress

-l-= Progress DB Mawvigatar

----- 5% Connection Info

..... Sl Connections
. % DE Dietails

[ SOL Histary —

----- 58 50L Results =

| o P e O ey I e |

Lse FE to display the description for a selectad wiew.

Ik El Cancel |

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued

13. Click OK. Both the Connections view and the Meta Catalog Explorer view are
opened.

H-f 3 Active Connections

= autoedge
e DBIPCOre
b temp-dh

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued

14. Select the group of views that includes the Console through to the Connections
views by clicking just past the last tab and holding down the mouse button. Drag
the group to the top of the Workspace above the Editor area. All of the views will
be moved and docked there.

:nEdge Architect - C:WOpenEdgetWwRK\AutoEdgeWs

a3 L8 e

=%, 3 Active Cannections
e autoedge

- QErpCore

e temp-dh

[E}Note: You can also move individual views by clicking on the view’s tab and
dragging it to the desired location.

continued on next page
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Lab 2 — Working with Views and Perspectives,

continued

Modifying Perspectives, continued

15. Right-click on the Outline view and select Fast View. The view is minimized to

the lower left of the Workbench.

"]-vr-.-.r-'-Jv-.u--.-—r*-fﬁ---"“’*/"""-«» T

B= Outine 52 |59 DBS. | i Prop.. | = O

A oul

Detached
FPEstare
il F
Size »
kinirnize
Maximize

Close

| 0 [

.]U—..w..'-‘f"'“P—r-v".—r' f'*_,_-m__'..__'.,,.._,_,_‘_‘_r“

55 DB Structure 22 | & Properties =0
=

v
RE)E:

Outlinel

@Tip: Clicking on a Fast View icon, such as the Outline view, displays the
view. Clicking again anywhere outside the view minimizes the view again. This
provides a nice way to keep a view easily accessible without taking up space when
it isn’t being used. A Fast View can be turned off by right-clicking on the icon
and un-checking Fast View.

64
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Lab 2 — Working with Views and Perspectives,
continued

Modifying Perspectives, continued
16. Change the DB Structure view so that it too is a Fast View.

The workbench should look similar to the following. Note that it does not matter
if it slightly different, since the goal is just to create a perspective different than the
default OpenEdge Editor perspective.

[ OpenEdge Editor - OpenEdge Architect - CA\OpenEdge\WRK\AutoEdgews

2-E 3 Active Connections
autoedge
Derpcore

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Saving Customized Perspectives

You can continue to use perspectives that have been modified; however, if the perspective
is ever reset (Windows—>Reset Perspective) you will lose all the changes you have made.
Therefore, if you want to make the changes permanent, it is suggested that you save the
modified perspective. It is also suggested that you save the changes in a new perspective
so that the default perspectives shipped with Architect are not affected.

1. From the Architect menu bar, choose Window->Save Perspective As. The Save
Perspective As dialog appears.

2. Enter the OpenEdge Custom as the Name.

[d Save Perspective As... x|

Enter ar select a name to sawve the current
perspectve as.

Mame: |OpenEdge Custom /

Existing Perspectives:

ﬁ%Debug
T, OpenEdge AppBuilder
1F OpenEdge Debugger
& OpenEdge Editor (defaulf)
& OpenEdge Tools for Business Logic
1 w-’“ﬂmy-gjpmw*--~r“-~h-4

@Caution: It is important to change the name when creating a custom
perspective. If changes are saved to the same name as an existing perspective (in
this case, the OpenEdge Editor perspective), then there is no way to restore that
perspective back to its default layout.

continued on next page
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Lab 2 — Working with Views and Perspectives,

continued

Saving Customized Perspectives, continued

3.

Click OK. The perspective name is changed from OpenEdge Editor to
OpenEdge Custom.

@'DpenEdge Custom - OpenEdge Architect - C:WOpenEdgety
File Navigate garch Project OpenEdge Run  Window  Helg

NS LB s -0- 5~ ]/ -l E

B |3§E OpenEdge Custam

£ Besources B2 = 8 E Console |2 Prohlems |« T
NC=
= ZiAutoEdge | =-'A 3 Active Connections
--f,‘: Feferenced Assemblies ----- -+ autoedge
---JL Frocedure Libraries ----- -§= Derpcore
[E:- rcode oo ol

r -#Mm.__‘_,“*___rh“*l—.

B 1 e s Y, S

continued on next page
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Lab 2 — Working with Views and Perspectives,
continued

Saving Customized Perspectives, continued

4. Select Window->Open Perspective->Other. The OpenEdge Custom perspective
is listed as one of the available perspectives. Open the OpenEdge Editor

perspective.
3 Open Perspective _ O] x|
% Debug

uilder
( & OpenEdge Custam
PENEdgE Dehugger /
LS OpenEdge Editor (defaul)
& OpenEdge Tools for Business Logic
& OpenEdge Visual Designer
5] Frogress DB Mawvigator
[ Rezource
E9Team Synchronizing

N\

The OpenEdge Editor perspective remains unchanged.

Ik Cancel

continued on next page
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Lab 2 — Working with Views and Perspectives,

continued

Saving Customized Perspectives, continued

5.

Right-click on OpenEdge Custom perspective in the perspective toolbar. Select
the Close option to close the perspective.

@'DpenEdge Editor - OpenEdge Architect - C:\OpenEdgetE

File Edit Mawigate Search Project OpenEdge Bun Window  Help
Jf"jv Jﬁu%Jﬁvﬂv%qu{v - .

= |3EE OpenEdge Editor &5 OpenEdge Custom

£ Resources B2 =B » I
| = = " DockOn »
B & AutEdge | [ o Bl Ve

---JL Procedure Libraries
B rcode

R me;yneﬁm‘r ‘\'Y-.‘r*r*\ P SR TS :
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Lab 3 — Using Architect’s Help Features

Overview

OpenEdge Architect includes extensive on-line help capabilities and help for both the
Eclipse Framework (Workbench User Guide) and help specific to Architect (OpenEdge
Architect Guide). If you add additional functionality via plug-ins, then additional topics
are likely to appear under the help contents. You can specify which parts of the help you
would like to search. This can speed up searching and reduce the number of unwanted
matches.

Accessing On-Line Help

This section shows how to use the basic help features and how to set filtering options for
searching.

1. From the Workbench menu, select Help=>Help Contents option to open the
OpenEdge Architect Help window.

- C:\OpenEdgetwWRK\WAutoEdgews O] x|
; Fun ‘Window | Help
p J = - |oE| Wwelcome

@ Help Contents

Dyhamic Help

ey Assist. Ctrl+Shift+L
Tips and Tricks...
Cheat Shests...

Software Updates. .
Classic Software Updates +

About OpenEdge Architect

R ,-\V«_n-w—_,,zm_»—wl\_ ,{\,4,(

s
L
m
o
0
=

=
Il
1

':‘A*_“‘TMM"}TT?' s‘h«__‘“_??.r’,_‘.ﬁ__\_,_hﬂ_ . "L._"n—\_. _____...a—-“?‘

E}Note: Architect also includes additional help features from this menu,
including Key Assist, which displays a quick reference pop-up of all available
keyboard short-cuts, and Cheat Sheets, which displays the steps for some common
tasks in Architect.

%}Note: ABL syntax help is also available through the Keyword Help view. You
can access this view by pressing Shift-F2 while the cursor is over a keyword in an
ABL editor.

continued on next page
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Lab 3 — Using Architect’s Help Features, continued

Accessing On-Line Help, continued

2. Select the Search scope link to open the Select Search Scope dialog.

i d Help - Ope dge A

Search: earch scope: All topics
| 3 fGearch scope:
e

Contents ¢ =+ [0 = 0

=elect Zearch Scope

@ Workbench User Guide
@ OpenEdge Architect Guide L) - R
@ Progress DB Navigator Guide

e Progress XML Tools User Guide Using the EB“pSE hel

Browse topics in the Contents fra
buttons to navigate within the histo

Searching
Y N SRRt bl it mste bt

3. Click New to open the New Search List dialog.

[ Select Search Scope x|

* Search all topics
" Search only the following topics:

New...[g Edit... Hemove

/1 0].9 Cancel

continued on next page
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Lab 3 — Using Architect’s Help Features, continued

Accessing On-Line Help, continued

4. Expand the OpenEdge Architect Guide node. The nodes displayed show the
level of granularity that can be specified for searching. You can select multiple
nodes to be included in the search.

[d New Search List

List name:

Workbench User Guide

= OpenEdge Architect Guide
% T Getting Started
I ABL Editor
I Debugger
I AppBuilder and Other OpenEdge T4
ﬁ.‘_h‘ﬂ..l_-.mw.l.p_e. SIEM‘* e,
continued on next page
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Lab 3 — Using Architect’s Help Features, continued

Accessing On-Line Help, continued

5. Type Architect in the List name field. This will be the displayed name in the list
of topic options. Check OpenEdge Architect Guide option. This search scope

will include all of the OpenEdge documentation. Click OK.

3 New Search List x|
Listname:‘/
IArchitect
Topics to search:

7 [T Workbench User Guide
-] ¥ OpenEdge Architect Guide
W Getting Started
ABL Editor
Debugger
AppBuilder and Other OpenEdge To
Visual Designer
Class Browser
Meta Catalog
Tools for Business Logic
Customization
ABL Language Reference
W Copyright
# [T Progress DB Navigator Guide
# [T Progress XML Tools User Guide

AAXMAAAAAAT

<

« | o

0K Cancel |
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Lab 3 — Using Architect’s Help Features, continued

Accessing On-Line Help, continued

6. Confirm that Search only the following topics option is selected and that
Architect (the topic you just created) is highlighted. Click OK.

[ Select Search Scope

" Sadfch all topics
&+ Search only the following topics:

_

Mew... Edit... | Remove |

; 0] I Cancel

The help window now shows the search scope set to Architect.

@ Help - OpenEdge Architect

Search: | | m Search scope: Architect
Contents A NS s

@ Workbench User Guide

@ OpenEdge Architect Guide

@ Progress DB Mavigator Guide

L 2 Progress XML Tools User Guide

Using the Eclipse

Browse topics in the Conten

L e s il g et sl

E}Note: The search scope is retained, so the next time you start this workspace
and open the help screen, the search scope will still be set to Architect.

continued on next page

74 Architect Tutorial 2009
Copyright © 2008 PSC



Lab 3 — Using Architect’s Help Features, continued

Accessing On-Line Help, continued

7. Type tools in the Search field or any topic of your choice. Click GO. The first
time help is accessed, indexing will be performed and may take a few seconds to

complete.

@ Help - OpenEdge Architect
Search: |tDDIs | (0] Search scope:
Search Results b
Indexing... |
| I © o=
12% complete \ Using the %E"
Please waitwhile the online Browse topics in the G
information is indexed. This displayed. Use the Ba
will happen only once. viewed topics.

Searching
e M_.hﬁ .k wdﬁqq‘#

continued on next page
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Lab 3 — Using Architect’s Help Features, continued

Accessing On-Line Help, continued

After the indexing is complete the search results are displayed. You can click on
one of the results to open the corresponding help topic in the right pane.

@ Help - OpenEdge Architect

Search: | tools

|m Search scope: Architect

Search Results & = I:I g

B Additional tools 1| OpenEdge Architect Guide > Visual Designer > Concepts
OpenEdge Architecttools thatare ; ;
notintegral to the Visual Designer, = The Visual De5|gner m set

but have paricular value while you

are building an OpenEdge GUI This section describes the components of the Visual Desg
for NET. include: Class Browser - following topics:

L L
LLL=A~3]

The Visual Designer tool set Visual Designer components

This section describes the The Visual Designer perspective
components of the Visual Designer Additional [T

and related tools. It includes the

following topics: Visual Designer

components The Visual Designer
N, Perspec

Starting the Database

Administration Tool

L. ng‘atabase Administration tool —_—

e g i g 1, f.-q.-l—---l-"""‘"u--\ T et

If you enter in a second search request, you’ll notice it completes much faster since
the help has now been indexed.

8. Close the Help screen.
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Lab 4 — Using the DB Navigator

Overview

The DB Navigator provides access to any SQL compliant database and includes the
following features:

Provides a hierarchical view of database schema.

Includes a SQL editor which allows you to write SQL code against a database.
Offers code generation tools to create SQL Create Table statements.

Offers tools for maintaining database schema, including the OpenEdge RDBMS.
Offers tools for maintaining OpenEdge database sequences and triggers.

The goal of this lab is to explore some of the functionality of the OpenEdge Architect DB
Navigator.

continued on next page
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Lab 4 — Using the DB Navigator, continued

The DB Navigator Perspective

@ Progress DB Navigator - AutoEdge/src/CarQuery. sql - OpenEdge Architect - C:\OpenEdgeYwRK\Auto. . [Mi[=1E3
File Edit MNawvigate Search Project Bun Window  Help

= | @~ | 57~ | - - 5 Y -
Ej’lf-l"_] Progress DB Mavigator | &5° OpenEdge Editor
5 Connection... 22 | % Navigator| = 8 || &l CarQuery.sql E@l = B | 5% OB Structure 2 - = 4
Praparty | alue i’ Q= JI j autoedge |Derpcore | temp—dbl
Database Pr.. OpenEdge ROBMS SELECT CarDescription, CarAddedDate, Carlsdwailable ;l =
ga_ltab?fe_ Pr.. 130.2,« E FROM Pub.Car; e AUTOEDGE =
D:\\jz:mzjs: 70 B SYNONTM
Driver Name  OpenEdge LI _’I;I T:f SYSTEM TABLE [123]
Driver Version 3.70.34 (029620.012. B TABLEI]
Usernams  AUTOEDGE B BaseCode o
URL jobcdatadirectop.. 1|7 DB Details 53 |5k SOL Results| | SOL Histary| - = 0||| =2 Car
AutoCommit... false : : - — =& Columns [12]
nrmm”nn © falsm ~| || Primany Keyl Fareign Key Preview | Fiowy CDuntI Frivileges 4 I 4|1 I . g
> | B CarDescription | CarAddedDate| Ca;| CarsddedDate [de
@ Connectians Egl = White Hmda Q\.foc Hatcht?ack 3.0 2008-10-28 fruE CarlsAwvailable [log
Bed Hinda Civoc Convertible 2.0 2008-11-20 true & Carld [character x|
T el s &% e 3 0 = 7| | Brown Hinda Civoc Corvertible 1.6 2008-10-31 true DealerlD [characte—
E% 3 Active Connactions Birowen Hlndanvoc Sedan 1.6 2008-11-04 true CarBrandiD [chare
. sutoedge Black Hinda Civoc Coupe 1.6 2008-11-05 true
. Brown Hinda Civoc Coupe 2.0 T 2008-10-26 true CarModellD [chare
oerpeare e Brown Hinda Civos Sedan 2.0 T 2008-10-24 tru BaseCadeStylelD
| e tempdb White Hinda. Civoc Hatchback 2.0 T 2008-11-21 true BaseCodeCalorlD
E-Fa Connection Profiles White Hinda Accomn Sedan 3.0 2008-11-05 tru BaseCodeEnginell
gk autoedge Green Hinda Accorn Sedan 20T 2008-11-18 truE BaseCodeFuellD |
- oerpcore White Hinda Accorn Coupe 2.0 T 2008-11-06 LT 1) O N g CarviN [character
g temp-dh KN ¥ _ [ =
= p _I - B Indexes [
4 3
[/ n |
Key:
O DB Structure View
® Connections View
© SQL Editor
® DB Details, SQL Results, and SQL History Views
© Connection Info View
continued on next page
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Lab 4 — Using the DB Navigator, continued

Manually connecting databases

In Lab 1 — Setting up the Environment, you set up the SQL connection options so that the
defined databases are automatically connected at startup. However, if the workspace has
not been restarted since the Database Connections were created, then the databases may
not be connected. There are other times when you may find it necessary to force a SQL
connection to a database, such as a database that you have not set to automatically connect
at startup because it is not often used. This section shows how to make a manual SQL
connection to a database using an existing Database Connection Profile.

1. Click the Open Perspective button in Perspectives toolbar and select the Progress
DB Navigator option. The Progress DB Navigator perspective opens.

@'DpenEdge Editor - OpenEdge Architect -
File Edit MNawvigate Search Project OpenEdge
it | LW [H~0~-Q~ |5~
T | & OpenEdge Editor
T, OpenEdge AppBuilder
3¢ OpenEdge Debugger

&® OpenEdge Tools for Business Logic
&,] OpenEdge Visual Designer ]

Cither... ‘
Fir oo
- .dbconnection

.,.,.j_-;;'?ﬁ.swbﬂﬁiﬁm..‘.é st

E}Note: You can also use the Window->»Open Perspective->Progress DB
Navigator menu option to open the perspective.

continued on next page
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Lab 4 — Using the DB Navigator, continued

Manually connecting databases, continued

2. Inthe Connections view in the lower left of the perspective, verify that the
autoedge, oerpcore and temp-db entries are shown under the Connection
Profiles node. These entries are for the connection profiles that were defined in
the Migrating an Application lab.

"l‘f’""""’“"‘u’vf"- Eathbas

<+ Connections 53 =0

T

F e E a0
=2 3 Actve Cannections
. <= autoedge

----- <@+ Derpcare

----- -4 termp-dh

(ﬁ% Cannection Profiles

----- .. autoedge

\ ----- g temp-db

J=-<}

3. Also verify the autoedge, oerpcore and temp-db databases are listed in the Active
Connections list. If a connection is listed as active, then it means that a SQL
connection is active for the Connection Profile.

,-l-q—""‘*/_.-"q‘\"b--'n.r-'"""’_""_ﬂl

-g= Connections &2 =0

=

=4 T e P =
.5, 3 Active Connections
. -0+ autoedge

----- -» DEIpCOre

b -0+ temp-dhb

E'g‘—,h Connection Profiles

----- 4. autoedge

continued on next page
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Lab 4 — Using the DB Navigator, continued

Manually connecting databases, continued

4. If a database is not connected, then select the database’s Connection Profile and
click on the Open Connection button.

i~ -._.c-"a-"-r#""-"‘-“"' TR T .
[4] | i)

<1~ Connections 52 = 8|3

=

< @/ e 90D

2 ' ns
- .|Open Connection

----- 4+ Derpoore
N -8 temp-db
=7, Connection Profiles

J=--{>-

A brief status screen will be displayed. If the connection was successful, the

database will be listed under the Active Connections node. Repeat this step for any
other databases the need to be connected

continued on next page
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Lab 4 — Using the DB Navigator, continued

Connection Info view

The Connection Info view shows general information for the database that is currently
selected under the Active Connections node.

1.

3 Progress DB Navigator - OpenEdge
File Edit Mawvigate Search FPFroject Run

| it = 5= -

= | ) Progress DB Nawvigator & OpenEdge EDI

T%: Connection ., 53 \‘r::. Navigatu:nr| =0

1

{ Database Pr.. OpenEdge RDBMS
wDatahase Pr.. 10.24

Drrver baor.. 23

DOrrver Minor... 70

Driver Name  OpenEdge
Driverersion  3.70.34(029620.07129
Uszer name ALUTOEDGE

LRL jdbcdatadirectope..
AutaCormmit...  false

:'Tmmif OnCl talse I _bILI

4= Connections 23 l =0
T o T I =

=-E 3 Active Connections

I autoedge

-+ DErpCore \

i ege temp-db

=2, Connection Profiles

- Butoedge

—qpe OBFpCare
gk temp-db

Bl _Mﬂ-l-h_.,__‘__“,?_‘r‘\m...w.,__

5

L s

In the Connections view, select the autoedge entry under the Active Connections
node.

The Connection Info view shows database information about the selected database.
For example, for the autoedge database you can see that it is an OpenEdge
RDBMS that was created with version 10.2A.
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Lab 4 — Using the DB Navigator, continued

Exploring database schema using DB Navigator

The steps in this section demonstrate some of the database schema information that can be
viewed using the DB Navigator.

1.

The DB Structure view contains tab folders for each connected database. Select
the autoedge tab and expand the Database and AUTOEDGE nodes. The top
level schema nodes are displayed.

EdgeWws M[=]E3
;

L

':;

T O || 5% DB Structure &3 =[5 =
3

! autoedge ||:|erpn::|:|re | temp—dbl
-

LJ E|T:‘g Database

3 =N

) ( ----- B OSYMNONYM N

{ 1 w1 SYSTEM TABLE

ﬂ #- & TABLE

M- B VIEW

1 ----- E SEQLEMCES

S I RS E TRIGGERS

")_ _

o= \_ & DEDETALS

| 00 Secunty
F%_-_NM-'“M“M., j

continued on next page
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Lab 4 — Using the DB Navigator, continued

Exploring database schema using DB Navigator, continued

2. Expand the TABLE node.

@E DB Structure 3

—+
S

- = 8

autoedge ||:|erpn::|:|re | temp—dbl

=4 iDatahase |

H-B VIEW

H-B SYSTEM TABLE
TABLH
Baselode
o[ Car

-7 CarBrand
7 CartModel
5[ Contact
5[ Custamer
7 Dealer
4 Employee
T TestDrive

----- % SEQUENCES
----- 5 TRIGGERS
----- %5 DE DETAILS

(B} e

Note that the number of non-system tables in the database is shown in brackets
next to the TABLE node. For the Autoedge database, there are nine tables.
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Lab 4 — Using the DB Navigator, continued

Exploring database schema using DB Navigator, continued

3. Select the Car table under the TABLE node. When the table is selected, the DB
Details view is populated with schema information about the table. In this case,
the attributes for the table are shown in the OpenEdge Table tab of the DB Details

view.

I:—'.U'F'Eﬂﬂu-geqrm-ﬂr'_'/-\_"—*-'v--'-"”wﬁ""' ""'r-"f'.-’-vi""_"-_f-" T ST e -f"'arn"“’-f"'-{-"- R
1 = B|®9DBStucture 33| = = H]
i autoedge |Derp|:|:|re | temp—dbl
: %

i =& Database

b =88 AUTOEDGE

| | | I S 5 SYNONYM

' -8 SYSTEM TABLE
: - TABLE [4]

I w- BaseCode

/ =

i e [ Caryand

i, i 1= i e :

|| T DB Details 52 | SOL Results | [ SOL Histary | - o 3 Carblodel

é: Previewl Row CDuntl Privileges { OpenEdge Table peﬂ_’l @[ Cantact

i = E Customer

3 ("'I_'able Mame: Car Y - Dealer

‘ Froperty | Yalue -~ BB Employee

G Area Schema Araa B TestDrive

' Can-Create - - B WIEW

1l Can-Delsts S |1 & SEQUENCES

{11 Can-Dump BN (| — B TRIGGERS

A ga”"&'ﬂa% R | (| I —— % DB DETAILS

r} y, —2n-mes A= i Security

4 | JER | D

5

] |

E}Note: DB Navigator can be used with any JDBC compliant database. The tabs
in the DB Details view for OpenEdge Table, OpenEdge Columns, and
OpenEdge Indexes are specific to OpenEdge and displayed only when an
OpenEdge database is connected. All other tabs are displayed regardless of the
database type.

continued on next page
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Lab 4 — Using the DB Navigator, continued

Working with the DB Details view

The DB Details view displays an enormous amount of information about a connected
database across a number of tabs. This section explains the purpose and features of some
of these tabs.

1. In the DB Details view, select the Columns tab. If the tab is not visible, use the
arrow buttons (@) to navigate the tabs until it is displayed. All of the columns and
column attributes for the Car table are listed in the grid. This tab shows SQL
information pertaining to the columns.

-;J-/ e
¥

= DB Detail % S0L He 5| 5 SOL History =

T ke .,.,..--l"-,____,,__ G = i L

Ui

Columns IndexesIanaryK FureignKeyIPreuie a°r

olurmnn Marne | DataType( aize | Deci... | Defa... |~

B odeColorlD | warchar BB
BaseC gin... | warchar 56
BaseCo ellD | warchar 5B
BaseCodestylelD) | warchar hh
CardddedDate date 4 sysd..
CarBrandID warchar BB
CarDescription warchar 800

Carld warchar BB -
< | | »

|

f\l ._,w_w._x___ﬂ_x___J__M_.____M_ﬁ_w. .ﬂ___r__ﬂ ﬁ”,_v

@Tip: You can sort the grid by attribute ascending or descending order by
clicking on any column header (®). A small arrow will be shown in the column
header indicating that that column is used to sort the grid. This allows you to sort
the grid by such attributes as Column Name or Data Type. Grid columns can also
be resized by moving the mouse to the line separating the two columns (©) and
clicking-and-dragging the column to the preferred width.

continued on next page
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Lab 4 — Using the DB Navigator, continued

Working with the DB Details view, continued

2. Select the OpenEdge Columns tab. Unlike the Columns tab, which shows SQL
information about the columns in a database, the OpenEdge Columns tab shows

column information that is OpenEdge specific.

e

e T o g e, -

. e—

T DB Details 23

&L Fesults

3| SOL Histary - = O

Privileges

enEdge Tahle OpenEdge Columns | Ope 4 | Ir|

| DataType| Format | Label
i(Carld character | XG4 Car 1D
DealerlD character | XG4 Dealer 1D
CarBrandID character | XG4 Car Brand 1D
CartdodellD character | H[B4) Car Model IC
BaseCodeStylelD | character | =(64) Base Code &
BaseCodeColorlDl | character | =[64) Base Code (

=64 Base Code

iEﬁpseCud@EnqinelD character
4

2

‘-.—.z-|-"ﬂ._.-._.—-f-.-wf“\.-"\-r—--'-._.\_,-,_.fr,,w'v\_.-.__-»'HT_.-qa-'r,'En]_[--x-.-l'-’\_-‘\h.i

“Tip: The toolbar above the grid (@) allows you to add, update, and delete
columns in the database. Toolbars to change schema are available in the
OpenEdge Columns, OpenEdge Indexes, and OpenEdge Tables tabs.

OpenEdge Architect Tutorial 2009
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Lab 4 — Using the DB Navigator, continued

Working with the DB Details view, continued

3. Select the OpenEdge Indexes tab. All of the indexes for the table are listed. Each
index node can be expanded to show the components that makeup the index. Click
on the plus sign (+) next to the DealerCar index entry to see its components.

T DB Details &2 | 56 SOL Results | 5 SOL Higny - = O
OpenEdge Columns OpenEdge Indexes L | >|

EE

Index Marme | Ares | Description | F’rimar},.fl Acti, ~
LcarlD =chema Area Yes e
Brand Schema Area Mo

ColorCode | Schema Area

=ECealerCar
* DealerD
Catld
‘VTIV | v [ P R L I b l— k/zld

4. Select the Primary Key tab and expand the node. The primary key for the Car
table is shown.

T DB Details &2 | [##*S0L Results | 5 SOL History - = O
Primary Key [ Foraign Keyl F"reviewl R Cuuntl Frivileg 4 | *l

Cirder

continued on next page
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Lab 4 — Using the DB Navigator, continued

Working with the DB Details view, continued

5. Select the Row Count tab. This shows the number of rows, or records, in the
table. It is the same result that is obtained by running a SQL COUNT command.
As with all databases that are accessed from the DB Navigator, the data and
metadata shown is obtained from the OpenEdge database via a SQL connection.

continued on next page
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Lab 4 — Using the DB Navigator, continued

Working with the DB Details view, continued

6. Select the Preview tab. You will be shown the actual data stored in the database
for the Car table.

T DB Details &2 | D SOL Results WHistnr\y - = O
Primary Keyl Fareign Key | Preview | Row Cuuntl Privilec 4 | ’l
CarDliescription | CarfdddedDate Y~
White Hinda Civoc Hatchback 3.0 2003-10-28
Fed Hinda Crvwoc Convertible 2.0 200a-11-20
Brown Hinda Civoc Convertible 1.6 2008-10-31
Brown Hinda Civoc Sedan 1.6 2003-11-04
Black Hinda Civoc Coupe 1.6 2008-11-05
Brown Hinda Civoc Coupe 20T 2005-10-26
Brown Hinda Civoc Sedan 20T 200a-10-24
YWhite Hinda Cihvoc Hatchback 20T 20058-11-21 =

3

@Tip: The maximum number of preview records returned is the first 150
records for the table. This value is configurable in the Preferences under Progress
DB Navigator by setting the Preview row limit. For this change to take effect,
you need to disconnect and reconnect to the database using the Connections view.

E}Note: So far, we have only seen information from the Car table in the DB
Details view. At any time you can return to the DB Structure view and select
another available table. The information in the DB Details view will change
accordingly.

continued on next page
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Lab 4 — Using the DB Navigator, continued

Working with the DB Structure View

This section demonstrates additional features of the DB Structure view.

1. Make sure that the AUTOEDGE->TABLE nodes are expanded in the autoedge
tab for the DB Structure view.

2. Expand the Car node. The Columns and Indexes nodes are displayed.

continued on next page
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Lab 4 — Using the DB Navigator, continued

Working with the DB Structure View, continued

3.

Expand both the Columns and Indexes nodes. Also expand the Brand index
node under Indexes.

|

'3 || 5% DB Structure 53 l - = 0
';h_

4 || Butoedge |Derp|:|:|re | temp—db'

9

i o5 TABLE [9] -]
14; ---Ij BaseCode o

; E||f| Car /

iy ﬂ =B CDIumn@

'~, ﬂ ----- B CarDescription [character <(35)]

\ ----- B CarAddedDate [date 99/99/9994]

EO | | T A B Carlséwvailable logical YES/MNO]

4,-.? arld

= X Dealer Eh

|= a" ----- I CarBrandlD [character x(G4)]

ﬂ ----- B CarModellD [character X(64))] |
a0 I BaseCodeStylelD [character X(54)]

g ----- I BaseCodeColorD [character x(64)]

;' ----- I BaseCodeEnginelD [character X(64)]

j!; ----- I BaseCodeFuellD [character X(64)]

E ----- B CarvIN [character x(207]

i = 5 Indexed (5]} ff—

E =~ Brana

ﬂ , ------ B CarBrandI‘—Q

3 w9 ColorCode h

Architect displays the total number of columns (@) and indexes (@) next to their
respective entries. Other information included in the nodes for quick reference
include the data type (©) for each column and the sorting order (@), ascending or
descending, for each index component. Also note that different icons are used to
signify special characteristics, such as the key icon for the CarID column (©)
which signifies that the column is part of the primary key index.
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Lab 4 — Using the DB Navigator, continued

Working with the DB Structure View, continued

4. To see the system tables for the OpenEdge RDBMS, expand the SYSTEM
TABLE node. This is where the underscore tables, such as _File, can be found.

=+l

ST

25 DE Structure 52

- — d

autoedge ||:|erp|:|:|re temp-db

el

= E Datahase
=85 AUTOEDGE

B SYNOMNYR
E X
75 _ActAllog
-F8 _ActBlLog
-F5 _ActBuffer
-E8 _ActiOFile
WH _ActlOType
CF5 _Actindex
-F5 _Actlock
WF5 _ActOther
WEE _ACtPWs
-5 _ActRecord
WFH _ActServer
Mes) _Act=pace
-5 _ActSummary
-F5 _Area

-F5 _AreaExtent

LE [123]

5 AreaStatus

OpenEdge Architect Tutorial 2009
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Lab 4 — Using the DB Navigator, continued

Working with the DB Structure View, continued

5. The last node available in the DB Structure view for the AutoEdge catalog is the
DB DETAILS node. Select this node. You can collapse the other nodes to make
it easier to find.

@Tip: Don’t confuse the DB Details node in the DB Structure view with the DB
Details view.

In the DB Details view, information on the overall database properties for the
selected OpenEdge RDMBS is displayed under the Database tab.

e

RS it/ ™ e el e i

.-% = 8| =% DB Structure 33 | =l s

i

; autoedge | oerpoore | temp-db |

3 3e

H =& Datahase

] =8 AUTOEDGE

Al B SYNONYM

i #- 5 S¥STEM TABLE [123]

J:_T M- B TABLE [9]

i -5 WIEW

e & SEQUEMNCES

? ==l - t TRIGGERS

¢ || DB Details 23 |G 80L Resutis| [ SLHisory] =1 = B i

! ‘ﬁﬁ/“ @

z._ Datshase |Tab|es & Columns I b Security

'l&‘- Froperty | value /

}) Additional Details

< ode Fage is0 -

: CodeF is0BE5h9-1

L Collation basic

Z Database MName autoedge

& Description CH10.1 ahworkspaceiautoe...

} Large Keys Enabled false

: Large Sequences Enabled | false

E Type FROGRESS

]
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Lab 4 — Using the DB Navigator, continued

Working with the DB Structure View, continued

6. Select the Tables & Columns tab. This tab provides an alternative way to view
column information for the database and includes all of the columns from all of the
tables in the database, as opposed to just those in a single table.

T

-,-'-‘__"____.,q__.ﬂ"’v.'_',_f""—:_‘__. S i O bl A e

T DB Details 52 |5 S0L Results | 52

Database Tahbles & [R:ulumns

BULHistory| - — O

T FY
BaseCode | BaseCodelD character
BaszeCode BaseCodeCategory character
BaseCode BaseCodeMame character
BaselCode BaseCodelescription character
Car Carld character
Car DiealerlD character
L‘iﬁ::ar ‘ (Earﬁlrar?dlllDH ':.h ara@er A
Il o

@Tip: This tab is useful because it allows you to sort all of the columns in the
entire database by any attribute such as data type and format. This makes it easy
to confirm that attributes are consistent across similar fields in the database (such

as key fields).
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Lab 5 — Using DB Navigator’s SQL Editor

Overview

The goal of this lab is to acquaint you with OpenEdge Architect’s SQL Editor.

SQL Editor Basics

This section shows how to use the SQL Editor to write queries against a database.
1. Make sure that you are in the DB Navigator perspective.

2. In the Connections view, select the autoedge database node under Active
Connections.

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

SQL Editor Basics, continued

3. Choose the New SQL Editor button in the Connections view toolbar. A new SQL
editor is opened.

3 Progress DB Navigator - SQL Editor (0).sql - OpenEdge Architect - C\OpenEc¢
File Edit MNawigate Search FProject Run Window Help

[ei i =N .]Q

79 0 Progress DB Navigator €2 OpenEdge Editor
% Conne... 52 | Navig.. | = O :@ SQL Editor (0)sgl 53 ) { =g

Property | value Fil ? = J'@‘DEE*QE 3
Database Pr.. OpenEdge |

Database Pr.. 1024

Driver bMajor .. 3

Driver inor... 70

Drriver Mame OpenkEdge
Driver Wersion  3.70.34 (0296

Llser name ALUTOEDGE -
LRL jobcdatadive i ,

AutoCornmit...  false _ILI
4 4
I | 7% DE Details 32 |3 SOL Results [ SOLHistory] — = O

¢ CDHHT:M Database Tables & Colurmns |
= Coar | @ 4 —
q @ 4% e ‘8B Tahle | Column Name | Data Type |j

E‘% 3 Acti¥e Connections BaseCode BaseCodelD character
. <0 autoedge BaseCode |BaseCodeCategory character
-~ oerpcore BaseCode BaseCodeMame character

: g temp-ib BaseCode | BaseCodeDescription character

E% Connection Profiles Car Carld character

5 autoedge Car DealerlD - character
Lo ST e, o G RAGR a y a stan e

@Tip: When a new SQL editor is requested, it will default to run queries against
the currently selected active database. You can change the database the queries
are run against using the database drop-down (@).

E}Note: Since you are creating a new temporary SQL file that does not exist on a
disk, the name of the file is generated with a number and a .sql extension. The
number is unique within the session and is incremented each time a new SQL
editor is created. The tab of the SQL Editor includes the generated name of the
temporary SQL file (@)

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

SQL Editor Basics, continued

4. Enter the following code in the SQL Editor:

Code for the SQL Editor

SELECT CarDescription, CarAddedDate, CarlsAvailable
FROM Pub.Car;

E}Note: Tables must always be fully qualified in the FROM clause when
accessing an OpenEdge database using the SQL interface. So in this case, the
PUB qualifier is used for the Car table.

@Note: If you do not want to type the code, you can copy it from the above box
and paste it directly in the editor. However, you might want to become
comfortable with Architect’s code completion features before skipping directly
typing code. For instance, the SQL editor will provide pop-up help when the dot

(.) is typed after Pub, allowing you to select from a list of available tables (@) and
columns (0).

e T T

s e = e, -
- |l | v VA T T e e, T v

L e e T
iy

-{r &F OpenEdge Editor
L

30 || s SOL Editor (0).5q] 53 | ) = O || =5 DB Structure 3 =0
| : -
g Q= _.r'_lautoedge jl | autoedge |Derpc:ore | temp—db'
;’ SELECT Car nption, CaraddedDate, CarlsAwvailable ;I g
T FROK FPub. | = 82 Dizizl
? FlRaseCode || "4UTOEDGE" "FUB"."Car"
i’ =Eirand o CarDescription warchar(G00)
{ = Cartodsl oo CarAddeF:Date b.?(?;em)
T Contact ﬁva' EHE '
5 = ( Cand warchar(ak)
i ﬂ — Bl;i.tﬁ;?er /' ealerD warchar(BE)
?; = Employee e CarBrandID warchar(bb)
e == =
; . DB Details & — CarhdodellD warchar(bg)
= = S ',ESYS—CHK—CONSTP‘S BaseCodeStylelD  warchar&E)
EEI Database T¢ ESYS—CHKCOL—USAGE BaseCodeColorlD varchar(bg)
L ESYS—KEYCOL—USAGE BaseCodeEnginelD  warchar(2)
{ Table I HE|3YS_REF_CONSTRS = || BaseCodeFusliD wvarchar(5B)
= BaseCode BaseCodelD character (L)) HI]
T T T T R - cL-TLITh Y 1| PLE O S
continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

SQL Editor Basics, continued

Ijg}Note: The SQL Editor shows information about the selected file and cursor
location in the status bar area. As shown below, the status bar indicates that the
current file is Writable, the current mode is Insert, and the location of the cursor is
at row 2 and column 14. Reducing the size of Architect’s window so that it is too
small will remove this information.

At e U eremngd Bl =7 T e T T T ey

£ 0| sl SOL Editor (0).sgl &

—_—

[

¢ = _f"_lautuedge

FROM Pub.Cr )

= E @_g-"

= I

SELECT CarDgscription, CarAddedDate, CarlsAwailable =
E.

-
b i

e N e e A e N =
& N

7% DB Details 33 |5 SOLResutts | [

SOl Histary

- = O

-
¢ O Datahase Tables & CD|L\W‘|S | g
i = i
E Tahle | Column Nam\ | Data Tyvpe | Format i’
= BaseCode @ BaseCodelD character | X(B4) B
A BaseCode | BaseCodeCatdgory character | X[15) !
“ﬁj BaseCode  BaseCodeMa character | *[15)
> BaseCode | BaseCodelesdyption character | X(35) o
i Car Carld character | xR
Car DealerlD character | #(b4) d
¥ Car CarBrandID character | =[b4) -
] ;
i v |

1.
gt .

1Writable ) t Insert )

(| 2:14)

OpenEdge Architect Tutorial 2009

Copyright © 2008 PSC

continued on next page

99



Lab 5 — Using DB Navigator’s SQL Editor, continued

SQL Editor Basics, continued

5.

Execute the query by pressing the Execute SQL (@) button.

3 Sl g Seem—_ — . ey . — .
S BT ORRREdgE Elffigr— T T e et A

T || L S0L Editar (0).sgl 52 = 5| =5.
9 = _;"_Iautn:ledge jl o
7 ELECT CarDescription, CardddedDate, Carlsiwvailahle = |
ROM Pub.Car =
| o |
| I piE

Y || (Time Elapsed 156ms

-f T DB Details | D SOL Results 52| 5 S0L Histary =0
Al 2

L B % =
E SELECT CarDescnptmn CatsddedDate, CarlsAvaHabl '>:.__
'ijv FROM FPub.Car / :
[ {E;LrDescriptiDn | CarAddedDatel Carls!—‘wa_\j

i White Hinda Civoc Hatchback 3.0 e008-10-25 true

5 Fied Hinda Civoc Convertible 2.0 2008-11-20 true

g Brown Hinda Civac Convertible 1.6 2005-10-31 true

i Erown Hinda Civoc Sedan 1.6 2008-11-04 true

5 Black Hinda Chvoc Coupe 1.6 2008-11-05 true

4 Brown Hinda Civoc Coupe 20T 2008- 'IEI EE true J

e — . . - - . [E—— [—

= —f ||
4 10047 :
f-?_ )
/ VWritahle Insert 214 | :
4

The result is shown in the SQL Results view. In the view, you will see the query
that was performed (@) along with the resulting rows from the database (©),
including the columns that were specified in the query. The time that it takes the
SQL query to execute is shown in the lower portion of the editor (@).
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Lab 5 — Using DB Navigator’s SQL Editor, continued

SQL Editor Basics, continued

%Tip: Remember that since you selected the AutoEdge database in the
Connections view, the SQL editor was opened with the correct database already
set. However, if the Execute SQL button is disabled, the likely cause is that a
database has not been selected. Select a database from the combo-box in the
Editor if one is not specified. This is a common issue when reopening a query,
since a SQL file does not retain information on the database that was connected.

<l SOL Editor (T).sg) 33 | =g

Time Elapsed 156ms

6. From Architect’s menu, select File=>Save As. The Save As dialog is displayed.

7. Expand the AutoEdge node and select the src folder. Enter CarQuery.sql for the
File Name. Click OK to save the file.

[@save As =1 F1

Save As

Sawe file to another location.

Enter ar selectthe parent falder:
IAutDEdge,’src

i

= = AutoEdge
L& rcode
'_5» 5rC

File name: |CarQuery.sgl /
(7} Ok IEi Cancel

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

SQL Editor Basics, continued

8. After saving the file, the SQL Editor’s tab changes to reflect the new name for the

file (@).

3 Progress DB Navigator - AutoEdgefsrc/CarQuery.sql - O
File Edit MNavigate Search Froject Run  Window Help

Jf"jv J%vJQTJ v’f::l - -
T 5 Progress DB MNavigator penEdge Editor

T Connect...

o Mawvigator 23

=52 st

- crystal
-2 gl
- nietct
-5 SERVEr
= shared
H-[= sonicesh
(== winform

v.sql

SELECT CarDesc
FROM Pub.Car;

tion, Cardcddd
i

Time Elapsed 156ms

-ui.V_|

-

T DB Details |53 S0L Besults &2
1

= G [ %

R

J-:m::.gf‘a-wy-—- Cie:

@Tip: The SQL program is now part of the project and can be seen in the
Navigator view by clicking on the Link with Editor (@) button.

102
Copyright © 2008 PSC

continued on next page

Architect Tutorial 2009



Lab 5 — Using DB Navigator’s SQL Editor, continued

Generating SQL code using the DB Structure view

You can use the DB Structure view to help with generating SQL code. This is especially
useful because instead of manually typing table, column, and field names, you can copy
the information directly from the DB Structure view. The following steps show how to
use these features.

1. Select the Database>AutoEdge=> TABLE->Car node in the autoedge tab of the
DB Structure view.

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Generating SQL code using the DB Structure view, continued

2. Right-click on the Car table and select Generate Select in Sql Editor.

e Architect - C:\OpenEdge\WRKwAuto. .. [MlI=] E1

3

;

%r = O | 5% DB Structure E?E\ - =08
j‘c autoedge | DerpCore | temp-db |
YlsAvailable =l

J =& Database

=B AUTOEDGE

) _I;l 1 SYNONYM

; . w1 SYSTEM TABLE [123]
; =B TABLE [9]

“";Stury‘ - =08 : g BaseCode

I;?_iul"ltl = o . h

gﬂ ~x Edlit Tahls Data
. gg:] % Refresh Table

081 ] Create Tahle Script

tBrand
arkdodel
ontact

Lstamer

08T = adid Table
ggg] v Edit Table
!QEIE—1 £ Add Column
a0a-1 15 Add Index

{108-1 £% Drop Table

ealer
ployes
e stOrive

LIEMCES
HGERS

08-1

?108-1 Copy Hame

ETAILS

Sy | |» .|
mbhay o o -l 1 bl S A
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Generating SQL code using the DB Structure view, continued

A new SQL Editor is opened and a SQL SELECT statement is generated to access the
records in the Car table. Not all fields are visible because by default generated SQL
has 10 fields per line.

wl CarQuery.sgl (ol SOL Editor (2).sg] B3 =0
@ = 7 |aut|:|edqe v"

ELECT CarDescription, CardddedDate, Carlsfevailable, Carld, Dea
BaseCodaFuellD, Carvik
FROM "AJTOEDGE" "FUB"."Car"

1] | 1

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Generating SQL code using the DB Structure view, continued

3. Choose the Execute SQL button to run the code.

_-.--.—-'"' L e L Sl e T g T . e

4 &F OpenEdge Editor

LFEI sal uery.sgl ol SCOL Editor (2).5g] 52 = 0|88

?v 2 = 7 Iautuedge jl ElUf;.'

EI SELECT CarDescription, CaraddedDate, CarlsAwailable, Carld, Dea_I }:9

! BaseCodeFuellD, CarvIM _L___l‘
FROM "ALTOEDGE". "FUB" "Car" 2

a | _I_I

Time Elapsed 94ms

3

;»E T DB Details |58 SOL Results 52 | 55 SOL Histany =0

®

» 8 | A=ELECT CarDescription, CaraddedDate, CarlsAwailable, Carld,

-,— DealerlD, CarBrandlD, CardodellD, BaseCodestylelD, —

E;v BaseCodeCalorlD, BaseCodeEnginelD, J

L CarDescription | CarAddedDateI CarlsAnwailt | H

1 YWhite Hinda Civoc Hatchback 3.0 2005-10-28 true

% Fed Hinda Civoc Convertible 2.0 200a-11-20 true

“ Brown Hinda Civoc Convertible 1.6 20038-10-31 true

| Brown Hinda Civoc Sedan 1.6 2003-11-04 true

£ Black Hinda Civoc Coupe 1.6 2008-11-05 frue

};. \Eﬂruwn Hinda Civoc Coupe 20T 2008-10-26 true

¢ = e P —— st s pm—— 0 1] [

b il p—

k

|

; YWtitakble Insert | 1 :o J

The SQL Results view shows the results of the executed SQL statement. The
lower right corner shows the number of records returned by the query. In this
case, only the first 100 records were returned.

4. If you wish, you can save this query as GeneratedCarQuery.sqgl in the AutoEdge
project under the src directory.

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Using the SQL History view

The SQL History view contains one entry for each unique query that has been run during
the session. This allows you to recall previous queries in case you need to run a query
again but do not want to load a saved file.

1. Select the SQL History view.

or - AutoEdgefsrciGeneratedCarQuery.sql - OpenEdge Archltec

*’h Froject Bun  ‘Window Help

'3_32: OpenEdge Editor
e

‘jﬁ_ sl CarQueny.sgl bl GeneratedCarQuerysgl 52 = O B8
W Q,L = A Iautuedge JI au"::
rEI SELECT CarDescription. CarAddedDate, CarlsAwvailable, Carld, Dealer_l 5=t
i BaseCodeFusllD, CarvIM _EI
j FROM "AUTOEDGE""FUEB""Car"

<] |
Tirme Elapsed 94ms /

[
g
} ||C% DB Details |5 SQL Results | 5] SQL History 23 = O

[t 2= = R |

SELECT CarDescription. CarAddedDate, CarlsAwvailablellFROM Fub.Car - ¢
SELECT CarDescription, CarAddedDate, Carlsdwvailable, Carld, DealerlD,...

%
L i, S St o et A%ﬂh%‘ﬂhﬁﬂ-\%q.‘.“*.

There should be at least two entries for the two queries that you have run in
previous steps. Note that there will be one entry for each unique query, not entries
for each time you have run a query.

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Using the SQL History view, continued

2. Right-click on the entry that only has the three Car fields in the query and choose
Open in editor.

[T]
i

T DB Details | D SOL Results | f5) SOL Histary &3 =B

Cpen in editor k ile, Carld, DealerlD...
Femowe fram history
Copy to Clipboard

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Using the SQL History view, continued

3. The query is opened in the SQL Editor. Notice that it didn’t open the saved SQL
program (@), but instead the code was opened in a new SQL Editor tab. The
Execute SQL button (@), is disabled, since a database (©) is not currently

associated with the query.

s g M B B oo A T T e gl A s g
{? EQEarGuery.qu =l GeneratedCarCQueny... [Q SCL Editor (4).5g] 22 IE BE C
FF _,I j | aut
ZI FELECT CarDescription, CarAdde™ate. CarlsAvailable |2 [
P FROM Fub.Car _El

o
il

™% DB Details | SOL Results | [7 SOL History 52

previous sgl

SELECT CarDescription, CarAddedDate, CarlsdsailahlellFROM Pub.Car
SELECT CarDescription, CaraddedDate, Carlsfwvailable, Carld, DealerlD, ...

--------

Associate the autoedge database with the query by selecting it from the Choose
Connection drop-down.

continued on next page
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Using the SQL History view, continued

5.

Execute the query.

S S S e et = e

p T OPEI e e e

L ey

ol SOL Editor (4).sgl 32| = 8|8

E

Lol GeneratedCarCuery...

sl CarQuery.sgl

SELECT CarDescription, CarAddedDate, CarlsAwailable
ROM Fub.Car

sed /Bms
T DB Detail; SOL Results 22 | [ S0L Histany = 0
(I R T
= Gy ®

SELECT CarDescription, CaraddedDate, CarlsAwvailable
FROKM Pub.Cad

CarDescription | CarAddedDate' Carlsﬁvailablel -

f'~ -v-"'lx'/-h"’""ﬁ = -\.—_r'-\._.-'-'\’_\'-.-'"."-\_ AT e e
a1

k YWhite Hinda Civoc Hatchback 3.0 2008-10-28 true

4 Fed Hinda Civoc Convertible 2.0 2008-11-20 true

} Brown Hinda Civoc Convertible 1.6 2008-10-31 true

Broiwn Hinda Civoc Sedan 1.6 2008-11-04 true

B Black Hinda Civoc Coupe 1.6 2008-11-05 true

J Browen Hinda Civoc Coupe 20T 2008-10-2k true

f Brown Hinda Civoc Sedan 20T 2008-10-24 true ;I
J S o T BN ' 10047
1 Writakle Insert 1:1 J

[

A new tab folder is created in the SQL Results view showing the results.
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Copying object names from the DB Structure view

In addition to generating a complete select statement from the DB Structure view, you can

copy individual database object names from the DB Structure view to the SQL Editor.

1. Open a new SQL editor by selecting the New SQL Editor button in the

Connections view.

2. Type select in the editor.

ol SOL Editor (4).5q

ol SCOL Editor (5).5g] 52

}}2 = E

@ = _f"_lautuedge
select|

X

[

=

3. Expand the Database>AUTOEDGE—->TABLE->Car->Columns nodes in the

DB Structure view.

OpenEdge Architect Tutorial 2009
Copyright © 2008 PSC
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Copying object names from the DB Structure view, continued

4. Perform multiple selections by holding down the Ctrl key and selecting the
CarDescription, CarAddedDate, and CarlsAvailable columns.

s\WRKWUtoEdgewsS  [M[=IE3

R

|

-,

T

,
| 4

o S
N O

|

-

v

25 OB Structure &3 - = B

autcedge ||:|erp|:|:|re | temp-dbl

—*

ST

| AUTOEDGE =]

B SYNONYM

B SYSTEM TABLE [123]
TABLE [4]

15

---Ij BaseCode

I:'_Ilj Car /
=8 Columns [12]

----- @ CarDescription [ch

PN b e

R
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Copying object names from the DB Structure view, continued

5. Right-click on any of the highlighted columns and select Copy Name.

"‘"'J_"'-"'\-r'fv""'--'_"'

1

e e e

-
i 55 DB Structure 53 - = d

Jé_ autoedge | oerpcore | ternp-db |

Ii :%D

¥ || [ AUTOEDGE [

S SYNoNYM

j B SYSTEMTABLE [123]

x -5 TABLE [9]

v || =2 BaseCode

'}"ﬁ EIE Car

F =% Columns [12]

: ..... W CarDescription [ch

{1 C Cars Eg Copy Name
‘; B o =
Ml % DealerlD £¥ Drop Calurmn
i ----- i CarBrandlD [chars

Al o e i CartodellD [chars

j ..... ¥ BaseCodeStylelD

[ | 1 BaseCodeColorD

ﬁl_.w ----- B BaseCodeEnginell

AL i :::_ﬁ\ BageCodeFugll L4

OpenEdge Architect Tutorial 2009
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Lab 5 — Using DB Navigator’s SQL Editor, continued

Copying object names from the DB Structure view, continued

6. Place the cursor a space away from the select statement in the SQL Editor, right-
click, and select paste.

ator - SQL Editor (5).5ql - OpenEdge Architect - C:\0OpenH

;i,'n:h Froject Run ‘Window Help
3w - > ¥ Y . -

]

e o .

Br & OpenEdge Editor

P B/ . SOLEditor (45l | = SOLEditor (5).sgl 82 ™

< Y12 = _f"_lautuedge jl

;I select| :

4 <2 Undo Typing Ctrl+2

'i / Fewvert File

H Save Cirl+=5

i

‘\ LI Show In Alt+Shift+it ¥

P = (irl 5%

3 @ (S, i R '}.-"|

sigfll ]z

_> = Shift Right _

'.‘-J! | SELECT C: Shift Left ailakle

¢ |FROM Pub

Freferences...
%_ CarDescription _ CardddedDate CarIsAv:é
m‘mmh.;“w*&.;.ﬂ For— A :

—
The selected fields are added to the SQL Editor.

7. Press the Enter key and type from pub.car.

! SOL Editor (4).5q ol SOL Editor (5).sgl 52| ™2 =0

@ = _f"_lautl:uedge jl -
select Car.CarDescription, Car. CaraddedDate, Car. CarlsAwailable ;l
from pub.car

e of

continued on next page

114 Architect Tutorial 2009
Copyright © 2008 PSC



Lab 5 — Using DB Navigator’s SQL Editor, continued

Copying object names from the DB Structure view, continued
8. Execute the query. The results are displayed in the SQL Result view.

9. Close all the open SQL Editors.
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Lab 6 — Modifying Schema using the DB Navigator

Overview

This lab shows how to modify OpenEdge RDBMS schema using the DB Navigator.

Adding a new table

In this section, steps are provided that show how to add a new table to the database.

1. Make sure the autoEdge entry is selecting in the Active Connections list in the
Connections view.

2. Inthe DB Structure view, select the autoedge tab.

3. Expand the Database>AUTOEDGE—->TABLE nodes.

continued on next page

116 Architect Tutorial 2009
Copyright © 2008 PSC



Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

4. Right-click on the TABLE node, and then select Add Table.

§TTT e i e T
18 |2 DB Structure &2 - = d
i

(; autoedge ||:|erp|:|:|re temp-dh

__\3 —*l

; —+l

y: - & Database

L =B AUTOEDGE

sl - 15 SYNONYM

J -5 SYSTEM TABLE [123]
N S=F 1 AELE [9

ﬁ ¥ 2 Refresh

- CarModel

i ---EI Contact

i 7 Custamer

3 = Dealer

j: 7 Employee
il e B TestDtve e ML

@Tip:

view to add a table.

e

B e T

5,-..¢__._,-\f~.r.__q_- T

T g T e ..-n-*—-l'f ey g e T

R

r

= O

T DB Details 52 | D6 S0L Results | 52 SOLHi#ftony =
Frivileges OpenEdge Table | OpenEdge Calu
E4ES

Taple Mame: BRseCode
Pl Add tahle alue

T Schema Area
Can-Create *
Can-Delete *

Il I [Ty o N e S . e

You can also use the toolbar in the OpenEdge Table tab of the DB Details

OpenEdge Architect Tutorial 2009
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

5. Inthe Add Table dialog enter the following (be sure to maintain case sensitivity):
— Table Name: NewCar

— Area: Auditing Area
— Description: Table created for lab.
[ Add Table 0] x|

Database:autoedge.db

(1) Enter a description of the contents of the tahle.

o
Takle Mame: |NewCar‘/
Area; IAuditing Area ‘/ j
~ Other
Dump File: |newcar
Lahel: |7 |
Description: | Table created for Lab ;I

J |
validation: | Edit...l
!

bdessage: |
™ Hidden

™ Keepwizard open after adding tahle

(7] < Hark et > = (5=l Cancel

6. Click Next. The next page of the Add Table wizard is displayed which allows you
to enter columns for the table.

continued on next page
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

7. Add the following column information:

— Name: cName

— Data Type:  Character
— Size: 10

— Format: x(12)

@ Add Table

Database: autoedqge.db

 The format size cannot be greater than size field.

= =‘_‘[ MEw Car Mame: Iu:Name
- 1 ehame Data Type: ICHARACTER[varC = | Size (10 cale: I

~Optional (

Format: Ix(1 2

!
Label: |7 |
Col Label: |7 |
Initvalue: | |

K S LR I bR e e o SN g

An error message will be displayed in the message area (@). This message
area is a common feature among some of Architect’s wizards and either shows
context help for the field that the cursor is in or an error/warning message,
depending on the information that is entered for a field. This error message
(The format size cannot be greater than the size field) indicates that the
format field size is greater than the fixed SQL field size that you set (currently
set to 10). This check helps to insure that the SQL field is large enough to hold
the number of characters that can be entered for a field as specified by its
format.

continued on next page
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued
8. Change the Format to X(10). The error message will disappear.
9. Click the Add button to add another column to the table.

@ Add Table
Database:autoedge.db

1
() Enter the display farmat used by the 4GLt0 display data. ‘

B ‘='_T MNewCar Name: |cName
o ehame

Data Type: | CHARACTER (varc [+ | Size I

—Optional

Format;

Lakel:

ColLabel: |?

Init value: |

Crrder: |1D r}

Description:

Help Text:

Wiew As:

Yalidation:

!
|
|
|
Wal hMeg: |
r

Casze Sensitive T Mandei

éddy\r\ls Copy | Bemovel

> st ,nm . . g nshn oy s PN oy &J

A New_Column label will be placed under the newly added cName column under
the NewCar table node. This indicates that the wizard is ready for you to add a
new field.

@ Add Table

Database:autoedge.db

(1) Enter a unigue column name within this takle.

= B NewCar f MName: Im,

g ;[i:fmgmumn Data Type: | CHARACTE

Dptional

'“"""—"‘“*a-f"“""m_-L“ _’.Mw—f"

continued on next page
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

10. Add the following two columns. Make sure to click the Add button as each

column is entered.

— Name:

— Data Type:
—  Size:

— Format:

— Name:
— Data Type:
— Format:

cDescription
Character
35

X(35)

dAdded
Date
99/99/9999

OpenEdge Architect Tutorial 2009
Copyright © 2008 PSC
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

11. Add a column with the following information:
— Name: aClob
— Data Type: CLOB
— Area: Auditing Area
— Code Page: UTF-8
— Collation: BASIC
i3 Add Table 0] x|
Database:autoedge.db
(1) Specify the database collation for the selected code page
]
= B NewCar Mame: |aC|Db ( /
el eMame . . _
i cDescription Data Type: ICLOEI (clok) J Slzel Scale: |
i dadded ~LOBE details ‘/‘
- B Ares IAuditing Area j
Description: ;I
o " Bhytes " KiloBytes
Mex Size. 100 % MegaBytes T GigaBytes
Order: |4EI—

™ Case Sensitive

o

Cade Page: |UTF-8 P =]
add | Copy | Remove | Collstion |BASIC x =]
N\
R e |
(7] < Back | Mext » %J Finish Cancel

12. Click Next. The next page of the Add Table wizard is displayed which allows you
to enter indexes for the new table.

122
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

13. Enter the following for the new index:

14.

— Name: idxName
— Area: Auditing Area
—  Primary: Checked
— Active: Checked
— Unique: Checked

Select the cName field in the Select fields list and click the Arrow button. Repeat
the process for the dAdded field.

L i g g T Al e g
r

1

¢ Table: |NewCar

! R »

A ame: ||dxl\lame #

?, Ared: IAuditing Area j
3

¢ Description: | |
¥

? Twpe: W Friimary W Active M Unigue I Word Index

)

_2; Selectfields to add to index; M

L T

‘

4

?E

b

.-'v[ “:-I-""-.-_-'\

o T

& Ascending © Descending

Pt e

N
< Back et > | : Finish rI Cancel

OpenEdge Architect Tutorial 2009
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

15. Choose the Finish button to complete the Add Table wizard. The table is created
and is displayed in the DB Structure view.

P AT e A e A

T
L1

- = 8

55 OB Structure &3 l

autoedge | Derpoore | temp-dh |
I

.
=
=] T:T.: Datakhase

=-8% AUTOEDGE

H.-—’\‘_.-M.-\-m-z-v./'«,__,\.'._,-ﬂ,ls

L

o

.HH.H.H.H.H.H.H.H

SN0 M
SWETEM TABLE
TABLE
- BaseCode
- Car
- CarBrand
- Cartodel
- Caontact
- Custamer
- Dealer
- Employee
- Qe
- TeatDrive‘\
WIENY
SEQLUEMNCES
TRIGGERS
DB DETAILS

%}Note: The DB Structure view is sorted in ASCII order.

@Tip: The DB Structure view is generally refreshed automatically when making
schema changes. However, if you think that the view has not been refreshed, you
can right-click on the Database node and select Refresh to refresh the nodes.

continued on next page
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new table, continued

16. Expand the NewCar node to see the columns and indexes that you defined.

B9 DE Structure 52

- — d

o

autoedge ||:|erp|:|:|re temp-db

—H
=t TABLE

w0 Car
---EI CarBrand
w1 CarModel
w- [ Contact
w0 Customer
w7 Dealer

- BaseCode

---Ifl Employee

[ |

& Columns [4]

ol eMame [character x(10]]
- B cDescription [character x(35)]
o dAdded [date 99/99/9999)
B aClob [clob x(80)]

H- 5 Indexes [1]

ﬁ idxMarme

_"\

B Testbve
F- B YIEWY

----- E SEQUEMNCES

OpenEdge Architect Tutorial 2009
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new column to the existing Table

The steps in this section show how to add a new column to an existing table in the

database.

1. Inthe DB Structure view, select the autoedge tab.
2. Expand the Database> AUTOEDGE-> TABLE nodes.

3. Right-click on the Customer table and select Add Column.

P
i

i ,.r-""'-'.*_"'-l--l P L L N L T Ry

< 0| 55 DB Stucture 52 - = 4
i

& autoedge ||:|erp|:|:|re termp-db

¢ |3

{ =& Database

$ =85 AUTOEDGE

_} ----- B SYMNOMY

m- B SYSTEM TABLE

1 =& TABLE

;FEI ---ﬁ BaseCode

_}T ---E Car

jJ—l &2 CarBrand

: - CarModsl

J ---E Contact

P a ISt C.ciome:

5 ---ﬁ Dea i Generate Selectin Sgl Editor
E ---ﬁ Emp 4 Edit Table Data
3 - MNew @ Refresh Table

-E Test = Create Table Script

WIE WY

oo o

DB DET

SEQUE ] Add Tahkle
TEIGGE 'E’” Edit Tahle

=% Drop Tahle

1

i

§:J .....

4 [ - 33 Security 1 Add Index
i

}

!

Copy Mame
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new column to the existing Table, continued

4. Inthe Add Column window, enter the following details:

— Name: EmailAddress
— Data Type: CHARACTER(varchar)
—  Size: 100
— Format: x(50)
— Label: Email
— Help Text:  Please enter your full Email address
i Add Column o] x|

Database:autoedge.db

(D) Enter a help message that appears whenewver a user is prompted o input data into the

field.
stamer Marme: |EmaiIAddress ‘/
CustomerlD Data Type: [CHARACTER (varchar) »| Size[100  Seale: |

CustomerFirsthame
CustomerkdiddieMName
CustomerLastMame
UserLoginlD

ContactlD
CustomerGender
CustornerBirthdate
CustomerBirthCountry
Customerlicenselate
CustomerLicenseExpinydate
Custormertotes
CustomerSearchField
LanguagelD
BaseCodeSalutationlD
Emailaddress

i

Add | Copy | Bemuvel

~Optional

Format: Ix(EEI) {

Label: |Email (

Cal Label: |7

Init Yalue: |

Order 180 [~ Extent |0
Description:

va

Help Text: |Please enter your full Email address

BE e Wl T LT

View As | Edit...
“alidation: | Edit...
Wl Msg: |

[ Case Sensitive [~ Mandatory

5

FEinish & | Cancel

OpenEdge Architect Tutorial 2009
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Adding a new column to the existing Table, continued

5. Click Finish. The DB Structure view will display the new column.

"F'_"""""_'"“"r"r"ﬂ"'—r"_"_"‘-‘f‘""'-.-""_""""""1""

BN &

!
“.—" 8

25 DB Structure 52 - = O

autoedge ||:|erp|::|:|re temp-db

=+l

S

- Contact
=-E Customer

=t Columns

CustomerLastName [character [
CustomerFirsthlame [character =
CustomertiddleMame [character
CustomerBirthdate [date 95/93,/39
CustomerBirthCountry [character

A CustomerlD [character <(b4)]

UserLoginlD [character <[64)]
ContactiD [character x(54)]
LanguagelD [character =(64)]
BaseCodeSalutationlD [characte
CustomerGender [logical MALESF

CustomerLicenselDate [date 99/3°

CustomerLicenseExpirydate [dat
CustomerMNotes [character X[401]
CustomerSearchField [character:

Emailaddress [character x(50]]

F- B Indexes b

[ |
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Generating a Create Table script

This section covers creating a SQL Create Table script for a table in the database. Once
the SQL is generated, you can use the scripts for deployment purposes or to create a
variation of the table by editing the script.

1. From the Architect menu, select Window->Preferences.
2. Select Progress DB Navigator in the left pane.

3. Check the Enclose in quotes box. This insures case sensitivity when generating
the Create Table script.

[ Preferences =] 3
Itypefiltertext Progress DB Navigator = T

" Genersl Frewview row limit: |BD

- Help

& InstallUpdate SQL Results row lirmit 2000

& OpenEdge Architect SOL Results rows to batch: [100

B Progress :

" Progress DB Navigator S0L editor separator: I;

a- Fun/Debug \ v Auto commit

& Team ¥ | Earmmit O Blmse

¥ Calumns auto-completing assistance. Use onby with fast database connections
V¥ Sawve and restore last selected node in Database Structure Yiew

Copy to Clipboard
WV Append tahle name to column
¥ Enclose in quotes

/ Delimitar: I

If catalogs are supported
’75“ Show catalag © Show schema

Restore Defaults | Apphy

3) * ok | cancal |

4. Choose OK to save and close the Preferences dialog.

5. In the DB Structure view, select the autoedge tab and expand the
Database>AUTOEDGE->TABLE nodes.

continued on next page
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Generating a Create Table script, continued

6. Right-click on the CarModel table and select Create Table Script.

e e e

T N R .
{ = O ||5% DB Stucture E@I - =08
: autoede | oerpeare | temp-db |
' »
_E L—"_IE Database
5 =85 AUTOEDGE
T - B SYNONYM
‘i B SYSTEM TABLE
P 515 TABLE
stary - =8 - BaseCode
| ---Ij Car
.{penEdge QLI_}' ---Ifl CarBrand
| w2
¢ sl Generate Selactin Sgl Editor

‘_ = Edit Table Data
,f‘ #a Pefresh Tahle
b8l 8 Create Table Script

|
i £ Add Table
% Edit Table
5 Add Column
7 5] Add Index
; % Drop Table

;— Copy Mame

3 1L

; |

=

The generated table script is created and displayed in a SQL Editor.

"CarBrandlD" warchar(367)

s T T N i e e T T e T e e e
nenEdge Editar :
$ 0 | L 50L Editor (B)sql 52 | =0|e3r0
3@ Y12 =/ |auoedge =]l autr:',:
oy create table "Carbdodel"{ Bl =
l} "CartdodelMame" varchar(16), _L:_I|
i "CartodelDescription” warchar(18),
' "CartdodellD" varchar(56) PRIMARY KEY,

b g,

v

}

¢ || DB Details 52 |52 SOL Resulis| [ SOLHistory. =) = O
1} ~|| Row Countl Privileges OpenEdge Table |OpenEdge Ci 4 | ’l
e L %E?‘\“ e T e e S e
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Generating a Create Table script, continued

7. Change the table name from “CarModel” to PUB.”CarModel2”” and set
CarModelDescription to varchar(100).

sl SCOL Editor (B).sgl 52 = 0
@ = J"_Iautuedqe jl
create tab@UEﬁ."CarMndelE" ;l

"CartdodelMamea” varcharTh),

"CartodelDescription” warch={{100])
= EEY,

"CarkdodellD" warchar(bh) FRIkA
"CarBrandID" warchar(5B))

4 of

@Tip: PUB must be included in the script to include it in the proper schema
area. For OpenEdge, the default schema area is always PUB.

@Tip: To maintain case sensitivity for table and column names, the names must
be surrounded by quotes. For instance, if you don’t quote CarModel2, then the
table name will be added as CARMODEL?2 when the script is executed.

8. [Execute the script.

continued on next page
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Generating a Create Table script, continued

9. Right-click on the Table node in the DB Structure view and select Refresh.

!
F
:

J T i T T s

@_E DB Structure &3 \ —

=0

autoedge | ORfpCare | temp-dhb

—+
S

i bt g N St O e

it

=-

i o @ Customer, .

& Datahase

=88 AUTOEDGE
----- B SYNONYM
w15 SYSTEM TABLE
EREE TAFLE |
...|j i
#-C [ Add Table

w- (£ Carerand
#-E Cartodel
= Contact

The newly created table is shown.

I.'_' R g———r --d'f

o e TV i v

=5
|

——
£
i

[

T e

M

L1

Fr T pmm—— v_,u

L,

2
]

@f DB Structure 23 l

sutoedge | nerpCore | temp-db |

—+
-

=& Datahase

=-8% AUTOEDGE

----- B SYMNOMNYR
- SYSTEM TABLE
- BaseCode
-3 Car

---Ifl CarBrand
Contact
---Ifl Customer
---Ifl Cealer

PR A L T
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Lab 6 — Modifying Schema using the DB Navigator,

continued

Generating a Create Table script, continued

10. Save the file as carModel2CreateTable.sgl in the AutoEdge project in the src
directory.

11. Close the file.
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Lab 7 — Using the OpenEdge Editor

Overview

The OpenEdge Editor provides many features to facilitate in the development of
OpenEdge applications. This lab is designed to demonstrate the functionality of the
OpenEdge Editor and the OpenEdge Editor perspective.

The lab consists of creating a new ABL program and displaying some data from the
database. Many of the available usability features for the Editor are covered through the
process.

continued on next page
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Lab 7 — Using the

OpenEdge Editor, continued

OpenEdge Editor Perspective

@ OpenEdge Editor - AutoEdgefsre/serverfautoedge/dacustomer.p - OpenEdge Architect - C:AOpenEdge. .. M=

File Edit Source Mawvigate Search

| - | A% |H~0~
[ |8F OpenEdge Editor

-

£ Resources 2 l =B

H=E
B 2 AutoEdge

H-a? Referenced Assemblies
AL Frocedure Libraries

Froject OpenEdge Run Window  Help
@~ | v L v
[F] dacustomerp 52 l [i] etcustomer.i =0
=l
DEFIME INPUT FPALRALMETER piMode L3 INTEGER  NO-UNDO.
DEFINE INPUT PARAMETER pcEmailId A% CHARACTER NO-TNDC.
DEFINE INPUT PARAMETER pcContactId LS CHARACTER NO-UNDO.
DEFIME OUTFUT PARAMETER plEmailValid A% LOGICAL NO-UNDO IMIT FALSE
LISIGN plEmailValid = TRIUE.
IF pcEmailld <> ™" ALND NOT

peEmsilld MATCHES "*@+*~_ %" THEM

£z Outine %% |89 DBS..| DPop..| = 0

Lo

E-42 Includes
=-@ Variahles
=-F TempTables
- ProDataSets
=@ Triggers
=@ Procedures
L@ eCustormerCreateBeginTrans (o
@ fetchiwhere (OUT datasethand
@ walidateEmail (integer. characte—

O
3

------ @ validateTestdrive (characte

Jl I

Do J
AZZIGH plEmailValid = FALSE.
MEZZLGE "Email entered is invalid" VIEW-AZ ALERT-EOX.

END.

TF meFwmed 1 TA <5 *0 THEN

il

al |

—+l, - =
B =

El Console | (2! Problems 53 l ) Tasks| B Keyword Help | D% Connection InfD|

o

0 errars, 2 warnings, 0 infos

Description -~ | Resource | Fath | Location |
= = Warnings (2 items)
& WARMNING: Executable staterne testheasnp AutcEdgefsroiservert..  line 80

& WARMING: Executable staternel puredGLT ... AuwtcEdgedsrofguidpure.. line 973

JmV AutoEdoe/srofserverfautoedge/fdacustomer.p J

Notes:

ABL Editor

Resources View

Outline, DB Structure, and Properties Views

oo oo

Console, Problems, Tasks, Keyword Help, and
Connection Info Views

OpenEdge Architect Tutorial 2009
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Lab 7 — Using the OpenEdge Editor, continued

Creating a new ABL program

The section shows how to add a new ABL procedure file to an existing project.

1. Open the OpenEdge Editor perspective or switch to the perspective if it is already
open. Close other perspectives, and close any resources that are open in the editor.

2. Expand the AutoEdge node in the Resources view.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Creating a new ABL program, continued

3. Right-click on the AutoEdge project and select New->ABL Procedure.

[ OpenEdge Editor - OpenEdge Architect - C:\OpenEdge\WR K\AutoEdgeV:
File Edit Mawigate Search Project OpenBEdge  Fun  Window  Help

| | LW |- 0- @4~ |5~ -0 -
2= |3§E OpenEdge Editor
£ Resources Eﬂl = EI”

- (2= OpenEdge Project
-l Pre Galnta = Project...
Ei ;‘ii Open in Mew YWindow [ ABL Class /
..... o L= Copy 1] ABL Interface
..... B pr FasiE B ABL Frocedure n
..... pr ¥ Delete [ ABL Include
..... [ as hdowe. . [ Falder
Fename... “ File

o= Outline & sug Import... = ABL Farrm

g g« s, EEL DI i

%}Note: As previously discussed, you can also use the New button or the
Architect menu File>New menu option to create new resources or projects. Just
make sure that the project in which you want to create the resource is selected in
the Resources view.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Creating a new ABL program, continued

4. Enter the following in the wizard:
— Container:  \AutoEdge\src
— File name: testDBConnection.p
— Description: Example ABL file which includes accessing a database

— Author: <Enter your name> (defaults to current user name)
@ New ABL Procedure _ O] x|

Create an ABL procedure file

Optionally identify the author of the procedure. This text will appear in the file header.

Caomntainet: |v3autc|Edge\,src: / Browse...

File narne: |testDElCu:unnediu:un.p

Description: [Fyarple ABL file which includes accessing a database

Burpose:

I*_ILILI;\_

Authar: |<Entery|:|ur name>| /

™ Add routing lessel error handling

(7) F Einish [1 I Cancel

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Creating a new ABL program, continued

5. Click Finish. The new procedure is added to the project in the Resources view in
the ABL folder and the file is opened in the Editor.

E'DpenEdge Editor - AutoEdgefsrcftestDBConnection.p - OpenEdge Architect
File Edit Source MNawvigate Search FProject OpenBEdge Bun  ‘Window Help

Jfﬁv J_{L\_J% ﬁvﬁv%vj{j'vJ - v’t‘:;:lc:lv -
ﬁ|3§£ OpenEdge Editar
£F Resources 22 l — 0 [:I__E testDBConnection.p E_EJ

S ) |
®H-= shared = File

. : cestDEConnection.p
- sonicesh

-2 winform
-2 autoedge-guiini Syntax
kol carModelzCreateTable sl J

B

sl CarQueny.sql Description : Example AEL file which

-kl GeneratedCarQuery.sgl

- [F] startp Authoris) : <Enter wyour namex
2 'tE'E“:I:Ir'II'IEI:ZT.iI:Ir'I.FEI, Created : Wed Dec 17 12:16:44 E3
e Notes

----- rdbconnactinn

Bz Outline 38 |*9DBS..| Tl Prop...| =

& 3 B
s, st datn sl e b gl | gl s MR | 3 SAS s i

lf?f o o o o o ol o ol ol ol Definiti

@Tip: A fast way to synch (expand and select the file) the open file resource in
the editor with the Resources view is to click the Link with Editor button (@) in
the Resources view’s toolbar.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor

This section covers writing ABL code using the OpenEdge Editor and will focus on
highlighting some of the features of the Editor.

1.

In the new file, after the Definitions comment, type dvlg. These characters
represent a macro that expands to a logical variable definition.

[F| *testDBConnectionp &2 l = 0
rY
e —
File testDEConnection.p
Purpose
Syncax
Description @ Exasnple AEBL file which includes accessing a database
Luthor (=) : <Enter wour name>
Cq?ated : Wed Dec 17 1Z:16:44 EXT 2005
Notes

f"'ﬁ e e i e e e e e e e e Lefinitions o e e i il e ol e e i e e

-
4| | b
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

2. Press the Spacebar. The macro is expanded.

[F| %estDEConnection.p &3 I = B

File ! testDEConnection.p
Purpose

Svntax

Description @ Exssople ABL file which includes accessing a datasbase

Luthor (=) ! <Enter wour natoe:
Created i Wed Dec 17 1Z2:16:44 E3T Z005
Notes H

nltanS ol i i i i e e
‘DEFII'-IE VARIAELE | 45 LOGICAL NO-UNDO.}
-
4| | b

6Tip: Architect supports a number of pre-defined macros and even allows you
to create your own. Available macros can be found in Workspace Preferences
(Windows—>Preferences) in the OpenEdge Architect>

Editor-> Templates(Macros) section. See online help for more information on
macros.

EE}Note: An asterisk (*) next to a program name in the Editor tab indicates that
the file has been modified in the editor since the last time it was saved.

M‘tgstDEiCDnnectiDn.p ‘
i —
File testDEConnection.p
Furpose

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

3. After the VARIABLE keyword enter the variable name IDone.

File : testDEConnection.p
Purpose

Svntax

Description @ Exssople ABL file which includes accessing a database

Luthor (=) ! <Enter wour natoe:
Created : Wed Dec 17 12:16:44 EST 2005
Notes

fE OEEERERERAFARRAELIFAFAFFARAF  [efinibions FEEEEEREEEREAARRFAFRERFRAAS
DEFINE UARIJLBLES LOGICALL NO-UNDO.

| -
4 | »

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

4. Open the Workspace Preference dialog by selecting Window->Preferences.
Expand the OpenEdge Architect node and select the Editor entry. Check the
Expand keywords and Case keywords boxes. Click Ok. This will instruct the
editor to fully expand partially typed keywords and to automatically capitalize
recognized keywords.

[ Preferences o) x]

|type filter texd Editor =i v -
" General ~ Tab preferences
- Help
& Install/Update  Inserttab
EI..Opir;Edge fﬁcxjru:hnec’c  Insert spaces
- Advance . ™ Replace contentwhen tak is pressed in ovenyrite mode
--Database Connection
----Debug‘, Mumber of spaces that represent a tah |4_
= Editor ~Indentation
i Meta Catalog ¥ Enable smart indent of new lines
----_Srtartlupi Busi . ™ Enable auto indent on paste
B PDS prousiness o ¥ Enahle tabular farmatting
- Wiews
-%isual Designer —Case
- Progress C MNoaction ©* Upper © Lower
#- Frogress DB Mawigator N
- BEuniDeb AS YOU e
- Fun/Debug ¥ Expand keywards
- Team
gp Case keywords
™ Apply keywordis) casing on sawve
¥ Expand datahase tahles and fields
™ Automatically prefix fizlds and tables with database name
¥ Enahle smart home and end keys
‘ | _4 Restore Defaults | Apply |

(7 * QK. [:I Cancel |

@Tip: You can control many of the Editor’s behaviors by modifying
preferences. View online help for information about the options.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

5. Back in the editor, type assign after the Main Block comment.

Description @ Example AEL file which includes accessing a database

Author (=) 1 <Enter wour name:
Created i Wed Dec 17 12:16:44 EST 2003
Notes H

l,"ﬂ‘ e e e e e e e e e e el Ol Ol el e e Definitions=s e ol ol e i

DEFINE VARIAELE 1Done A3 LOGICAL MO-TNDO.

llﬁ'ﬂ' e o e Ol i el Ol Preprncessor DEflnltanS ol e e e e e e e e e i

il ol ol Ol O i O O ol ol ol Main EBlock o o ol ol ol ol ol o ol ol ol o

-

| B
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

6. Press the Spacebar. The ASSIGN keyword is automatically capitalized.

Descriprcion @ Examwple AEL file which ineludes accessing a database

Luthor (=) 1 <Enter wour natme:
Created i Wed Dec 17 12:16:44 EST Z005
MNotes H

fF O EEERERERAFARARFAFRFRFRAFASEF  Definitions

DEFINE VARIAELE lDone AS LOGICAL NO-TINDO.

L ol ol ol o o o ol ol ol

f"'ﬁ i e e e e e i e e e Preprocessnr Definitions=s e e e e i e e e e o

il- . ITWRKTTW*XTWRKTTW*XTWH‘KT M=in EBElock

ol e e i e e i e i e e e e i

-

| BB

OpenEdge Architect Tutorial 2009
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

7. Type ID on the same line and the press the Ctrl and Spacebar keys.

e

=TT e e e e T e e e T e e e T T e _— 1 b
[r| %estDECannectionp &2 l =08
[
Description : Example AEL file which includes accessing a database
Luthor (=) : <Enter your name:>
Created : Wed Dec 17 12:16:44 EST 2005
Motes H

‘fﬁ oo o ol o ol ol o o o Definitions o o o o o ol o ol ol o o o o e o o

DEFIMNE WARIAEBLE 1Done A3 LOGICALL MNO-TNDO.
JE EFEERERLRLFLXRGFGHFGS Preaprocessor Definitions FEEEEEEEEEEEEEEEEEES

f* 1{#*1{‘#1{%*‘k*#*#‘k*‘k*‘k*#*#‘k*‘k Main Elock e o o e e O O e O

-'—.-""'—\1'-_J\_-J'\-___\Nr'v.h__,\.-_PV\,_-_..H-\_/V'wv‘_-"""'\_-’-_.\_rb:h-r—\.:b"]“-""NW/\.\ S e L T A

ASSTGHN 1d T
d | @ Done LOGICAL - testDBConnection | "|
@ LDBNAME () - Function = o
[ le & . B e - - |
ENeel: ® LdapStyleUriParser - System B | o E
ABL Console
Project 'bhutc OK ;I
Froject 'butc QK
>testDBEConnec Edgeh roode’ testDEConnect]
1 | 3
| Whitably
Prezs Cirl+Space to show full list

Upon pressing the key sequence Ctrl-Space, a list of options is displayed. These
options are valid object names (such as variables, keywords, or database names)
beginning with the characters Id that can be selected to complete the typed code.
On top of the list is the variable IDone that was coded earlier in this lab. You can
scroll through the list of options by using the arrow keys.

@Tip: It is useful to become familiar with the icons that are used throughout
Architect. Knowing the meaning of the icons can help you quickly understand
what is being presented to you. For example, in the list of options that was
presented, the © icon is used to identify variables and @ icon is used to indicate
that an item is a function.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

8. To select the IDone option, press the Enter key (you can also double-click on the
option with your mouse). The code will be completed with that option and the
pop-up list will disappear.

Description @ Exssople ABL file which includes accessing a database

Luthor (=) ! <Enter wour natoe:
Created i Wed Dec 17 1Z2:16:44 E3T Z005
Notes H

',J‘?f i e i e e o e e e o Tefinitions o o o i ol i i e

DEFINE VARTIAELE 1Done A5 LOGICAL NO-TINDO.

JE OREEEEREELEXRREEARAATY Preprocessor Definitions REEEEEEEEEESEEEEEAAS

',J'K FTEEE x - i i i i i Haln Black o i i i i
4| | >|

9. Complete the line by typing = false. Press Enter to start a new line.

=8

Dezeription @ Exssople AEBL file which includes accessing a datsbase _:J

Luthor (=) ! <Enter wour natoe:
Created : Wed Dec 17 12:16:44 EST 2005
Notes H

fF O EEERERERAFARRFAFRFAFARAAAAF  Definibions FEEEEEREEEAEAARRFAFRERFRAAS

DEFINE WARTAELE 1Done A3 LOGICAL NO-TRDO.
B JE OREEEEREELEXRREEARAATY Preprocessor Definitions REEEEEEEEEESEEEEEAAS

f"'ﬁ el e e e e e e e i e e i e e M=in EBElock ol e e i e e i e i e e e e i

LSS IGH lDDn |
| -
‘| | B

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

10.

Type for ea and press the Spacebar. The EACH option is presented along with a
pop-up help box that offers information about the keyword. You can give the box
focus and scroll to read the help. Press Enter to select the option.

A g g e TR e = T e _“j"’*'..—,....,g-"v--,.-v"'

==t e i RV
k3 1 =
18 || [F| #estDBConnectionp &2 ] i
A

fv Dezcription : Examwple ALEL file which includes accessing a database_:]
ﬁ.l

i Luthor (=) : <Enter wyour name:

} Created : Wed Dec 17 la:l6:44 EST 2008

i MNotes :

i . S R, S

i

\_: II.I"K e o e e e e e i e e e Definitions e o e e e o e i e e

E DEFIMNE WARIAELE 1Done L3 LOGICAL NO-TNDO.

5

1

\\v II.I"K e o e e e e e PrEDrDcESSDr Definitions e e e e
=

gﬁ

FEEETEERERFFETFEEEASSAATTAAS Madin Block FrEEEEAEEESEEEAEEEAGSEAETE AL
A GI 1Done = FALLIE.

B

3 FOR es ~

1 | = EACH - Option EACH Starts an iterating block, finding a single record
F s . vou do not use the EACH kenawaord, the Record phras
4 Bl Cansale one record in the table. FIRST Uses the criteria in the
¢ ||ABL Console first recaord in the table that meets that criteria. The Av|
i llproject 1o before any sorting. The following statement displays

; Froject 'k primary index of the Customer takle), notthe Custome
{i wtestDECOY FORFIRST Customer NO-LOCK BY Customer. Credit]
4

1

: /'

g

: i

—

Press Ctl+Space to show full list Prezs "Tab' from the proposal table or click for focus
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

11. Select the DB Structure view (by default it stacked below the Outline view). This
is the same DB Structure view that is part of the DB Navigator perspective. A tab
for each database associated with the project is displayed.

. ,—_-.,,,..1-- 4 St : T '-"-"-.r--‘- g g
- [r] testDBECannedian.p
.. dbrnnneart ;I

o= Outline BSDBS.. 82 T Prop.. — 8

DB Structure =
autoedge ||:|erp|:|:|re Emp-

_gb
EI'E Database -
E---@E AUTOEDGE
B BYNOMNYH
- B SYSTEM TABLE
=& TABLE
! m-E BaseCode
[ Car ]
|

E}Note: OpenEdge Architect makes it much easier and faster to work with
database schema than was possible when using OpenEdge Studio. One reason for
this is the functionality of the DB Structure view in the OpenEdge Editor
perspective. Having the DB Structure view available at the same time that you are
coding allows modeless searching of a database, the ability to quickly see data
types of fields, and the ability to copy schema names including tables and columns
directly into the Editor.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

%Tip: If the autoedge tab is not displayed in the DB Structure view, then the most
likely cause is that a SQL connection to the database has not been made. Go to the
Connections view in the OpenEdge DB Navigator perspective (or alternatively open
that view in the OpenEdge editor perspective). In the Connections view, connect to
the database if it is not connected. Select the active connection for the database. The
database should now be available in the DB Structure view.

®Tip: What if the previous tip didn’t resolve the problem? Another possible reason
that the database is not listed in the DB Structure view is that the database server is not
started. Architect contains some clues that let you know that this is the problem. One
is that the color coding for database references in the code is black (coloring in the
Editor will be discussed later). Also check the Console view to see if there are any
connection failure messages.

If a connection failure exists, restart the database server. Once it is started, restart the
AVM for each project that needs to connect to the database by selecting
Project->Restart OpenEdge Runtime from the main menu. Confirm that everything
was started correctly by checking the messages in the Console view.

®Tip: What if you have many projects that need to have their AVM’s restarted to
connect to the recently restarted database? Instead of selecting Restart OpenEdge
Runtime for each project, you can restart the workspace by selecting File=>Switch
Workspace from the Workbench menu. The current workspace is supplied in the
Workspace Launcher dialog. Instead of selecting a different workspace, just click OK
and the current workspace and all associated AVM’s will be restarted.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

12. Table and field quoting was turned on in a previous lab to maintain case when
working with the SQL Editor. For ABL code, you do not want the table and field

names to be in quotes.

Select Window->Preferences to open the Preferences

window. Select the Progress DB Navigator entry in the left pane and uncheck the
Enclose in quotes option. Select the OK button to close the window.

[E Preferences =1 F
|type filter text Progress DB Navigator = T
" General Fresview row limit IBD
- Help
w- Install/Update S0L Results raw limit 2000
£-Openkdge Architect SOL Results rows ta batch: |1 0o
- Advanced _
_ Database Connection| =0l editor separator: I;
- Debug ¥ Auto cormmit
- Editor W | CammitOn Close
& Meta Catalog V¥ Calumns auto-completing assistance. Use onby with fast database connections
- Startup ¥ Save and restare last selected node in Database Structure Wiew
- Tools for Business Lo
- iEws Copy to Cliphaard
Y visual Designer ¥ Append takle name to calurmn
[&rugress [ Enclose in quotes
#-Pragress DB MNavigator D%imiter: I
- Fun/Debug
#-Team
If catalogs are suppored
’75“ Show catalog ¢ Show schema
« | _’I Restore Defaults | Apphy |

* Ok I Cancel |

OpenEdge Architect Tutorial 2009
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

13. Make sure the autoedge tab is selected in the DB Structure view. Expand the
AUTOEDGE->TABLE nodes.

14. Right-click on the Car table and select Copy Name.

fﬁ_:ﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ
- B startp DEFINE VARIAELE

""" El iz 5L i Generate Selectin Sgl Editor

O Cl.utline 59 DR £ ﬁ Edit Table Data hEh ok w
O—

“u Refresh Table

] Create Tahle Script

"'”"I""'?:’m ‘Generaied Carduery SGl '__”

FTEEITFEEATES

ELUtEIEdgE | OEerpoo

° =/ Add Table
> = Edit Table
= 'Ea @D@atabase 77 Add Column
iuggril = Add Index
..... i
Cirop Tahle
-8 S5 Eli i
SRR By Copy MName EDESQE'
w2 Bt g Show Details ezt igi p
10 r:arEiBQ\ =Y |

0=
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

15. Position the cursor after EACH in the editor. Right-click and select paste (or press
CTRL-V) to paste the table name. Finish the line by typing NO-LOCK: and press
Enter to start a new line.

[F| %estDBConnection.p &2 \ =8
Author (=) 1 <Enter wour name:
Created i Wed Dec 17 12:16:44 EST 2003
Notes H

lfﬂ‘ e e e e e e e e e e el Ol Ol el e e Definitions e ol ol e i

DEFINE VARIALBLE 1Done AS LOGICAL NO-TNDO.
JE FEEEEREEAEEEEGEGEEAST Preprocessor Definitiong TERARASSEREERAEASSEE

C e e e e Main Block e e

L%3IGN 1Dgpe = Fi
ELC NO-LOCKE: |
-

F
|
1] | BN

[E}Note: When starting a new line in a coding block (in this case, a FOR EACH
block), the editor will automatically start the next line as an indented line. This
option can be turned off in the Preferences window under the Editor section.

I;}Note: The screen shot above shows some of the varied syntax coloring that is
possible in the OpenEdge Editor. The coloring options in the OpenEdge Editor are
much more sophisticated than those previously available in OpenEdge Studio.

This sophistication is reflected in the colors shown in the Editor such as keywords
in purple, data types in red, and database tables and fields in orange. For a full list
of the coloring options, and the ability to change specific colors, go to Workspace
Preferences and select OpenEdge Architect->Editor->Colors in the left pane.
While the coloring is nice for quickly recognizing syntax structures, it is only the
beginning since Architect uses the knowledge of the types of code to provide
numerous advanced editing features, which will be shown throughout this lab.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

16. Type disp on the new line.

[r| 4estDECannection.p &3 \ =0
huthor (3] 1 <Enter wyour namex
Created 1 Wed Dec 17 12:16:44 EST Z003
Notes

fE OREFERFARFARFFAFAGFAGFATFATF  Definitnions FEEFERFEREAAEAEEAAEAAAAAAEA

DEFINE VARIABLE 1Done AS LOGICAL MNO-TNDO.

JF REXTEXEXXLXLFERAERAY Preprocessor Definitions FEFEREREREEEEEEEEEEES

lfﬂ‘ e e e e e e e e e e el Ol Ol el e e Main EBElock e e e e e e e e e e e e e e e e e e e e

AISIGH lDone = FALLSE.

= FOF, et NO-LOCE: |
-
| B

<

Notice that while you are typing the characters change colors. This lets you know
that the editor is trying to match the characters to a corresponding syntax element.
After typing the p in disp, the characters turn purple. This means that the editor
has recognized the characters as a match for a keyword. Because we have
previously set the preference to expand partial keywords, pressing the Spacebar
will complete the keyword.

154
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

17. Press the Spacebar. The keyword will be completed for you.

Luthor (=) : <Enter wyour nage:
Created : Wed Dec 17 12:16:44 E3IT Z0O0S
Motes H

f’* ol o o ol o ol o o ol o o Definitions ol o o ol ol o ol o ol

DEFIMNE WARIAELE 1Done A3 LOGICAL INO-TNDC.

',’# e o e o o e ol o e Preprncessnr Definitions=s e i ol e e e o e o

f-'w o i e e e e ol i e e i i o M=in Block o o i i o i e i i e i e e o e i i

AISIGH lDone = FALSE.

‘FOi'i'iIiI'ﬁO—Lomﬁ o
CED -
4| | >|

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued
18. In the DB Structure view, expand the Car->Columns nodes.

19. A modification needs to be made to the DB Navigator preferences for copying
multiple field names from the DB Structure view to the editor. Open the
Preferences dialog and select Progress DB Navigator. Change the Delimiter
from a comma to a space and close the Preferences dialog. Changing this option
will separate multiple copied fields by a space instead of a comma.

@ Preferences _ o] x|
|typefilterte>d Progress DB Navigator =n v w

- Ganarel Freswiew row limit: |8IZI

=-Help

- Install/Updats SOL Results row limit 2000

i OpenEdge Architect SOL Results rows to batch: |1 no

- Progress _

# Progress DE Navigatar S0L editor separator: I;

& Run/Debug ¥ Auto commit

- Tearn ¥ | Carmrmit On Close

¥ Columns auto-completing assistance. Use anby with fast database cannections
v Save and restore last selected node in Database Structure Yiew

~ Copy to Clipboard
v Append table name to calumn
™ Enclase in quates

Delimiter:

ogs are supported

Show catalog © Show schema

Restore Defaults | Apphy |

S
(7 F O, [:l Cancel |

®Tip: A comma delimiter is what you would likely want if you are working
with the SQL Editor.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

20. Click on the CarlID column. Hold down the Ctrl key and click on the
CarDescription and CarlsAvailable columns.

_[“";"fffﬁ"t"@!!uw:ﬂhéﬁiﬁp”‘”ﬁil g e

;* EEFFFFTEEEE

o= Outline BSDBS.. 82 L Prop.. | — 8

= l.."ﬂ' FTHEFFFFFFFN

autDEdgE | CErpCore I temp_db | LIZIGH 1Done
- FOFR EACH
ST DISPLAY
5B Car =] «
E-’R@Jmmns L2 El Console 22 |20 Pr

ABL Console
Froject 'AutoEdge’

. Project !'AutoEdge
[cha >testDEConnection.

----- I DeslerdD [c:haran:tr (fe
i il

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

21. With the three fields selected, right-click on one of the selections and select Copy
Name. In the editor after the DISPLAY statement, paste the field names. This
adds the three fields qualified with their table name to the editor.

Author (=) 1 <Enter wour name:
Created i Wed Dec 17 12:16:44 EST 2003
Notes H

lfﬂ‘ e e e e e e e e e e el Ol Ol el e e Definitions e ol ol e i

DEFINE VARIALBLE 1Done AS LOGICAL NO-TNDO.
JE FEEEEREEAEEEEGEGEEAST Preprocessor Definitiong TERARASSEREERAEASSEE

l,l'ﬂ' e e o o o e e e e e Main Elock e e e ol e ol o e e e
ASSIGHN 1Done = FALSE.
SFOR EACH Car iee—fmensg

DISPLAY@;.CarDescriptiDn Car.CarIsivailakbhle Car.CarI@

1] | B

-

22. Finish the display statement by typing nonExistingVariable. and press Enter to
start a new line.

=08
Luthor (=) : <Enter wyour nsame: ;I
Created : Wed Dec 17 12:16:44 EST 2008
HNotes :

S OFEEFRFAARARAFAARGRAFAERGTNAT DeFinitions FETEERAEETREERERER@EREwA AT N7

DEFINE VARIALELE l1Done AS LOGICAL NO-UNDO.
JE OFXAXXFAXNXLAAXLANXETT  Preprocessor Definitions  sEEmssEmssaasssaasss ox/

S EEXXXAAXXXAXXLSTEELNLLRLLET Main Blogk FEEEEsELssmasamaaaaaswsacrw v/
ALISIGH 1lLDone = FALLSE.
“FOR EACH Car NO-LOCE:
DISPLAY Car.Carlescription Car.Carlslivailabhle Car.Carl nDnExistingUariab@ o
| -
= I

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Entering code in the ABL Editor, continued

23. Press Shift-Tab to remove the indent from the new line. Type end.

[r] 4estDBEConnectionp &3 I = B
Luthor (=) : <Enter wour name: :I
Created : Wed Dec 17 1Z:16:44 EST 2003
Notes H

',J‘?f i e i e e o e e e o Tefinitions o o o i ol i i e

DEFINE VARTIAELE 1Done A5 LOGICAL NO-TINDO.

f‘k L e o i e e e o e Preprocessor Definitions=s e e o e e o

f’* ol i o o ol e o o o Main Block ol i o o o ol e ol o o o o

BIZTIGN 1Done = FALLIE.
~FOR EALCH MO-LOCKE:

SPLAY nonExisting'_ |
| o

@Tip: If code indention gets out of order at any time, you can press CTRL+I to
automatically correct indentation levels. You can also use the Source->Correct
Indentation menu option from Architect’s menu.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Using Coding Aids

There are a number of coding aids available in Architect that can assist in the coding
process. The following steps demonstrate some of those coding aid features.

1.

Move the mouse and hover over the DISPLAY keyword in the editor. Context
help for the keyword pops up. This is a quick way to look up information about an

ABL keyword.

5&"‘""""*"-‘"—%'-"‘._ i P _'_'_'.-‘J"--f-v-r' ks Rl e s _,‘___.”J" e e _’__r‘-"'"'-“'-u- A
"— llﬁ'?f E o o e e o Main Elock o ol e e e e

Il:'_ AR TG lDV FALZE.

;- FOR EACH NO-LOCK:

! DISFLAY nonExistineg'

3 END.|  DiSPLAY- Satemen MK -

3 ! bowves datato a screen buffer and displays the data on the screen or ather

b output destination. The AV uses frames to display data. A frame describes how = 5
Al B Consale . . .

; constant and variable data is arranged for display and data entry. *You can let ABL

i ABL Consale  |construct default frames oryou can explicity describe frames and their characteristics.

3\ Project 'Aut :“
i ||Project r gy DISPLAY

ill>testpBconnd {[STP\EAM.stream | STREAM-HANDLE handle ][ UNLESS-HIDDEMN] T

‘:l [ {expression

3 4 | [formatphrase ]

= [[aggregate-phrase)]

H | “ritak [VWWHEM expression ]

.';{ I [
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Lab 7 — Using the OpenEdge Editor, continued

Using Coding Aids, continued

2. If'you need more information on the keyword, press the Shift-F2 keys while still
hovering over DISPLAY. The Keyword Help view is opened and displays the

ABL on-line help page for the DISPLAY statement.

L"“" B e e e e i o e e &
7
5) JT TEEEFEXRRFTRXRETEACT  Preprocessor Definitions  FRERSEETEEESAEEERSER
¢ =
20
i?_ JF FEREFAXERFRFARERFFAANEAEFEE Nain Blopk FEEEERAAAEEEFANAEREREARERLAES
Pl A3ZIGN lDone = FALSE.
FOR EACH HO-LOCK:
DISHLALY nonExisting |
END.| -
4| v
El Consaole | [2: Problems|£ Taskﬁ Keyword Help E@] =0
2
[
< | > |index|

/ |

DISPLAY statement

(ol

‘ Wiitable | Insert ‘ 255 |

P e I et T e
| uhetes W1 |

Ijé}Note: If Shift-F2 does not show keyword help, the likely cause is that the tab
for the editor does not have focus. Select the tab folder and try again.

@Tip: You can also open the Keyword Help by right-clicking in the editor and

then selecting the Keyword Help option.

OpenEdge Architect Tutorial 2009
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Lab 7 — Using the OpenEdge Editor, continued

Using Coding Aids, continued

3. Double-click on the Keyword Help View’s tab. This will maximize the view so

that its content is easier to read. This functionality is particular useful when
working the ABL Editor.

[ OpenEdge Editor - AutoEdgefsrcftestDBConnection p - OpenEdge Architect - CA\OpenEdgeWWRK\Aut

File Edit MNawigate Search Project OpenEdge Run  Window Help
GG (LR H -0 [ [ /7 mC o -
5 |8 OpenEdge Editor
| & Console (2. Problems ‘i—' Tasks [E Keyword Help &2 l =8|
=l &
oe : =l
% L< ] > ]index| d
&
os DISPLAY statement
o=
i Moves data to a screen buffer and displays the data on'%he screen or other output destination. The AVM uses
= frames to display data. A frame describes how constant agd variable data is arranged for display and data entry.

You can let ABL construct default frames or you can explicit describe frames and their characteristics.

Data movement

Database \
| Record buffer }—>| Screen buhr |
Syntax \
DISPLAY %
{ [ STREAM stresm | STREAM-HANDLE handle ] [ uwiLEss-mipoEn ] }
[ { expression
[ Fformat-phrase ]
[ { zggregate-phras= } ] ;I
[[lay |

4. Double-click on the Keyword Help View’s tab again to return it to its normal size.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Using Coding Aids, continued

5. Click on the FOR keyword. A black rectangle is placed at the closing keyword
(END) of the block. This feature, which identifies where blocks are terminated,
comes in very handy in a poorly indented program where it is difficult locate the

end of a block.

[F| ®#estDBConnectionp 53 } =0
buthor (=) : <Enter your name:> :I
Created i Wed Lec 17 1Z:16:44 EST 2008
Notesz H

fF O FEREREAFRFRFAARRFRFARGFAFAFF Definibions FEEREEEAEAEAAREAARRERFARGH

DEFINE WARILABELE lLone A3 LOGICAL NO-UNDOC.

FEOREEEREEREEEERRREENNN Dreprocessor Definitions RREEEAREESEETEEEEEE

fr v R R E R AR A AR AFRFAATFAFHFF Madin Block FEEEEREEEAEAEAAREAARRERFAAGH
L3 M lDone = FALZE.

Fom EALCH NO-LOCE:

] PEEY non :-c1st.1ng:[T
] [

@Tip: The opposite also works. You can place the cursor on the END keyword
and the editor will place a block where the code block begins.

E}Note: This blocking functionality is common in Architect, and works not only
for code blocks, but also for quotation marks and brackets. Also, with quotes and
brackets, once you type in the starting quote or bracket, Architect adds a matching
quote or bracket respectively. This option can be configured in Preferences under
the OpenEdge Architect-> Editor—> Assistance option.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Using Coding Aids, continued

6. Another way to determine a blocks scope is to use the marker bar. Place the cursor
over the minus (-) sign in the marker bar next to the FOR keyword. A line is
displayed from the minus sign to the last line in the block.

._h.__,,‘ N P e - -nf""'i"'"'""-"' "‘1_ A T I g

ll."ﬂ' FEFTFATFATFIATFIATASANSS PrEprDGESSDr Lefin

JE TEALTAXALLAALLAAALXARLSARLSE Main Block
glﬁé@m 1Done = FALSE.
OR EACH HO-LOCK:
DISPLAY
END .

2

7. The minus sign can also be used for code folding to hide blocks of code. Click on
minus sign. This collapses (folds) the block so that only one line is visible. The
indicator in the marker bar changes to a Plus (+) sign.

B
Y rE ww'%r".i-'w?wwwwwwwwmm‘pfeﬁ_&é‘sgaﬁéf‘l

%wawwwwwwwwwwwwwwwwww *%% Main Bloc
IGH 1Done = FALL3E.

HFOR EALCH NO-LOCE:[]

al

This feature is very useful in a large program. By collapsing large blocks of code
that you are not currently working with, you can focus on the areas of code that
need attention. The ellipse indicator (@) shows that the current line has been
collapsed and that more code exists than that which is shown.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Using Coding Aids, continued

8. Place the cursor over the Plus sign. The first few lines of hidden code are
displayed. This is useful if you need to quickly view the code contained in a
hidden block.

[F| *testDBConnectionp &3 } = O
buthor (s) 1 <Enter your name:> ;I
Created t Wed Dec 17 12:16:44 EST 2008
Notes :
',".'f i ol ol e e e DEflnltanS Ea e
DEFINE WARIAELE 1Done AS LOGICAL NO-TIDO.
B f"?f o e ol e e ol e e PrEprDCESSDr DEflnlt—anS o e e
B ol o ol ol el ol ol Mai Elock ool o o el ol ol ol ol ol ol ol ol o ol
S3IGN lDone = FALSE.
AIFOR EACH Car NO-LOCK:
DIZPLAY Car.CarDescription Car.Carlsivailable Car.Carld nonExistingy |
llEnD. |
1] . B
9. Un-collapse the block by clicking on the Plus sign.
continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors
This section contains an overview of the error reporting features of the ABL Editor and
associated views.

1. Make sure the editor’s tab is selected and select the Save button. The asterisk next
to the program name in the Editor tab is cleared.

@'DpenEdge Editor - AutoEdgefsrcftestDBConnection.p -
File Edit pdhource  Mawigate Search Project OpenEdge  Bun Win

I9=Ela | £ L 350~ 5| &=l =t

5| |3EE OFiSENE (Ctrl+5]|H

& Resources B2 | = 0O [r| MestDEConnection.p &3
T | =] lg = Luthor (s) 1 <E
E? sonicesh ;I Created e
. HNotes :
#-= winform 4
|2 autoedge-guiini
i il carMogdel?CroateTable sql o, Ma /1t 77 x5 aniaiea s 1t

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

[ OpenEdge Editor - AutoEdge/srcftestDBConnection.p - OpenEdge Architect - CA\OpenEdgeéwWRK\Aut... [M[=1E1

File Edit Source MNawvigate Search Project OpenEdge  Fun Window  Help
[Ref SR SAF AR AR SO RO R AR PRI AR S chel i50
i | &F OpenEdge Editor

& Resources 22 = O||¢# testDEConnectionp &2 =8

| = ,g = Luthor (3) : <Enter your name:x ;l!
_mE3 sonicesh _:J ;;::;ed f Wed Dec 17 12:16:44 EST 2003
(= winfarm
= autoedge-gui.ini
EﬂcaﬂdudemtkemeTaMBsq\ SF FEFEERLERLERLARFARLALSALAAT  Definitions FEEEEEEEEAEAEEAREAEEALE RGN
5l CarQueny.sgl DEFINE VARIALELE 1Done A5 LOGICAL NO-UNDO.

Ll GeneratedCarQuery.sql

: [F] star.p
¢ testDBConnectionp LI

= — e
o= Outline |5 DB S.. 82 |El Prop. | = O
o snmnnmwannannranrwnnnnannun  Wain BLOCK FREREEEAAEREEEE AR AR AR

= LSSIGH 1Done = FALSE.
- : =

autnedge |oerpcore|temp—db| © @ror zach Wo-LOCK:[] e_’
L2 —

- B Car =] | {

. B-1 Columns [12] 5 = =
= ||| 2 Consote | Proti £ Tasks |2 Keyword Help 5 ]
_____ ) o it [t El Conzale |[Q_ roblems |~¢ asks [I% eyword Help I

- B CarAddedDate [date 3¢ . f’
----- B Carlséwailshle [logical L=< || > ||index|

& Carld [character X(E4)]

P ----- f DealedD [character X(bie DISPLAY statement z
4 - | » { | .H

[ e |Writab|e | Insert | 271 |

JF EEEEEAEEXXELRAELSAGS Preprocessor Definitions R EEEAESSRTEEAESLAE

The program will be saved and an attempt will be made to compile the program. Ifthe
compile was unsuccessful, error markers will be displayed next to the file’s name in
the editor tab (@), next to the file’s name in the Resources view and the directory
where the resource resides (@), in the marker bar next to the line where the error(s)
occured (©), and in the overview ruler ().

@Tip: The marker in the overview ruler (@) represents the location of the error
relative to the entire file. This is useful when you are working in a large file since it
allows you to position the viewing area to the location of each error even if the lines of
code with the error are not currently visible in the editor.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

%}Note: Hovering over the red box in the upper right-hand corner of the editor
will display the total number of errors in the program.

(i e [

L

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

2. Hover over the error marker in the marker bar or error bar in the overview ruler.
The error message for the error will be displayed.
& testDECannection.p &2 l = 0
Luthor (=) : <Enter wour name: = |I
Created : Wed Dec 17 1Z:16:44 EST 2003
Notes H
',"'R e e e e e e e el DEflnlt—anS o o e e e
DEFINE WVARIAELE 1lDone A% LOGICAL NO-TNDO.
f‘k e Preprocesgor DEflnltanS o i ol ol e e e e
f‘k Ea i Haln Bchk Ea o o
LZZIGN 1Done = FALLSE.
%"r' kultiple markers at this line =
** CADpenEdge\wWRE\AUtOEdge'ShAutoEdgehsroitestDEConnection.p Could not
|[understand line 25. (1386) -
-** Unknown Field or“arnable name - nonExistingvarahble. (201) | >
@Tip: In many cases it is useful to see the line numbers in the editor. To toggle
the line numbers on/off right-click in the Marker bar and select Show Line
Numbers. A check mark will appear next to that option indicating that line
numbering has been turned on. You can also set this option in the Workspace
Preferences dialog in the General->Editors-> Text Editors section.
continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

3. Click on the Problems view. The Problems view shows a list of all the detected
errors and warning messages for the resources contained in the workspace.

. — e Ve — - e, -
w T4 srermrmen BT, i .o—-’uﬂ..n.r_—__r.,”_' e T gl il - T p—

pr—

o
B 1| | E

I> El Console |[2 Proklems 23 I«: Tasks||§| Kesaword Help| o =S
'TEUJ 3 errars, 2 warnings, 0 infos

‘gt Description =~ | Fesource | Fath Location | ;|
?I = & Errors (3 itemns)

%] @ * CA\OpenEdgeywRkyAutoEdge testDBCo...  AutoEdge/src line 25

:;{(5 hi @ ** Unknown Field or Variahle nar testDBCo..  AutoEdge/src line 25

* @ Compilation failad with errarin sr testDBECo...  AutoEdge/src Unknomwn ;l

|

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

4. Double-click on the Unknown Field or Variable name error in the grid. This
repositions the cursor to the line of code in the editor with the error. If you click
on an error for a resource that is not already opened, the file will also be opened.

e

it = W

L Lo L™ _,,,.--r""fﬁ-""-"-—r—'-_,._#_...v—"r-\,..—e""'""'*. s S ———
== JE O RTFEREARRRFTRERRFREFRFAAFET Main Block L s i L

=

4 m; AZSIGH 1Daone = FALZE.

— FOR EACH NO-LOCK:

I}— DISPLAY Car.Carlescription Car.Carlslivailakble

1 o
J}jA I |
5

%

ac

E gbnsole |2 Prokblems i3 ] 7z Tasks| B Keywaord Help| Y =0
3 enprs, 2 warnings, 0 infos

':-,95 Digscription = I Fesource I Fath I Location | -
B =f%: Errors (3 iterns)

fh @ ** CAOpenEdgeVWRILAUDE doe testDBCo...  AutoEdge/sro line 25

5?(5 i @ ** UUnknown Field or varighle nar testDBCo...  AutoEdge/src line 25

; Compilation failed with error in sr testDECo...  AutoEdgefsrc Unknown ;l
; | Writable | Insert 25 : 81 |

5. The error in testDBConnection.p is the unknown variable named

NonExistingVariable in the DISPLAY statement. Delete the variable from the
DISPLAY statement.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

6. Right-click in the editor area and select Check Syntax to verify that the syntax
was fixed. A message appears showing that the syntax is correct. Click OK to
continue.

Fle/srcitestDBConnection.p - Op il e\wRKwAut... M=l ]
;‘f(u:h Froject OpenEdge  Run  ‘Window  o5ce »
B RCTN T E e
'IE Compile k
Y 0| f “testDBConnectionp £2 Keyword Help ShigF2 =0
= SREERER ©OUER YR Toggle Breakpaint - |
§t| fores Shg\i Referenies Ctrl+Shift+G .
IS.: - v e
z Open Declaration
) /1€ ol o o o o o o ol o ol o o ol o
\;.| DEFINE WARIAELE lDone AZ Fun As r
o Debug As v
(’r Team b

/1€ ol o o o o o o o o o o | ol o o ol o
[ Compare With *
4 [ Feplace With v
\f}: JE OREATEAATRAAT DTG NG AT OpenEdge L O T )
£ B 13SIGN 1Done = FALSE& Praf
= FOR EACH NO-LOCK: [EIBIEnEes.
— e DISPLAY =
i END . |
'\ -
e T i
i il P -y _ -__?,“—‘"
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

7. After performing the syntax check, the error screen decorator for the file (@) and
the error in the Problems view (@) will still be shown. This is because these
markers show the status of the file that is saved to disk and this file has not been
saved yet. However, the error bar (©) will be removed and the error marker (@)
in the marker bar will be grayed out.

[ OopenEdge Editor - AutoEdgefsreftestDBC~nnection.p - OpenEdge Architect - C\OpenEdgeWwRKiAut... M=1EI
File Edit Source Mawvigate Search Project Op ge Run Window Help

IC-EolfuB s 00 | A= ¢80y -
[ |€F OpenEdoe Editor

& Resources 2 = O | g| estDBConnection.p &3 =0
| )~ Trenied eTECrEC LTIt IETaT Lol Lu0s =
. = Notes
#-(= sonicesh -
(= winform
autoedge-guiini S R ERREREREETARFFAATRFAAATFF  Defininiong  FETERREAREEETERAFAAEEETARS
L) carModel2CreateTable sqf DEFINE VARIAELE lDons LS LOGICAL NO-UNDO.

sl CarQuery.sgl
| GeneratedCarQuery.sgl
startp

éﬂ testDElConnection.po ﬂ o
" - '

S R EEREEREREETARFFEATEFAAARFF Main Block FRATERREARREETERA RS MEAES

EE Oulline | 5FDBS.. 2 :Per... g ASSIGH lDone = FALSE.
= FOR ELCH HNO-LOCK:

JF RTEEXEXELLXAAELEAEST Preprocessor Definitions AR EERAESEERTESTEES

=1

(x} DISPLAY
autoedge |aerpcore| temp-db| END. |
=B Car d ‘I | '
5 Columns [12] g El Console | 2. Prablems 2 ]«. Tasks||§| k.eywiord Help| - ~8
8 CarDescription [ch 3 errors, 2 warnings, 0 infos

CarAddedDate [date 9¢

Description = | Fesource | Fath | Location | -
CarlsAvailable [logical

= Errors (3 iterns)
Carld [character X(54)] @ * C\0OpenEdgetRKyAoE dge testDECo.. AutaEdgefsrc line 25 |
e DealerlD [character (6 - @ **Unknown Field or ¥ariable nar testDBCo...  AutnEdge/src line 25
I > @ Compilstion failed with error in sr testDBCo...  AutoEdge/src Unknown ;I
[ ‘ Wiitahls ‘ Insert | 25 - B |

@Note: Architect also only runs files that are saved on the disk, not from the in-
memory copy that is visible in the Editor. The saved procedure on disk still
contains the error and would fail if executed.
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Lab 7 — Using the OpenEdge Editor, continued

Viewing Errors, continued

8. Save the file.

[ OpenEdge Editor - AutoEdge/srcftestDBConnection.p - OpenEdge Architect - C\OpenEdgeéwWRK\Aut... [M[=1E1
File Editp#f=ource MNawvigate Search Project OpenEdge  Fun Window  Help

10 @ [ L [0 -G [ [Pl s
5 &F OpenEdge Editor /
[ festDEConnection.p &

& Resources 2% =0 =0
LLEdLEl » B UEC LY LA L0 T Lol U000
: == -
: - | Bl Hotes : —I
-2 sanicash =]
(= winform
autoedge-gui.ini FE OEEETAAEEEATEAARERAGARAAGAAT  Definitions AR EEEEEAARETAREEAARAAEERAS

EicaﬂﬂudemtkemeTaMBsq\ DEFINE WVARIAELE l1Done AT LOGICAL NO-TNDO.

Ll CarQueny.sgl
Ll GeneratedCarQuery. sgl
stan.p

[
[F] testDBCannection.p =

JF OEEEEAAEERXELRAELTANS Proaprocessor Definitions R EEEAESSRTEEAESLAE

fE REEEEARFRFERRRFAFARRASATFFF  Main Blomk  FREAFEEEEE AR EREEREARARASALS

o= Outline |EE DB S.. 2 |2l Prop. | = O /3551(}1\] 1Done = FALSE.
= =

FOR EACH Car NO-LOCK:
DISPLAY Car.CarDescription Car.CarIsiwvailshle Car.CarIdI.

autoedge |Derpcﬂre | temp—dh' END.

o =

E |

: EIEI Car ;I d I :
B8 Caolurmns [12] El Console | [Zi Problems XléTaskSE Keyward He|p| B

B CerDescription [chara% 0 errars, 2 warnings, 0 infos
-8 CarAddedDate [date 9 Description =~ | Resource | Path | Location |
- B CarlsAwailable [logical & Warnings (2 ftems)

- -

o Carld [character X(64)] & WARNING: Executahle statemel testbeasn.p AutoEdge/srcfservert..  line 80
L ﬁ DealerD [character X(6 - & WARMING: Executable statermel puredGLT... AutoEdge/srcfauifpure... line 973

4] »

[ ar |Writab|e | Insert | 25160 |

All of the error markers and errors in the Problems view will be removed.
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Lab 7 — Using the OpenEdge Editor, continued

Running code

In a previous lab, you set up a Run Configuration that started the entire AutoEdge
application. This section shows how to set up a configuration that executes just the
procedure you are working on.

1. Select the down arrow next to the Run button and select the Run Configurations
option. The Run Configurations window will open.
3 OpenEdge Editor - AutoEdgefsrcftestDBConnection.p - OpenEdge Archi
File Edit Source MNawvigate Search Froject OpenEdge  Run Window  Help
eSO SH I GER-NE S AP R RIS NIRRT S eReR
= |33‘ OpenEdge Editor 1 AutoEcdge Complete Application
& Resources 3 l Fun Ag
| = |_ Fun Configurations...
& sonicesh Organize Favorites.. ™ |
-2 winfarm
_____ = autuedge_gL“lnl f"ﬁ e e i e i e e i e e e e e
_____ L carModel?CreateTable s DEFINE WARTABLE 1Done iS5 LOGTCAL HO-
et - SV TSR ST, . ..-..-Av_ e A s i
2. Select the existing AutoEdge Complete Application entry that you created in a
previous lab. Click the Copy button to copy the configuration. This will duplicate
all of the previous settings without having to set them manually in the new
configuration.
@ Run Configurations
Create, manage, and run configurations
S Marme: |Aut|:|Ed|:_:|e Cl:um‘
prtlDup”EEltES the currently selected launch configuration
|_| DpenEdge Appllcatu:nn -
4 Anplication Froject:
\ |V|AutDEdge
Etanup program:
- Fun this program
L i il il b a s
B St e ettt S = e T 4
continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Running code, continued

3.

In the Main tab, change the new configuration name to Generic Run. Select the
Run selected program in workspace option in the Startup program group.

]
L

5

@

%ted program inyour workspace each time you start the configuration. @
j— 2

2 !

!— MName: |Genenc Fun

]

1 Main | [£] Starup | wf PROPATH | ' Databases| =l ABL| W Culture| B4 Perormancs | & Logging| 7 Enviranment| = Comman |
I _ R .

In Froject:

an { IAutoEdge Elrowse...l
H -~

; ~Startup prograrm: k/

Y " Run this program (:I\Run selected program in workspace

I

i |Start.p i

{, Yatkemace.. || e Eysterm. Variables...l

]

; .

” Waorking directory, - " - o ~ = - .H“‘_’J_u
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Lab 7 — Using the OpenEdge Editor, continued

Running code, continued

4. The rest of the settings, such as the PROPATH, were copied over from the other
configuration, so click the Apply button to save the configuration.

5. Click the Run button.

e T e e I
1
{
£ Copy Froject Settings...l
,
;
| e | Eewvert |
[ h
Z
)
2 Fun Close |
I .
continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Running code, continued

6. The program runs and data from the database is displayed. If you encounter an
error, review the Problems and Console views to diagnose the problem.

id Progress _|O] x|

D escription
Car (D

"White Hinda Civoc Hatchback 3.0 [F Available?

f905c7¥4d-1385-a79e-dd11-abb31 67 ab7 43
Red Hinda Civoc Convertible 2.0 [# Available?

f905c74d-1385-a79e-dd11-abb31 7 7ab7 43
Brown Hinda Civoc Conwvertible 1.6 [F Available?

fA05c74d-1385-a73e-dd11-abbB1 8725748

|F'ress gpace bar to continue. o

7. Press Esc and then the Spacebar at any time to close the running window.

&. Close the source file in the editor.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Modifying and existing resource

This section will add validation logic to the Contact Email address column and adds the
Customer Email field (added to the database in an earlier lab) to the code for future use.

1. Click on Resources view and either press Ctrl+Shift+R or select
Navigate->Open Resource from the Architect menu.

2. In the Open Resource dialog, enter dacustom in the text field. As you are typing
the characters, resource files will be filtered to match the characters you are typing.

3. Select the dacustomer.p file and click OK. The file will be opened in an editor.

4 Open Resource M= F1
Selectan itewen [? = any character, * = any string]: hd
Idacustumer

batching items:

dacustomer.p

= AutoEdge/srofsenernfautoedge |

7 I Y OK 1. | Cancel |

%}Note: The In folders area (@) will display the location of the selected file.

“Tip: This method of opening a resource file is faster than searching through
the Resources view’s tree-view for the resource—as long as you know the name of
the file you are looking for.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Modifying and existing resource, continued

4. Click on the Outline view. Expand the Procedures node and click on the
validateEmail entry. Doing will reposition the editor to that procedure.

3 OpenEdge Editor - AutoEdge/srciserverfautoedgef/dacustor
File Edit Source Mawigate Search Project OpenEdge Bun Window

Jf'ﬁ'v leJDﬂJﬁvﬂv%vJQvJ - - {_’::I
2] |3§E OpenEdge Editar
£ Resources B2 = O [f] dacustomerp 52

“PROCEDTRE walidateEmail

| = i

..... [r| dacustomerp ;I Purpose etermind
---- @ dadealerp Parameters: INFUT po
----- [F] dadealaerlistp INPUT pe
----- [F] daemploves.p INFUT pe
----- [F| daemploveslistp OUTPUT p
----- [F] dalanguage.p
..... [F| daschedulep Notes If walid
F o e, A l|EE
al I
o= Outling &2 | EF DB S..| T Prop... DPEFINE INFUT FPARLME

DEFINE INFUT FARLME
DEFINE INFUT FARLME

F-43 Includes
El@ Frocedures
.8 eCustomerCreateBegin

DEFINE OUTPUT PARAMET
|
El Console [L Froblems &2

...... @ walidateTestdise (character, OUT) | U &rrors, 2warnings, U infos
Description -~
'ﬂ“‘""m-—ﬂ-&&_w‘m-m._ Tt -h'wxx

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Modifying and existing resource, continued

5. Add the code that is highlighted below after the first ASSIGN statement (you can
copy and paste the code from the following document):

Procedure: validateEmail Program: dacustomer.p

ASSIGN plEmailvalid = TRUE.

IF pcEmailld <> """ AND NOT

pcEmailld MATCHES "*@*~.*" THEN
DO:

ASSIGN plEmailValid = FALSE.

MESSAGE "Email entered is invalid" VIEW-AS ALERT-BOX.
END.

IF pcEmailld <> """ THEN

6. Save the file.

continued on next page
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Lab 7 — Using the OpenEdge Editor, continued

Modifying and existing resource, continued

7. Press Ctrl+Shift+R in the Resources view or select Navigate=>Open Resource

from Architect’s menu to open another resource file.

8. Using the Open Resource dialog, open the etcustomer.i file.

9. Add the EmailAddress field to the eCustomer TEMP-TABLE as highlighted

below:

DEFINE TEMP-TABLE

[* fields from customer table */
FIELD CustomerID

FIELD CustomerFirstName
FIELD CustomerMiddleName
FIELD CustomerLastName
FIELD EmailAddress

FIELD BaseCodeSalutationID

Program: etcustomer.i

BEFORE-TABLE eCustomerBefore

AS CHARACTER LABEL "CustomerID" ...
AS CHARACTER LABEL "First (Give ...
AS CHARACTER LABEL "Middle In ...
AS CHARACTER LABEL "Last(Fami ...
AS CHARACTER FORMAT "X(64)"

AS CHARACTER LABEL "Salutat ...

10. Save the file.
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Lab 8 — Using the OpenEdge Debugger

Overview

The OpenEdge Debugger is fully integrated into the Architect environment and works
seamlessly with other tools in the environment. It also has an intuitive interface that
allows for easy organization of debugging data. Multiple debug sessions can be run
simultaneously and the tool provides source code viewing while debugging an application.

This lab provides an introduction to the OpenEdge Architect Debugger and how to use
some of the available debugging features.

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

OpenEdge Debugger Perspective

@ OpenEdge Debugger - AutoEdgefsrciserverfautoedgefdacustomer.p - OpenEdge Architect - C:A\OpenE... [ H[=1E1

File Edit Source MNavigate Search Project OpenEdge Run  Window Help
= |3~ 3 -~ |5~ | - - A5 -
Eﬁ’lﬁﬁ OpenEdge Debugger €57 OpenEdge Editor
%5 Debug E:@l 3 |2 = & = | ¥ = 0| 6= Variahles 23 | ©o Breakpoints @“-L"Expressions| =l Dynamic Obj...| =0
B AutoEdge Complete Application [DpenEdoe Application] - S =
El'u'f:? startp atlocalhost NeTa | Value 6 i’
E|u]'1‘I EpenEdge Avhd (suspended) . : _ © hSupporProc 1474
; autoedge/dacustomer.p validateEmail( ... ) line: 127 @ KvalidateProc 2
autoedge/bhecustomer.p validateEmail( ... ) @ hDataSet 1EE2 -
autoedos/becustomer.p eCustyalidation] .. ) ] | 3
autoedge/becustomer.p eCustomertdodifyFreTrans) . » o
4| > 5l 2|
[F] dacustomer.p 2@] [i] etcustomer. | ] startp | =08
120 DEFINE INPUT FPARAMETER pcEmailld A% CHARACTER NO-THDO. A
1z1 DEFINE INPUT FPARAMETER peContactld A% CHLRACTER NO-UNDO. e
1z2
123 DEFINE OUTPUT PALRAMETER plEmailValid 45 LOGICAL NO-UNDD INIT FALSE.
1z4
1z5 AI3IGH plEmailVWalid = TRUE.
=

IF pcEmailld <> ™" AND NOT
pcEmailld MATCHES "%@%~, %" THEN

=
1| | »

El Console %]\ETasks| = eil&&| 2 B8-ri>708
AutoEdge Complete Application [OpenEdge Application] ChProgress\OpenEdgeibiniyprowind2 exe (Dec 21, 2008 4:49:33 Pi)

=
A o

N |

Notes:

© Decbug view showing execution stack.

® Information views including Variables, Breakpoints,
Expressions, and Dynamic Objects views.

© Editors with current line and debugging markers.

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process

This section shows you how to set up and start the debugging process.

1.

To make sure that all files are compiled and up to date (especially since changes
were made to an include file in the last lab), right-click on the AutoEdge project in
the Resources view and select OpenEdge—>Compile. A progress screen will be
displayed as the files are compiled.

3 Compile files M[=]E3

\1,) Building...

Compiling srchsersensetupideletedata.p

3

™ Always run in background

Fun in Background Cancel Details »»

EE}Note: A program must be compiled before it can be executed in the Debugger.
If r-code is not available for the file you are trying to debug, you will receive an
error message. Also, make sure that you have saved any changes you have made
to any files in the editor and recompile them. Otherwise, you could end up with
old r-code being executed by the Debugger.

E}Note: You may notice that the terms compile and build are being used in
Architect. The Eclipse framework uses the word build, while OpenEdge has
traditionally used the term compile. For the purposes of this workshop, these two
terms have the same meaning.

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued
2. Ifnot already opened, open the dacustomer.p resource file.

3. Navigate to validateEmail internal procedure (you can use the Outline view to
help).

4. Double-click on the debug marker area as shown below. This sets a debugging
break point for the program at that location.

[F| dacustamerp £3 I [i] etcustomer.i | =5

DEFINE INFUT PARLMETEER piMode A3 INTEGEER NO-TINDO .
DEFINE INFUT PARLMETEER pcEmailld A3 CHARACTER NO-TNDO.
DEFINE INFUT PARLMETEER pcContactId A5 CHARACTER MNO-TNDOC.
DEFINE OUTFUT PARLMETEER plEmailValid L3 LOGICLL NO-TNDO INIT FALALSE

AIZTGH plEmailValid = TRUE.

(IF pcEwailld <> "" AND NOT )
PCEMAilld MATCHES PFE+~.*" THEN

Do J
ASSIGN plEmailvalid = FALSE.
MESSAGE "Email entered is inwalid” VIEW-A% ALERT-EOX.

END.

TF +wreFwad 1 TA <~ PP THRER x
a| | »

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

5. Select the down-arrow next to the Debug button in the Architect toolbar. Select
the AutoEdge Complete Application option. This will start the debugger using
the Run Configuration you set up previously to run the entire AutoEdge
application.

3 OpenEdge Editor - AutoEdgessrciserverfautoedgefdacustomer.p -
File Edit Source MNavigate Sa@gfich Froject OpenEdge  Run Window  Help

It e | LD s~ 0@~ |5~ L5l =00~

1= |3§‘ OpenEdge Editor 3 1 AutoEdge Complete Application
£ Resources B2 & CEmane R armer.|
Debug As \ 3
: Debug Configurations... LEANETER p
. . LEAMETEE pog
Organize Favarites...
. FAMETER pé
s o oot e REEINE OUTEIT RARABATED

E}Note: Clicking on the debug or run buttons (instead of the button’s drop-down
menu) automatically launches the last used configuration.

6. If this is the first time you have run the debugger, you will be asked to enable
debugging for all OpenEdge clients. Architect is not shipped with debugging
enabled for security reasons. Click Yes to enable debugging.

[ Enable Debugger |

p \ The CpenEdge A%k is not enabled for debugging.

2
Do wou want to enable debugging for all the OpenEdge clients in
'CAFrogress\OpenEdge'?

“'as Mo

@Note: You can enable debugging from the console by typing —debugenable —
enable all while in the <OpenEdge Install>/dlc directory. Also, under certain
circumstances, you may need to restart Architect for debug enabling to take affect.

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

7. A dialog will be displayed confirming that you would like to switch to the

OpenEdge Debugger perspective. Check the Remember my decision box so that
Architect does not ask you this question again. Click Yes.

[ Confirm Perspective Switch %] |

&  This kind of l[aunch is configured to open the OpenEdge Debugger
*-«"/ perspective when it suspends.

This perspective includes tools for testing and debugging OpenEdge ABL
programs.

Do wou want to open this perspective now?

W Femember my decision

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

8. The Debugger will be opened and will immediately suspend execution at the first
executable line of code. In this case, the Debug viewer shows that execution has
stopped on line 26 of the start.p program (@). In the editor section, the start.p
program is displayed (®). The current line marker (©) and blue highlight bar
shows where, in the code, execution is currently suspended (@).

Click on the Resume button (©). The AutoEdge login screen is shown.

@'DpenEdge Debugger - AutoEdgefsrcistart.p - OpenEdge
File Edit Source Mawigate Search Project OpenEdge  Run Wi

It - @3- 0~ q&v Il B e e
Ej|i9* OpenEdge Debugger doge Editar
%% Debug 2 O & g = ¥ =0

= AutoEdge Camplete Application [OpenEdge Application]
El-iff startp atlocalhost
- BaP Opgaddge

adspended)

d / / [

Pl %u:uatu:umer.p |i| etcustomer.i r| startp £3

{,.-"* we don't want no status windows */ 0

> ISESSION:APPL—ALERT—BOXES = YE&.
SEFSICN:3TSTEM-ALERT-BOXES = TYES.

f% atart client services
Rl serwvices/startclient.p WO-EREOR .

¥ test Applerwver conhection. Bail out if not conhected

Ll

M PP Pp—————_ [ —-—— *J

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

%Tip: An editor is started to show the start.p code because this program was not
already open when debugging began. This is a standard feature of the Debugger.
During debugging, if more programs are debugged (hit breakpoints) that were not
already opened, they will reuse the same Editor. You can specify that each
debugged program opens in its own Editor by unchecking the Reuse editor when
displaying source code option in Preferences under the Run/Debug option.

id Preferences

oe[H]

-Install/Update

- OpenEdge Architect
-FProgress DB i
Fun/Debug

- .m.H.H

e

|type filter tend Run,Debug
#- General _ _ _
B Help \ General Settings for Bunning and Debugging.

¥ RBeuse editorwhen displaying source code

¥ Activate the warkbench when a breakpaint is hit
¥ Activate the debug view when a breakpaoint is hit

™ Skip breakpoints during a 'Run to Line' operation.

E}Note: Multiple Debugger sessions can be run at the same time. The Debug
view will show root entries [OpenEdge Application] for each Debugger session.
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

9. Ifnot already turned on, toggle on line numbering by right-clicking on the marker
bar in the Editor and selecting the Show Line Numbers option.

=

= TR e T "

\r| dacugmer.p |i] etcustorner. P| startp &3

A% we don't want no status windows */

ﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ R T Ty TES .
Add Bookmarlk:... TES .
Add Task...
v Show Cluick Diff Citl+ O_EREOR .

Show Line Mumbers

. Bail out if r
Freferences... :

—
El Console 2 | v Tasks

S e . T ana g YT T e =t

6Tip: It can be useful when debugging to see the line numbers; for example, the
line number for each program active in the stack is shown in the Debug view and
having the line numbers on in the Editor shows the relationship between the Debug
view and the Editor.

Ijg}Note: During the following steps, line numbers may be used to help you locate
specific sections of code. However, keep in mind that your line numbers may be
different depending on how you have typed code in previous labs.

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

10. In the Login window, keep the values for the login User and Password fields but
change the Container Style drop-down to Windows ABL GUI. Click the Login

button.
M AutoEdge Login - |

AutoEdge

Izer: Itu:um

Paszwaord: I*ﬂwnn

Container Style:

Wwindows ABL GUI

Cancel |

¥l

E}Note: The ability to maintain customer information is not implemented in the
OpenEdge GUI for .NET Container Style so the ABL GUI app must be used.

11. Click on Maintenance menu and select Customer.

EAutnEdge = - Emplnyee Daily Sch

[nventory

gﬁ Jones, Tom

EmpIUVEI Dealer
=l L Schedule SRl :
{09 M - 09 AM

03 AM - 10 4M

B R N
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

12. While the Alexander, Patrick entry is selected, click on the Update button.

MaAutoEdge - - Customer Maintenance
gt Drive  Maintenance Repors Help

il
CUUpdate this Customer infn:urmatin:lni

-

=1\ Detailz

Alexander, Patrick,

’aﬁ Baker, Robert

a Bames, Susan S alutation;

a Bing. Evelun First Marne:
qﬁ Brooksz, Helen

a Brooks, Larmy hiddle M ame:
& Bums, Frank Last Mame:
a Burnz, Man Gender:

| ;._.p.a.ﬁ.mq_hﬂgljsaat_hﬂ*__ PR =P SSYUENP

OpenEdge Architect Tutorial 2009
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

13. Change the Email field’s value to Patrick.Alexander.aol.com.

E—-’"_—-:-‘v.'fvw_r'ﬂ' r,-—-"i""_..-—-"..n-‘._._..-"'l“{'wv
‘I 5 alutation: I ;I
é Firzt M ame: IP‘atrin:k =
s Middle Name: |

; Lazt Mame: I.i'-.le:-:anu:ler *
<'\.

£ Gender, o hale ™ Female §
i

2 Bitth Date: |ozsoss1983 g
1]

% Birth Country: IGerman_l,l

& License D ate: IDZ!D?!ZDDnI #
1 Language: I -

% Notex: ;I

i

| | |
g

£

1

i

—— T e ¥
Addresz 1: IGI:u:keIweg 27 "
Address 2 |2. Stock.

City: IM uenchen

State: IBa_I,Iern

Postal Code:  [81111

Colntry: IG Ermary

Telephane:  [+43-811-8294

Fax: |+4E|-E1 1-7440

tabile: |+45-811-1557

Ernail: Patrick.Alexander. aol com
Password: S I TTI I
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Lab 8 — Using the OpenEdge Debugger, continued

Starting the Debugging Process, continued

14. Click the Save button.

MaAutoEdge - - Customer Maintenance

File TestDriwve hiaintenance Repords Help

So=E

il
Cust0m|5ave this new Customer infu:urmatin:unh

=120 Details =
:ﬂ Alewander, Patrick,
r.
Baker, Robert
\._,_W-EL;M » sl Ty

The Debugger will be brought to the front because the debugging break point you
set in the validateEmail internal procedure has been hit. The current line marker
will show execution stopped on line where the debugging marker is set and a blue
highlight bar will highlight the code on that line.

__-T.‘__'_'.—-M.'-.-r-f*ﬂ—‘_rpwfnv\“q-.p..--'--._ﬂ_r,—-._,F-Fﬂw g ]-—- -'r‘__.‘_"__,_
4 i rl «|

Pl dacustomerp 52| 1] etcustomer. || startp

DEFINE INFUT FARLMETEE pcEmailld A3 CHARACTEER MO-TNDO.
DEFINE INFPUT FPARALAMETER peContactId A3 CHARACTER MO-TNDO.

DEFINE OQOUTPUT PARAMETEER plEmailValid A LOGICAL MNO-TNDO

BIZICGH plEmsilValid = TRIUE. /
| IF pcEmailIld <> ™" AWND NOT

poEmailld MATCHES "¥@*~, %" THEMN

[E Console &2 = Tasks

e

e e R . .'"‘-\.-'\-"'\ S T i “'I-. Sl e -""-'.V. o

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code

The Debugger Perspective provides a wealth of information about the application being
debugged and action buttons to control the execution of the application. This section
covers some of the basic features of the Debug Perspective.

1.

Click the Step Into button.

File Edit Source

Mavigate Search

| i |3 ~0 Q-

J

Ej’|ﬁ§ OpenEdge Debugger &2 OpenEdge Edibr

-

o

@'DpenEdge Debugger - Auto Edgefsrcfsewerfaumedgefdac

Froject OpenEdge  Run  Wing

5 = |

SR

ﬁ? Debug 2

U

1=

VEE

|

= AutoEdge Camplete Application [Ope
=8 .j'jﬁ‘ startp at localhost

=- .Jj'} OpenEdge A%M (suspended)
= autnedge/dacustomer p validateEmail( .
----- = autoedge/becustomer.pvalidateEmail{ ...
----- = autoedge/hecustomer.p eCustvalidation] .
----- = autoedge/becustomer.p eCustDmerMDdiBﬁPreTrani.I;I

)

(2 ?%
tion]
otep Into (F5)

line: 127

)

]

[F| dacustomerp 52

The pointer moves to the next executable line of code.

|i| etcustomer.i

\F| startp

EEl 20 DEFINE INFPUT FPAEAMETEE pcEmailld
At St O~ st s ST A

b3 CHARRCTE
i ’_q. J

|i| etcustomer.i

|| startp

[F| dacustomerp 52

END.

Do

IF peEmailld <> "' AND NOT
pcEmailld MATCHES "#@#~. %" THEN
D0z ff—
ASSIGN plEmmilValid = FALSE.
MESSAGE "Emmil entered is invalid” VIEW-AS ALERT-BOX.

IF pcEmailId <> ™" THEN

196
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

Notice the variables view located (by default) in the upper right portion of the
perspective. This view shows all the variables and their run time values. Scroll
down the list until you see the pcEmailld and plEmailValid variables. Notice
that the pl[EmailValid variable is currently set to yes.

itoedge/dacustomer.p - OpenEdge Architect - C:\OpenE.... M= E3
'/f Fun ‘Window Help

5o .

1

L'U — O | &= Yariables £ | “ Breakpoints 54 Expressions | £l Dynamic Obj.. = 8

- e

Name | value ]

{] itode 2

éEEI @ pcEmailld "Patrick Alexander.aol.com"

! pcContactd "f306c7 4d-1385-a73e-dd11-abbib..

; @ plEmailvalid yes )

Fans( -

; 1 G

{ ' | 2

3 - | -

:'E 4 LI F

3 =0
: it A A S et

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

2. Click on the Breakpoints tab. All the breakpoints that have been set will be listed

here.

yedgefdacustomer.p - OpenEdge Architect - C:\OpenE. .. [B[=] F3
SRun  Window Help

[§

3':' B | ¢9= ariables | %c Breakpoints 23 | 97 Expressions | = Dynamic Obj..| — B

DA B HE e

“3 ------ = C:poenEdgeMFiK,f’AutDEdgeWS,-"AutDEdgefsrc.#sewerfautuedgef|’
{

7

s

7

 n

Sy 4| | ]
$ . . st 0

@Tip: A workspace keeps track of all the breakpoints that are defined for its
resources. You can open the OpenEdge Debugger perspective at any time and
switch to the Breakpoints view to see all the defined breakpoints for all the
resources in the workspace. Also, you can double-click on one of the breakpoints
in the Breakpoints view to open the program in an editor and reposition to the line
where the breakpoint is defined.

continued on next page

198 Architect Tutorial 2009
Copyright © 2008 PSC



Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

3. Back in the editor, double-click on line 134 (which is the next IF condition
statement if your line numbers do not match). Notice that a new breakpoint has
been added to the Breakpoints View. This is a very helpful feature that allows you
to add breakpoints while actively debugging an application.

d OpenEdge Debugger - AutoEdge/srciserverfautoedge/dacustomer.p - OpenEdg
File Edit Source MNawvigate Search Froject OpenEdge Run  Window  Help

G- e #0058 ol=0 o= 0

£ 4% OpenEdge Debugger &2 OpenEdge Editor
% Debug E@I U |2 @ & 5| ¥ = 0||ew- Variables[% Breakpoints &3
=l AutoEdge Complete Application [OpenEdge Application] j

El J'ji':‘ start p at localhost [ © C/OpenEdgeiRKiAut
= .J‘P DpenEdge AWM (suspended) e C/OpenEdgefRKAu
-= autoedge/dacustomer.p validateEmail( . ) line: 129
autoedge/becustomer.p validateEmail( ... )
autoedge/becustomer.p eCust\-’ahdatmn(

R R e YRR PN RPN Pt o rr e Y P

P ey x
3 1 |

27 IF pcEmailId <> "@*IND NOT
25 peEmail IdMATCHES "#@%~, " THEN
D

#SIGH plEm=silWValid = FALSE.
MEZSAGE "Email entered is invalid"™ VIEW-A3 ALERT-EOX.
EMND .

IF pcEmaillId <> ™™ THEN
Do

N AE Checlr if the Custormer recnrd is mrested w0
-..-\Ml \_h.f‘#‘mw.‘..‘W\_*\M_‘_HM*_*_“““‘_’ SOy v=ra

E}Note: You can turn on or turn off a breakpoint directly from the Breakpoint
view by checking or un-checking the box beside the listed breakpoint.

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

4. Click Step Into (twice) until the current line marker goes to the MESSAGE
statement (line 132). Click the Variables view. The plEmailValid is now set to

no.
[ OpenEdge Debugger - AutoEdge/srciserverfautoedge/dacustomer.p - OpenEdge Architect -
File Edit Source MNawvigate Search Project OpenEdge Run  Window Help
[ i |3~ 3~~~ - - 5 o -
4
Eﬂ’ﬁ@ﬁ OpenEdge Debugger & OpenEdge Editor ;
* Debug 8@] O | = = & T | ¥ = O ||®= Variahles S@]% Elreakpoints|5f2"E:<pressions
=] AutoEdge Complete Application [DpenEdge Application] - 1
Elﬁ'f:? start.p at localhost Name | Value
EI“P EpenEdgeA\fM (suspended) i i : - @ pcEmailld "Patrick. Alexa
; autoedge/dacustomer p validateErmail( .. ] line: 131 peContactld "g05c740-135
autoedge/becustomer p validateErmail .. ) ® plEmailvalid “D_)
autoedge/becustomer.p eCustvalidation(...) «
: autoedge/becustomer.p eCustomertodifyFreTrans(.
[F] dacustomerp S@l [i] etcustomer. | [¢] startp | E
IF poEmailld <> "' AND NOT
poEmailld MATCHES "#@#~_ ** THEN 1
jilsH B
AISIGH plEmailValid = FALSE.
MESSAGE "Email entered is invalid” VIEW-A5 ALERT-BOX. 4‘_
END. 4
k.
IF peEmailld <> "" THEN
aTakl
| i
[M‘Sﬂk\- Sgw""nwm\m e .

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

5. Click the Resume button.

[ OpenEdge Debugger - AutoEdgefsrciserverfautoedgeid

File Edit Source Search

MNavigate

J—:;v

|3~ 0-G
Ejhw DpenEdge Debugger,

P

Froject OpenEdge Run
v 5 -

OpenEdoge Editar

VEIE

%5 Debug 32 l [

RS

E . AutoEdge Complet

Er SpenEdge Application] o
|;| uj?«‘ start p at localhao Resu (FB)

= u‘j} DpenEdge A4M (suspended)
-= autoedge/dacustomer p validateEmail{
autoedge/becustomer.p validateEmail{ ..}

ine: 131

<|E

= autoedge/becustomer.p eCustvalidation( ..

' R ' LT T B .

)

autuedgefbecustomer p eCustomertdodifyPreTra

nel.
>| q

I p| startp

J@ dacustomerp 22 | [i] etcustomer.

AR e

R e A, R

ENPr——— -.._,rf ETr -

6. The application will show the error message is displayed. You may need to bring
the AutoEdge application back into focus (click on the window) to see the

message.

S e

l]:l obert

et -

_-_HTH7 ¥ WY "-—-—"_\___ -y __.,,.-\..'_./"-\'--a-{‘-\"-v

_M‘Fc-«---..,_u--I" e e e e

g8usan prel: [ockebeg 7

Evelyn [EEE. |2. Stock

WHelen  Email entered is invalid [Muenchen

i Larmy

Frank [Bayem

Mary Ok I Help | |Code:  [B1111

.}1_el|ssa T At IGermany

Richard )

Heler Birth Courtry: IGelmany |+4E|-8‘|1-8294

ii}l"l, Liza Licenze D ate: IEIZ,-’D'?;ZDM |+4g_3-| 1-7440

4. Richard Language: | =] Mabile: EEGIEED

{E:"S Motes: ;I Ernail IPatrick..&leuander.aol.com *
Ei@ Pazzword: Iwwa-w-xwwwwww-xwwww ®
< Ksith =

"i::rank

ﬁﬂobert

;Iice |

1,

¥

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

7. Click OK to dismiss the error message. The Debugger moves to the new
breakpoint that you created in a previous step.

o

T e médgﬁﬁmfruﬁrmﬂmﬁﬂmﬂﬂ?ﬂel FANEL.
= . 3

[f] dacustomerp 52| 1] etcustomer| | startp
IF pcEmaillId <> "7 AND NOT
poEmsilId MATCHES M#@ %~ %" THEN
Do
AA3TGH plEmailWalid = FALALZE.
MEZZAZE "Email entered i=s inwvalid®™ VIEW-4F ALERT
END.
IF peEmailld <> "7 THEN -iff—
T

il

E Cunsule &d lﬁ, Tasks

- e T e e e e meme —_ e oy s i e

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued
8. Click the Resume button.

9. The application will show another error message indicating that the email is
assigned to another user. Obviously you would not want two error messages in an
application, so one of the messages should be deleted in the code and the other
message should be generic enough to handle any errors.

Click the OK button.

MAAutoEdge - - Customer Main

File TestDrve
N T L

Maintenance

Feports  Help

Last Name:

=10l x|

Customer

= 2 Details

‘Q Baker. Robert
a Barnes, Suzan
a Bing, Evelyn
.'a Brooks, Helen
a Brooks, Larmy
a Burns, Frank.
a Burns, Mary
a Burng, Melizza
8 Bumnz, Richard
8 Carter, Helen
Q Coleman, Liza
.R Colernan, Richard
& Colling, Chris
a Cox, John

& Cow, Mike

a Ewans, Keith
‘E Flares, Frank
nﬂ Fioster, Robert
551 Gatt, Alice

53 Alexander, Patrick

-

Information (Press HELP to view stack trace)

1)

Ermail is already assighed to another user

i

Help |

elweg 27
ck
chen

]

Birth Date:
Birth Country:

0E/08/1583

Germany

License Date: IDZ;‘D?;‘ZDM = Fax:

Lahguags: I

Motes:

Al [EN
m
3

Pagzsward:

=

- |

IG ermary

|+49-81 1-8234
|+49-81 1-7440
|+49-81 11837

I Patrick.Alexander. aol com

I##**************

[User: tom

OpenEdge Architect Tutorial 2009
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

10. Switch back to the Debugger Perspective. Find the line of code with the
MESSAGE statement that you previously added to the validateEmail procedure.

[r| dacustomerp &2 I [i] etcustomer. ‘ [p| startp |

IF pcEmailId <> "7 AND NNOT
poEmsilld MATCHES "#@%~, %" THEN
D
AZSIGH plEmailValid = FALSE.

b abibumiae

MES3AGE "Email entered is inwvalid®™ VIEW-43 ALERT-EOIX. |
END.

YOI gt
.

IF pcEmailId <> "™ THEN
it

al

11. Delete the line of code and save the file. Although the coding changes will not be
reflected until the next time the code is run or debugged, this is a handy feature for
fixing code while debugging.

continued on next page
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Lab 8 — Using the OpenEdge Debugger, continued

Debugging Code, continued

12. Stop the application by selecting the Terminate button.

3 OpenEdge Debugger - AutoEdgefsrciquifautoedge/maince
File Edit Source Mawigate Search Froject OpenEdge  Run Wine

J—q?v QJ%S'G'%'JQ {}v{r v’lf::(:jv -
£ 3% OpenEdge Debugger &2 Op e Editar

%5 Debug 52 | i’ 2% YO
= AutoEdge Complete Applicé{ﬁon [OpenEdae Application]
E| .]’F" start.p at localhost | Terminate (Ctrl+F2)]

= .Jj'} OpenEdge AV (suspended)
= autoedge/maincontral.prl ) line: 113
5 = startpl )
g ChProgress\OpenEdgeihiniprowindz.exe (Dec 21, 2008 4:49:33

1| i

[r] dacustamer.p | [i] etcustomer.i [IE maincantralp 53
111 oForm = new Progress.Windows.Formi() .
112
LIS PR S L S i T E RS

E}Note: From here a developer could continue debugging to make the second
error message more generic.

13. Close the Debugger perspective. Close all source code files in editors.
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Lab 9 — Using Tools for Business Logic

Overview

The Tools for Business Logic provide an intuitive drag and drop interface for modeling
in-memory business structure. Models can be created for Temp-tables and ProDataset
objects. These models can then be stored and reused for either designing or development
purposes. You can generate code for these objects directly from the models. Models can
also be generated from existing code.

This lab demonstrates some of the available features in Architect’s Tools for Business
Logic.

continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Tools for Business Logic Perspective

[ openEdge Tools for Business Logic - edcustomer.dgm - OpenEdge Architect - C:\Exchange2008\Worksp... [H[=1F3

File Edit Mavigate Search Project OpenEdge Run  ‘Window Help
I B = = e P o | | 2|
Eﬁ?|ﬁ OpenEdge Tools for Business Logic
& Resources 2 l =0 *adcustamer.dgm 23] =0
| _’gv ~||=—Palete — »
----- [} dscustomeri 1.1 (ASCll kkv) =] G T T [} Select
----- [} dsdealeri 1.1 (ASCI-kk) 2 Mafque?
----- [ dedealeristi 1.1 (ASCI -kk) o ~ Connections  #|
----- [i} dsemployee.d 1.1 (ASCI -kky € Two-way
] ploy
----- [ dsemploveelisti 1.1 (ASCH -k, Reference
----- [f) dslanguage.i 1.1 (ASCI-kky) ¢ Mote Link
----- [} descheduled 1.1 (ASCI ki) cantain cantains © New Compo... #|
----- [i} descheduletdi 1.1 (ASCI -kky) 55 Newy Buffer
----- [i} dstestdrivei 1.1 (ASCI -kky) 5 Mew Index
----- [i} dstestdrivebycustormneri 1.1 (AS [ eCustomer =] eContact 5 Mew Column
----- [} dstestdrivews. 1.1 (ASCI -kky) :] CustomerLastName 8 Contacthddress! T Mew Temp-
----- [} dstimelisti 1.1 (ASC -kkv) 8 CustomerFirstName 8 Contacthddress? Table
_____ [ >adcustomerdgm  (Binary) :| CustomerM|ddIeNa... 4 ContactCity - Existing Co... ,|
..... ) etaranda i 11 (ASCH Kl _IL| g g“smmergf”:gate A ContactState 4 Column
] B 9 033222:”;1 IR f ContactTelephone 1 Temp Takle
= Propert. X Outline|DB Stru...| = g UserLaginiD d ContactFaxPhone - Other #
T g ) ) B ContacttobileFPhone ;
’E =B g ContactiD W 4 CantaciNotes (@ Mew Annotation
Property | value - » Lengragely . d ContactCountry i, Diagrarm Note
= Attributes J BaseCodeSalutatio.. B ContactPostalCode
DataSour ) CustumerG.ender B ContactErmail oo
Narme I g CustomerLicenseD... g ContaciD
TablaPro A CustomerlicenseE.. 51 ContsctiD
T Tabl e f Customerhotes
¥Re anie g CustomerSearchFi... -
= Code Gener LI .
Author  <author> — =
CodeTen com.openedge.pdttd.. || Connections & lPrUbIems|CDnnediDn Inf0| AT A B LI = =
Container fAutoEdge/srofsenverf P -4+ autoedge ;I
FileExten: i P <4+ DerpCore
FileMame et tempdb
Generate true H-# Cannectian Profiles b
Tahlabra o hd
| | _>|J =
| |
Notes:

O Component Designer Canvas Area
® Designer Palette
© Properties, Outline, and DB Structure views
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Lab 9 — Using Tools for Business Logic, continued

Creating a ProDataSet Component

The following steps start the process for creating a ProDataSet Component that can hold
Customer, Test Drive, and Car information from the AutoEdge Database.

1. Open the Tools for Business Logic Perspective by selecting the OpenEdge Tools
for Business Logic option from the Open Perspective button.

@'DpenEdge Editor - OpenEdge Architect -
File , Edit Mawvigate Search Project OpenEdge
I~ JAus-0 x|~
=] |3§E OpenEdge Editar
. OpenEdge AppBuilder
1% OpenEdge Debugger
¥ OpenEdge Tools for Business Logic
3§| OpenEdge Yisual Designer
571 Progress DB Mavigator

Cither...

----- [F| dacodes.p
----- [r| dacustomer.p

----- [F] dadealer.p -
«| | b

o= Outline 2 [EF¥DBS.. O Prop..| — 8
[T Mﬂﬂw-u.‘rwﬁﬁhﬂ ot g xﬂr"“‘“ﬂ .

continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Creating a ProDataSet Component, continued

2. Since the Tools for Business Logic use a SQL connection to retrieve schema
information from a database, make sure that the autoedge connection is active in
the Connections View. If not, double-click on the autoedge entry under the
Connection Profiles node to connect.

e e, = - “ e
T e, T S Rt L L R P B

<> Connections 52 &Prublems‘ E e Sy~ =0

=% 3 Active Connections
. <= temp-dhb

----- <4+ oerpcore

e autnedge lf—
52, Connection Profiles

----- g autoedge

----- g OBfpCore

----- g temp-dh

Pcustumer.p J

continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Creating a ProDataSet Component, continued

3. Create a new Business Logic Component by selecting the down arrow next to the
New button and selecting the Business Logic Component option.

3 OpenFdge Tools for Business Logic - OpenEdge .
File gt Mawigate Search FProject OpenEdge  Run Wink
NS J& | L Qx|+ r

[ (= OpenEdge Project i!ED“tEIr

[y [ Project...

‘l_l

] ABL Interface

ABL Class

| ABL Structured Include

|p{ ABL Structured Procedure

B Business Logic Component
s JET Enablement for DpenEd Froject

% Other... Crl+ N

------ IB dadealetlistp
------ [ daemployes.p

-
[e1 Ammim L el e o

-'-“-ﬂt- e .q-"l" -.u,‘d"""‘a il e R o

continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Creating a ProDataSet Component, continued

4. In the New Component dialog-box, set the following values and then select the
Finish button:
— Location: \AutoEdge\src
— Component Name: dsTestDrive.dgm
— Component Type: Dataset

[ New Tools for Business Logic Component

Tools For Business Logic

This page creates a new Toaols for Business Logic componentwith a .dgm extension.

WAutoEdgeisrc K I
dsTestDrive.dgm

<l

continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Creating a ProDataSet Component, continued

5. The diagram file is created and the dsTestDrive ProDataSet component will be
shown in the Component Designer editor. Click and drag the component to the top
left hand corner of the Component Designer’s Canvas Area and resize it
accordingly.

e A ot

e
g‘ OpenEdge Editor
=8 *dsTestDrive.dgm EE] .

3 ;I l RS TE 'E L|<]

e e e

g

o

P

P
-
4

T

:E_I: |

_;_

e

4

'L Y

¥

i

]

3 -
;;3 i [

¥ g~ Connections 332 | [21 Prublems| T e %« gy~ -0
f.. -

=-% 3 Active Connections
e temp-db
g+ OErpCOre
L autoedge -]

e

G
4

r.
—
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Lab 9 — Using Tools for Business Logic, continued

Creating Temp-Tables Components from Database Schema Information

ProDataset Components are built using one or more temp-table Components. There are
many ways in which to create temp-table components, but one quick way is by copying
the schema structure of a table from a database and turning it directly into a temp-table
component. The following exercise uses the DB Structure view to copy schema structures
from the AutoEdge database to create the temp-table components for the TestDrive
ProDataset Component.

1.

In the DB Structure View, select the autoedge tab. Expand the
Database—AutoEdge—Table nodes. Click and drag the Customer entry over to
the canvas area and release the button. A new customer temp-table component

will be created.

[ OpenEdge Tools for Business Logic - AutoEdge/srefdsTestDrive.dgm

File Edit MNawvigate Search Project OpenEdge BRun  Window Help
IGrBlaols/duW @]+~ ] -G as

i | 28 OpenEdge Tools for Business Logic €5 OpenEdge Editor

v |

& Resources & I

_’;V‘:EI

“dsTestDrive.dgm I3

[/_:5 oeti

[5- OpenEdge
[5- services
[ wversion b
[#-[= sonicesh

= winfarm

----- = autoedge-guiini
carodel2CreateTable sql
CagQuery sgl
dsTastDrive.dgm

----- W

[

Hds [estUnve

cuntains&/

1 eCustomer

CustomerLasthame
g CustormerFirsthame
i CustomertMiddleMa...
8 CustormerBinthdate
H CustomerBithCountry
g CustornerD

-

g UserLaginlD
8 ContactD
i LanguagelD

Derpcorel temp-ch autoedge |

e
/

H BaseCodeSalutatio...
8 CustomerGender

o8 TAEBLE

w7 BaseCode
w0 Car

w7 CarBrand
w7 CarMadel
---E Contact
---E Customer

L e A e i,

A CustormerLicenseD...
=] o A CustamerlicenseE..
q
J =2 ?ﬁ 3 Active Connections k
; -4 temp-dhb
<@ OBfpoOre
= 1:- autoedge
J

PORE R P e i, O Sn ke
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Lab 9 — Using Tools for Business Logic, continued

Creating Temp-Tables Components from Database Schema Information, continued
2. Repeat Step 1 for the TestDrive and Car tables:

3. Maximize the Component Designer editor by double-clicking on the diagram’s tab
label.

} ogic - AutoEdge/srefdsTestDrive.dgm - OpenEdge Architect - C\Open. .. [M[=] F3
iOpenEdge  Fun Window  Help

EI,,J (')’_' - J - v ¥o o - - J <:’,' ||1E|E|% vl

;:32‘ Ope

*dsTestDrive.dgm E@l ] =5
[

‘.""'—I'EH W I __/ 24

) eCar | B
8 CarDescription
§ CarsddedDate
d CarlsAvailable
q Carld

N DealerlD )
S I 4.__...__.....7,1 iy

g o g o e ey
I 2

continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Creating Temp-Tables Components from Database Schema Information, continued

4.

In the Customer component, select the following elements by using the CTRL key
and clicking on their entry:
— UserLoginID

— ContactID

— LanguagelD

— BaseCodeSalutation

— CustomerNotes

— CustomerSearchField
— EmailAddress

— userLoginID (index)

Bon o | € o |

R

e e (B bl B

% *dsTestDrive.dgm 23
COntEmat tans

) eCustamer

A CustamerLasthame

H CustomerFirstMarme

d CustomertiddleMa. ..
A CustomerBirthdate

A CustomerBirthCountry
d CustomerlD
R serLoginlD
R ContactiD
N LanguagelD

BazeCodeSalutatio...

e

d CustomerGender

A CustomerlicenseD...
A CustomerlicenseE .
El Customerhotes

ﬁ customertame
" uCustomer

OpenEdge Architect Tutorial 2009
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Lab 9 — Using Tools for Business Logic, continued

Creating Temp-Tables Components from Database Schema Information, continued

5. Press the Delete key to delete the elements.

Ao o || &% a |

TRy Ui SRc I DU O O AR S T

*dsTestDrive.dgm &3

s [ estlre

ContEmetfe

] eCustarmer

d CustomerLastMame
d CustomerFirsthame
A CustomerMiddlanMa. ..
d CustomerBirthdate
4 CustomerBirthCountry
q CustomerlD

A CustomerGender

A CustomerlicenseD...
A CustomerlicenseE...
ﬁ customert™ame

] uCustomer

216
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Lab 9 — Using Tools for Business Logic, continued

Creating Temp-Tables Components from Database Schema Information, continued

6. Repeat steps 4 and 5 for the TestDrive and Car components.
— TestDrive

TestDriveNotes

DealerID

EmployeelD

DealerTime (index)

Employee (index)

TestDriveTime (index)

DealerID
CarBrandID
CarModelID
BaseCodeStyleID
BaseCodeColorID
BaseCodeEnginelD
BaseCodeFuellD
Brand (index)
ColorCode (index)
DealerCar (index)
Engine (index)
Fuel (index)
Model (index)
Style (index)

L R 2 I R 2 2k 2 2 2 2B 2R 2% NGO Ak 2R R R N 4

continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Creating Temp-Tables Components from Database Schema Information, continued

7. Position the components in the canvas area to look similar to the image below.
The lines can be repositioned by clicking on the line and then clicking and
dragging on one of the black boxes that are shown.

@'DpenEdge Tools for Business Logic - AutoEdgefsrc/dsTestDrive.dgm
File Edit MNawigate Search Project OpenEdge Run  Window Help

=BG &L [y G [

Ej’|ﬁ OpenEdge Tools for Business Logic & OpenEdge Editar
*dgTestrive.dgm &3

H Carlsfwvailable
q Carld

: 4 CarviM

/ \\/ =] UcarlD
[ eCustomer [ T el estDrive
H TestDriveTime
d TestDriveMeedEwval
q TestDriveApproved
d TestDrivelD
g CarlD
d CustomerlD

™ Customer
] uTestdrive

Bon [ o | o |

A CustomerLasthame
H CustomerFirstNarme
H CustormerMiddleNa...
q CustomerBirthdate

H CustomerBirthCountry
d CustormerlD

d CustomerGender

A CustomerlicenseD..
A CustomerlicenseE

ds [ esilirve - .
= contains E eCar
- 8 CarDescription
. _ \ A CarsddedDate
contamns | contains .

™ custometame
=] uCustomer

H__\H_\L"n ‘, R L R, - ""“—""“"‘"“\tah'*—‘-‘—"""*""‘--‘ﬂ PR ‘_____‘..‘!

8. Restore the editor to its original size by double-clicking on its tab.
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Lab 9 — Using Tools for Business Logic, continued

Adding Relationship Links

Complete the following steps to add Data Relationships between the temp-table
components in the Test Drive Component Diagram:

1.

Open the Palette by selecting the arrow above the Palette label. Note that you also

can hover your mouse over the Palette strip to have the Palette open temporarily

while you select a single option.

Logic - AutoEdgefsrcidsTestDrive dgm - OpenEdge Architect - C:\Open... [Hi[=] E1
i0penEdge  Run  ‘Window Help

1 o P I o I

’1 J g J - v o 0 - - J <'r, | 100% -

}335 OpenEdge Editar

Fl_ *dsTestDrive.dgm 53 l p=!
Iv = ds [estUrnve <]
\i‘:l contains T eCar :
? = 8 CarDescription [s
_ _ \ 8 CaraddedDate

5 contains | contains . g CarlsAvailable

é‘ g Carld

3 g CarviN

\\/ UearD

;‘—l £ eCustomer ] eTestDrive

3, A CustormerLasthame ] - -

| ; TestDriveTime

§ 8 CustomerFirstName .

3 ) g TestDriveNesdEwval

i g CustornertiddieMNa... .

= . d TestDriveApproved

=l 8 CustormerBirthdate g TestDrivelD

2__ g CustomerBithCauntry 4 CarlD

g g CustomerlD 8 CustomerlD

8 CustomerGender |

£ ) " Customer

L 8 CustomerlicenseD... 5 uTestdrive

." 8 CustometlicanseE... =

e .
i cl
2 4 ‘,B - = =

=

hiow Palette|

-

L Connedtiags 332 Problems " ol &
- T B can yaa

Lk

o

|
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Lab 9 — Using Tools for Business Logic, continued

Adding Relationship Links, continued

2. In the Palette under the Connections label, select the Two-way Reference option.

Z\Edge Architect - C:\Open... [[=F3
|

L =]
2
-
J:-.l e L]
z’ i ﬁ Ecﬂr — ¥y PE[|E1.'tE [)
:1 4 CarDescription [+ Select
__% g CarAddeFiDate L Marguee I
} g gar:zﬁvanable % Cunnemiuns¢¢o
! ar
ﬁ g CarviM £ Twio-way
)] ] UcarlD Feference
5 «» Note Link
{;L < New Compo... <
I\';dE | o1t MNew Buffer

Wa
‘ huqﬁﬂﬂm,mk
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Lab 9 — Using Tools for Business Logic, continued

Adding Relationship Links, continued

3. Place the cursor over the Customer temp-table component.

Logic - AutoEdgefsrcidsTestDrive dgm - OpenEdge Architect - C:\Open . [Mi[=] E

i OpenEdge  Fun  Window  Help
i’ 2l . - - w ’,‘ oo -
?J & v | = [ « [ro0% =]
& & OpenFEdge Editor
'8 |5 *dsTestDrive.dgm 53 | =g
i sTestDrive.dgm
iy 0% | Eslve 2|z Palette B
:i — contains [ FdeCar |
i - H CarDescription [ Select
: o cumﬁinf)\ i CardddedDate L1 Marquee
\ B CarlsAwailable - Connactians o
f Carld
b 1 g CarviN S Twooway
L l‘ i Reference
; - 4 <> Note Link
4 eCustamer :
}_I g CustomerLastName ] E eTestDrive B CEiaE,, 2
e q ust — g TestDriveTime o Mew Buffer
i q Customerwrzdla&ne g TestDriveMeedEwval
I_ﬁ : Cus DmerB.l hde ... g TestDriveApproved i Mew Index
: ustomerSihaate 8 TestDrivelD & Mew Calumn
4 8 CustomerBithCaountry g CarlD 5 Now T
1= ew Temp-
)ﬁ_ g CustormerlD ' g CustomerD Table
y; g CustormerGender 9 Customer -
2 8 CustomerLicensefr 5 uTestdrive 4 Existing Co... <
8 CustomerLicenseE... . g Column
Lol . .
| | _I" A Termn Takle
<+ Connections 22 [ (20 Prublems‘ E g E%eYgpgeE~—0
- -...-"""'\..»-‘4__7

%wa-q_‘,‘_ﬂ___., %J_.‘b‘_‘__,.a-‘-#__“_h_'._.ub
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Lab 9 — Using Tools for Business Logic, continued

Adding Relationship Links, continued

4.

Click and drag the Relationship Line from the Customer component (Source) to
the TestDrive component (Target) and click again. The relationship will be
created.

bogic - AutoEdgeisrc/dsTestDrive.dgm - OpenEdge Architect - C:\Open... [M[=] [F3

CpenEdge  Fun

b .
J ‘x_‘)h - J -
J&5° OpenEdge Editor

“dsTestOrive.dgm &3 l

YWindow  Help

> ¥ . > |

[ro0z =]

= ds [ estlnve

2 w2 Palette >
= eCar
[ Select

i} Marguee

contains

# CarDescription
. ) A CaraddedDate
contains | contains

8 Carlsiwvailakle

<+ Connections <o

\.__.V'J"f-f"-\-i\.‘lt'\&\_ 4'¢T\lﬂ]']

A Carld

3 A CarviN € Two-way
¢ U Reference
I B UcarD
3 «-+ Wote Link
o ] eCustomer
: A CustomerLestlame [ eTestDrive < New Compa.. <
u 8 CustomerFirstName 4 TestDriveTime i Wew Buffer
% A CustomertdiddleMg E) iESIBWEEEEdEV? E‘iNewlndex

8 CustornerBirthd ) , estUrvespprove
£1l |8 customenBinhCyntn]_ o oionshis § FestDrivelD B Newr Column
fr g CustormerD arlD £ New Temp-
»-, g CustomerGender q MstomerlD | | Table
3 A CustomerlicenseD... ﬁCustDmgr % Ewisting Ca... <«

*E Cugtome-rll_ic:enseE... [ uTestdrive _ILI g Column

| | b = Termn Takle

e

Lt Connegions 23, L -Rumblemaly oy oo el B Ste 0 - T T8
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Lab 9 — Using Tools for Business Logic, continued

Adding Relationship Links, continued

5. Repeat Step 4 to create a relationship between the TestDrive and Car components.
The diagram with the Relationships should look like the following:

*dsTestDrive.dgm 23 \

= ds [ estUrnve

containg | containg

] eCustomer

A CustormerLasthlame
8 CustormerFirsthame
i CustormerMiddieNa...
A CustomerBirthdate ) )
| CustcurnerEIirthCDun’cr),,f_iel—amﬂm—hIE
8 CustormedD

i CustornerGender

H CustormerlicenseD...

g CustormerlicensekE...
Lol . v

= O
ontains FleCar | s Palette [-
8 CarDescription I+ Select
x ﬂ CarsddedDate r Maruee
i Carlsawvailahle L+ AN
9 Carld < Connections <
g Carvin £ Tuwa-way
5] UcarlD Feference
Felationship ez MNote Link
F eTesiDrive “ Mew Compo... =
H TestDriveTime i Mew Buffer
g TestDr?veNeedEval i New Index
H TestDriveApproved
i TestDrivelD B New Colurnn
84 CarlD £ New Temp-
# CustomerlD | Tahle
'3 Customer & Existing Co... <
[ uTestdrive 4 Calumn
| _’I—I 1 Temp Takle
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Lab 9 — Using Tools for Business Logic, continued

Adding Relationship Links, continued

6. Return to the Palette and select the Select option. Hide the Palette by clicking on
the arrow to the right of the Palette label.

1 ‘ITGD%EH'HWFH'_“' T e T e e
n

‘i [ A eCar I 2 Palette /
4 CarDescription s Select |
?‘————____a_ A CarAddedDate Hide Palette

;,‘vlarquee

T

% d Carlstwailable

? q Carld Connections <
;? a Carty/l & Two-way

] 5 UcarlD Fefarence

!.) Felationship / s NOte Link

L FleTestDrive | & New Compo...
Y8 TestDriveTime 5 Mew Buffer

% TestDriveMNeedEval 5 New Index

§ i TestDriveApproved

'd TestDrivelD B Mew Colurnn
4‘15 CarlD £ MNew Temp-
A CustomerlD | Table
Customer = Exigting Co... <«
uTestdrive ]
i S i e _\.w_‘_'.l.“--xam!;':'vly.mnh o k]
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Lab 9 — Using Tools for Business Logic, continued

Setting Properties

This section shows how to set properties for the elements in the diagram.

1. Select the relationship line between the Customer and TestDrive components.

wutoEdgessrcfdsTestDrive.dgm - OpenEdge Architect - C:\Open... [Bi[=] 3
2 Fun  SWindow Help

[ h e P o [ ||1DD% vl

Edge Editor

e

E [%) *dsTestDrive.dgm EE] = O
fJ 105 | eslrve . Bl eCar ] L|<1
: contains — =
& H CarDescription

it x 4 CarAddedDate

§ containg | contains 8 Carlsfwailable

g Carld

i g CarviN

‘;- l eCustomer | ] UcarlD

3 A CustomerLastName Relationship

% 8 CustomerFirstiNarme

<'_I 8 CustarnerMiddlieMa. . ] eTestDrive

:ﬂ g CustomerBitthdate H TestDriveTime

:f_ 8 CustomerBithCountry Relﬁtiunshig TestDriveMeedEval

'/_ET 8 CustomerlD . w———_| 0 TestDrivespproved

S H CustormerGender \% g TestDrivelD

= 8 CustomerLicenseD... g CarlD

;]_’;_ H CustomerlicenseE. . i CustormerlD

1 ﬁ customet™Narme ﬂ Custamet

a 51 uCustomer 51 uTestdrive

o ' e
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Lab 9 — Using Tools for Business Logic, continued

Setting Properties, continued

2. Select the Properties view. Change the Name property to relCust_TestDrive and
press the Enter key. The name change will be reflected in the diagram. Change
the values for the SourceColumn and TargetColumn properties to CustomerID.
This sets the primary/foreign key relationship between the two Components

,_.‘,.a\,.?-'-?n—ﬂh_r, ..r,.,_-.-__,-.,-...._.._. ""-’""_""'“-' re— _,-'v’v‘-“‘“w_ Sy g g "
P sutoedge-gui.ini W W

Q cartdodel?CreateTahkle =g [ eCustomer 1
.k CarQuery.sql H CustomerLastMame :
dsTestDrive.dy — 4 CustomerFirstName )
m Grnaratar TG hil ﬂ CustomertiddleMa..
.| _ | v A CustomerBithdate Relationsh g Teq
— — Ao ; = = g CustumerBinhCDuntry___E auonshp Tedr
[| Fropedies o= Outlme‘ = DB Struct.., | B

——
) CUStDmEHQHEICust TestDrivéj
= (e i CustomerGender |

Froperty | value - A CustometLicenseD...
= Link Properties A CustomerLicenseE...
Bendpoints  219.214 ™ customerame

Link Twoe Eelationshio h uCustamer
@me relCust_TestDr@ LI
Mot-Acthe false
Fecursive false -4~ Connections 52 | [21 F"mblems|
Reposition false El% 3 Active Connections
SourceColumn - Custornerl D "3' temp-db
TargetColumn | ( -l::- oerpcore
e gutoedge
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Lab 9 — Using Tools for Business Logic, continued

Setting Properties, continued

3. Repeat Step 8 the relationship between the TestDrive and Car components using
the following settings:
— Name: relTestDrive_Car
— SourceColumn: CarlD
— TargetColumn: CarlID

4. Select the Customer component. In the Properties view, change the Name
property to ttCustomer. Press the Enter key. The component’s name will reflect

the change.

. .;',\?‘l_l_'T_l,__E?.-mm,ﬂ_/'v"'-'—ﬂ-‘_i,-r‘.—--r"nu_v--,".- _"""",-,“—ﬂ—-g-’ S NN = L i
. |2 autoedge-guiini /
o bl carModel2CresteTakle sgl [ ttCustomer

~kal CarQueny.sgl H CustomerLastMame
[ dsTestDrive.dgm - A CustomerFirsthame
L) GeneratedCarQuens sl hd a CustomerMiddieNa. .
1| | ¢ A CustomerBithdate

A CustormerBirthCourtry] _"2/310nshIR

C Propeties &3 \ o= Clutline| B DB Struct.. ‘ == A CustamerlD

+relCugt_TestDrive

E o B g CustornerGender
Froperty | Yalue - H CustomerlicenseD...
O Aftributes 8 CustomerlicenseE...
DataSource ﬁ customerMame
Mame ] uCustomer
TableFropertie: ﬂ 1
Twpe Tahle
= Cudsgeneraﬂon @ Connections 52 |5 Problems )

Author <authors El% 3 Active Connections
[ e temp-db

CodeTemplate com.openedge.pdtidbl e

ContainerMame fautoEdge/src - - OBrpCore
«| i B e Autoedge 1
5 4
continued on next page
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Lab 9 — Using Tools for Business Logic, continued

Setting Properties, continued

5.

In the Properties view, scroll down to the TablePrefix property and delete its value

so that the value is blank.

T Properties 52| o= Outline | 55 DB Struct.. | = O
B 5o B Y
Froperty | Yalue ;I
= Code Generation
Author <author

ContainerMame fAutoEdge/src
FileExtension i
FileMHamePrefix
Generatezepar tru
TakblePrefix

CodeTemplate c:n:nm.n:upenedge.pdt.t-ﬂlbl.jeJ

= #tended Attributes hd
4| | b

6. Repeat steps 10 and 11 for the TestDrive and Car componets:

— TestDrive
¢ Name: ttTestDrive
¢ TablePrefix: (blank)
— Car
¢ Name: ttCar
¢ TablePrefix: (blank)
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Lab 9 — Using Tools for Business Logic, continued

Setting Properties, continued

7. The component diagram is now complete and should look like the following:

*dsTestDrive dgm 3 l

S ds [estlinve

containg | containg

EJ tCustomer

contains

8 CarDescription
x g CarAddedDate

H CustomerLastMame
A CustomerFirsthlarme
g CustomerMiddieMa...

] tCar

A Carlstuwailable
g Carld

g Carvim

] UcarlD

Felatianship

+relTestDrive_Car

] T estDrive

# CustomerBirthdate

g CustomerlD
d CustormerGender

™ customerName
5 uCustomer

H CustomerBithCauntry

+re|Cugt_TestDrive

8 CustomerlicenselD..,
A CustomerlicenseE. .

Felationship

d TestDriveTime

i TestDrivebeedEwval
H TestDrivedpproved
i TestDrivelD

i CarlD

A CustomerlD

M Customer

=1 uTestdrive

o
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Lab 9 — Using Tools for Business Logic, continued

Forward Engineering Code

Once a Component Diagram is completed, you can use the model to generate ABL code
based on the structure and properties of the components in the diagram. Complete the
following steps to generate code for the TestDrive ProDataSet, including code for all the

related temp-tables:

1. Save the diagram by selecting the Save button in Architect’s toolbar.

@'DpenEng ‘1ools for Business Logic - AutoEdgefsrcidsTes:
File Edit pM&vigate  Search  Project OpenBEdge  Bun Window  Help

Pt IFIENE AR N D S AR N i S e R

; : DE :
Eﬂﬁ o Save (Chl+S) s for Business Logic £2° OpenEdge Editor

&% Resources | =5 ¥ 20 | *dsTestDrive.dgm 53
[57 OpenEdge [ ‘= ds lestUnve
H-[= services
2] wersion t
#-=- sonicesh containg | contains
L= winfarm

i B Eﬂtgﬁﬁﬁﬂﬂ@ﬂm T
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Lab 9 — Using Tools for Business Logic, continued

Forward Engineering Code, continued

2. Right-click in the canvas area and select the Generate Code option.

fEi-ilole | 40 Qx|

@'DpenEdge Tools for Business Logic - AutoEdge/srcidsTestDrive.dgm - DpenEdge
File Edit MNawvigate Search Project OpenEdge Run  ‘Window Help

P e e SO RN

=] | & OpenEdge Tools for Business Logic £ OpenEdge Editar

&F Resources &2 l =8
[E&F
&= sonicesh LI

H- (= winform

..... = autoedge-gui.ini
----- Q cartodel2Create Table.sqgl
----- Lol CarQuery.sql

----- dsTestDrive.dgm

----- 5ol GeneratedCarQuery.sql
----- [F] startp

TR o e S S

Sl

«

£ Prop.. £2 | 8% Outline| 9 DB St..| =

e =l =
—+

|

Froperty | Value

dsTestDrive.dgm 33

ds [ estUrve .
= contains

contains | contains

< Undo
EedE

ftCustomer

A CustomerLastNa = Show Praperties View
g CustornerFirstMa
A CustamerMiddlie &0 T DiEmrET

4 CustomerBirthda g Yalidate Component

T e o

s MeOE I =l ®e] = Generate Code
8 CustomerD \pprov\g
g CustormerGende Fun As b
8 Custormerlicens  DehudAs D
f Customerlicens  Team i
9 customerName Compare With 4
51 uCustomer Feplace With »
LI OpenEdge »
= Connections 23 ] [3_ Problems| 1
R P

(T RS S - "r-ﬂ P
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Lab 9 — Using Tools for Business Logic, continued

Forward Engineering Code, continued

3.

Include files will be created to hold the ABL code for the components. Review
and close the files, including the Component Diagram file.

File Edit Source

[ openEdge Tools for Business Logic - AutoEdge/src/dsTestDrive.i -

Mewigate Search Project OpenEdge  Run ‘Window  Help

ﬁ|ﬁ OpenEdge Tools for Business Logic €5 OpenEdge Editor P

[lak P NS e s

OpenEdge Architect - C:\0penEdg... Ml[=] 3}

& Resources 2 l

=0

1

[ - T R S

9
10
11
1z
13

I ~ B
/ [
File : From template Datalet - template for Datalet.
Luthor (s) : <author:>
Created D Sun Dec 21 ZZ:54:2Z2 E3T 2008
Version : 1.0
HNotes :

dsTestDrive.dgm UD #Customer.i ‘ [i] fTestDrive. | [i] ttCar.i [D dsTestDrive.i & ):' |
o

{arc/ttCustomer. i}
{sro/ttTestbrive. i}
{ero/oncar. i}

Ll aaem, ...__-‘-—__.,,__r.hkmwnm_’*'___.‘-_...‘u._—_ .

4. Close the Tools for Business Logic perspective.
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Lab 10 — Using the Visual Designer

Overview

Architect’s Visual Designer allows developers to build ABL GUI applications using .NET
controls.

This lab shows some of the features of the Visual Designer and builds a sample OpenEdge
GUI for .NET client application.

continued on next page
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Lab 10 — Using the Visual Designer, continued

Visual Designer Perspective

[d OpenEdge Visual Designer - AutoEdge/srciTestDriveForm.cls - OpenEdge Architect - C\OpenEdgetw... JH[=] 3
File Edit Design MNawigate Search Project OpenBEdge  RBun Window  Help

Cie g% [ =0 Que e e TG

=

Ej’lazl OpenEdge Yisual Designer & OpenEdge Editor

- &, TestDriveForm.cls (Design) &2 TestDriveFarm.cls | = O||El Properties 2 ] =i E Y0
e ; Toolbox n ITestDriveForm . Progress \Windows. Form LI
¢ 8 TestDrive Form : ; a ;
Lo + Microsaft Controls 1= |F'"3F'e"t'e‘3 | Events |
Filter I GO | +) OpenEdge Contrals FormBorderStyle | Sizable ;I
HelpB utton Falze
—| OpenEdge Ulr... [P B flzon)
Crag a column header here to group by that column. ¢ Painter Imetdode MolContral
R IsMdiContainer | False
& AnimationCaontral .
s - . KeyPreview Falze _I
1 AppStylistR untime Language (Default]
-% |nbaxCantralStyler . Localizable False
@ UlraButton Lacation 0.0
Izl UltraCalct anager Locked Falze
|2 UltiaCalculator MaintenuStip | [nane) ;I
7 UlraCalculatorD ropDyown Text
= UlraCalendarCombo The text associated with the contral.
“i " UlraCalendarlnfo
77 UlraCalendarL ook
UltraChart =
[v] UlraCheckE ditor =
Start! Click 'Start!' to begin designing the UlraGrid ’u! UltraColorPicker
= UlraComba i bindingSourcel  Progress.Data Bindi
=7 UlraCombaE ditar
£ UltraCurrencyE ditar
I ° [ UlraD ataSource
# bindingSaurcel [271] UltraDrateTimeE ditor
! UltraDrayview -
1 | | 3 1 _>|
[ w Writahle [
Notes:
O Visual Designer Editor’s Canvas Area
® Visual Designer Editor’s Toolbox
© Properties view for property and event settings
® Non-visual controls area
continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Form

OpenEdge GUI for .NET client development begins by creating an ABL Form to hold
components. This section shows how to create an ABL Form and place components on it.

1. Open the Visual Designer perspective by selecting the OpenEdge Visual
Designer option from the Open Perspective button.

3 OpenEdge Editor - OpenEdge Architect
File it Mawigate Search Project OpenEdge
| £ B | ~0~Q~ |5
T | & OpenEdge Editor

P, OpenEdge AppBuilder

37 OpenEdge Debugger

2 OpenEdge Tools for Business Logic
&3 OpenEdge Visual Designer

I Progress DB Mawvigatar

e [i] Customer |
S e P ,_\?r-l

2. Minimize the Resources view to provide more room for editing the form.

File Edit MNavigate

| i | LB |-G~

Ej’|3;| OpenEdge Yisual Designer & OpenEdge E

£ Resources B2

| = F:;\‘Minimize
E? oeri ;I

[& OpenEdge

| L= services
xﬂ.'-xw- I RN LS R e

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Form, continued

3. Select the down-arrow beside the New button and then select the ABL Form
option.

3 OpenFdge Visual Designer - Ope
File fit MNavigate Search Froject Of
| W | L% 35~

Ll
[ (= OpenEdge Project
- % Project..

. o] ABL Class
* & ABL Interface
|F{ ABL Procedure
li] ABL Include
[ Faolder
 File

= ABL Form k
ABL Dialog
= ABL MDI Farrm

[=+] ABL User Control
| | ABL Inhetited Control

] Other... Crl+M

Sl ‘J_‘_“H*M'“F;.‘._ u##q-‘k. ,L__J
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Lab 10 — Using the Visual Designer, continued

Creating a Form, continued

4. 1Inthe New ABL Form wizard, enter \AutoEdge\src for the Package root and
TestDriveForm for the Form name. Select the Finish button.

Ed New ABL Form _ O] x|

Create a Form Class =]

Enter a name for the form. Do notuse spaces or special characters.

"
Fackage root; IWUTDEdgE\SrE X Browse. .
Fackage: | Browse. ..
>

Form name: ITestDriveFDrm X

todifiers: ™ Final ™ “Widget poal

Inherits: IPngress.WindDws.Furm Browse...

Implements: Add
[EErEE

Selectwhich code elements you would like to generate:

I¥ | Generate defanlbEanetustar ¥ Eenerate desthictr
™ Generate super class constructors
™ Add routine level error handling

Selectwhich style of method code youwould like to create:

% Generate exceptions for required methods
" Generate default values far required methods

Description: ;l
=
Furpose: ;l
=

N

(7} F Einishr_\l I Cancel

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Form, continued

5. Resize the new form to look similar to the following image:

@ OpenEdge Visual Designer - AutoEdge/srciTestDriveForm.cls - OpenEdge Archii

o TestDriveForm

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source

There are a number of ways of supplying data to a form’s controls, but the most common
is to use a ProBindingSource control that is tied to a temp-table or ProDataSet. The
ProBindingSource is a non-visual control supplied by OpenEdge that acts as a data source
to .NET controls. This section shows how to add a ProBindingSource to the form.

1. Expand the OpenEdge Controls group in the Toolbox by clicking on the + (Plus)

button.

indow  Help

‘m.cls - OpenEdge Architect - C:\OpenEdge\w..._ =1 F3

*I-,T_I (::I - o
I.

3

i
r

L... Toolbox

+| Microzsoft Contrals

C Propeties &2

B2l B YO

ITestDriveFDrm . Progreszs. Windows. Form

|Prnperties | Events I

=l

ﬁpenEdge Cantrals
+"0penEdge Ultra Contrals

i‘,\\_,_,-\_.-._._,-\___-_ﬁ-x.-_-. '\-—H]-

"""'\“"‘r"“""""‘“*"-“"‘“" Al

FrowinHandle Progresz. ClrBridge. P«
RightToLeft Mo
RightToLeftLayoul Falze
Showlcon True
ShowlnT askbar | True
BLSEE, oo vns 433,335 000
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

2. Select the ProBindingSource control and position the cursor over the form.

@'OpenEdge Visual Designer - AutoEdge/src/TestDriveForm.cls - OpenEdge Architect
Froject OpenEdge  Run  Window Help

File Edit Design Mavigate Search

w e R TSR R S e e e

Ej’|3;| UpenEdge Visual Designer & OpenEdge Editor

: &) *TestDriveForm.cls (Design) Ki] =0
Toolbox T |

!EI m ) Microzoft Contrals

=| OpenEdge Contraols

s TestDrive Form

L¢ Poinker

o w
‘iﬁ windowContainer

+| OpenEdge Ulra Contrals

)

Y TR SR pomie, s i gl Mg i, P~ ?‘-—Iﬁ- s

- - e, P
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

3. Click on the form. The control will be placed in the non-visual controls area
below the form. A start wizard also will be displayed.

e |

5 -1 = - G -0 A ProBindingSource Designer - bing

s

[
24 bindingSourcel

R = s

EE}Note: The non-visual controls area helps keep the non-visual controls out of
way so that they do not interfere with any visual controls in the form. It also
makes finding and selecting non-visual controls easier.

%}Note: It is very common for controls to have a start wizard that is displayed
when they are placed on a form.

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

4. The start wizard’s toolbar can be used to manually create the schema structure for
the data source. However, you can also import the schema using an XSD file that
can be directly generated from a ProDataSet’s definition.

[ ProRindingSource Designer - bindi!

Tables Fields

s s s M. *;l-*“*-:-r*“~1~

Select the Cancel button in the start wizard (you will return to soon).

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

5. Select the down-arrow beside the New button and select the ABL Procedure

option.

3 Open=dge Visual Designer - AutoEd!
File it Design Mavigate Search Froje
OGO L% s -0-Q -~
P2 OpenEdge Project E
7 Project...

| =

. o] ABL Class

* B ABL Interface

B ABL Procedure

Li] ABL Include

[ Faolder
 File

=9 ABL Farm

ABL Dialog

£ ABL bDOI Form

[=+] ABL User Control

[*'] ABL Inhetited Caontral

7 Other... Crl+M

LRt q.q.u-v--.-..‘.p-ﬂ“-‘"‘ ‘-_’\#‘-x‘_ﬂ_hr.% —
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

6. Inthe New ABL Procedure wizard, set the following and then select Finish:
— Container: \AutoEdge\src
— File name: createXSD.p

@ New ABL Procedure =] Py

Create an ABL procedure file

Specify a name for the procedure file.

<

Container: I\AutuEdge"-,src Browse...

File name: |create><SDlp K

Diescription: \

Furpose:

I‘_I;I*_I;\_

Author: fjwillis

[ Add routing lewel error handling

~

(7} : Finish I Cancel

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

7. Enter the following code as highlighted below. This code will take the ProDataSet
definition created in a previous lab and create an XSD file from the structure.

&, *TestDriveFarm.cls (Design) I [F] *createS0p 53 \

17
13

20
21

25 fDATASET dsTestDrive:WRITE-XMLSCHEML
z {"File", "dsTestDrive.xsd", TRUE, ?, FALLZE).

Ja

1

2 e
3 File : createX3ID.p

4 FPurpose

=

5] Jyntax

7

=] Description :

=]

10 uthor (=) » jwillis

11 Created i Mon Dec 22 01:24:17 EST Z0038

iz Notes H

5/ ————————————— - ——_——————_———_—_———————————— e — ———
14

15 - - ol e e e e Definitions e e e e e e e el
la l{dsTestDrive. 1}

IE JE OBTEHAFRAERAFERAFRAGS Preprocessor Definitions  RESEEASERAGEREEAAEE

2z f?f ol ol il Ol ol ol ol ol Ol Ol ol ol ol ol ol i M=in Blork ool ol ol ol O ool ol ol ol ol ol ol o

| o

8. Save the file and run it using the Generic Run launch configuration. If you are

prompted to save the form file, select No.

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

9. Once program has executed (control will quickly be returned to you after a splash
screen is shown), restore the Resources view by clicking the Resources button.

3 OpenEdge Visual Desigr’
File Edit Source MNavigate 3
0 e L 1S
! |3;| DpenEdge Yisual Designer
: |3;| *TestDpiweFormm.cls (Design

File Edit Source Mawigate Search FProject

| it | A% |H~0~Q -~

— |8 Resources E@l =0

. 5 el
= 2 AutoEdge
#-s® Referenced Asspfiblies
---JL Frocedure Li
[B» rcode
ES—} SIC
H-[= crys
H-4= gui (S
H-(= netc| Paste

&
£
H-52 s,
o
- shey(E Impo...
&
3

I e +

6= soni 3 Export.

rl- (= winf
----- aut

[ s catodel2CesieTailesgl ||

246
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

11. Scroll the view and make sure the dsTestDrive.xsd file was created.

£ Resources B2

= O

E=E

L= winfarm

..... || autoedge-gui.ini
..... sl CarQuery.sql

----- [F] createx=D.p

----- dsTestDrive.dgm
----- [i] dsTestDrive.

----- TestDriveFarm.cls

----- [i] #Custormer.
----- [i] #TestDrive.i
----- = .dbhconnection

..... D .prDject
\ ----- = .propath
= apphodeltdbl

----- Al assemblies «ml

12. Minimize the view.

13. Close the createXSD.p file.

----- sl GeneratedCarQueny.sgl

----- [F] testDBConnection.p

FY

----- @ cartdodelZCreateTable =gl

OpenEdge Architect Tutorial 2009
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

14. Select the bindingSourcel control in the non-visual controls area and then click
on the ProBindingSource Designer link in the launch wizards area of the
Properties view.

[ OpenEdge Visual Designer - AutoEdge/src/TestDriveForm.cls - OpenEdge Architect - C:\OpenEdge\w. .. M[=1E1
File Edit Design MNawvigate Search Project OpenEdge  Fun Window  Help

[N A= S PR RS A R AT AR AR S e e R A

1 &) OpenEdge Yisusl Designer &F OpenEdge Editor
: &) *TestDriveFom.cls (Design) 33] = 0| = Praperies EX] EHETT EI|
o Toolbox n IbindingSource‘I : F‘rograss.Data.BindingSourc;I
73 = "
TestDrlveForm !Elm 1 Microzoft Controls |PTDDEﬂi=E | Everts I
=] OperEdge Controls [Mame] bindingSourcel &
. AllowE dit True
R Poirter Al v True
“H ProBindingS ource AllowRemove True
6 windowContainer AutoSart Falze
AutoSypnc True
+| OpenEdge Ultra Contrals | Autalpdate Faisn
Batching False
D atabd ember -
ProBindingS cprce Designer |
wihdicates the name used in code to identify
/ the object.
B Quiline £ | El~==0
, ;E TestDriveFom  Progre: {
Sl hinclingS ource]  Proar
! bindings ourcel
4 | |
[ Witable |

15. In the control’s start wizard, select the Import Schema button.

ProBindingSource Designer - bindingSe

=PRI TR 1—

Tables |Imp|:|rt Schemai

R et Y ot L mtine s

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

16. Navigate to the C:\OpenEdge\WRK\AutoEdge WS\AutoEdge directory and select
the dsTestDrive.xsd file. Select the Open button.

Open

Recent

ky Documents

™

by Computer

Loak i IE}.&utDEdge LI e _? =
ICircode
i) sro
[ s TestDrive xsd
File name: IdST estDinve, xad ;I Open
Files of type: IXSD Files ;I Cancel !
L4

OpenEdge Architect Tutorial 2009
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Lab 10 — Using the Visual Designer, continued

Creating a Data Source, continued

17. The wizard will use the file to create the schema structure. Select the OK button to
close the wizard.

ProBindingSource Designer - bindingSourcel O] x|
Bt X =

T ables Fields T able: ttTestDnve
g TestDriveTime g'gg J.'*l |J
g DealslD —
g TestDriveNeedEval = Design .
g TestDrivedpproved M ame ttTestDrive
8 TestDrivelD
g CalD
8 CustomerD
A
Design
(] i I Cancel
continued on next page
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Lab 10 — Using the Visual Designer, continued

Writing Code for the Data Source
Code must be written to tie the ProBindingSource control to the ProDataSet. This section

shows how to write that code.
Right-click on the form and select the View Source option.
4 OpenEdge Visual Designer - AutoEdge/src/TestDriveForm.cls - OpenEd

Search Project OpenEdge  Run  Window  Help

1.

File Edit Design Mavigate

AR |H~-0-%~ |5

Tz E
Ej’|3;| OpenEdge Yisual Designer & OpenEdge Editor
: £, *TestDriveForm.cls (Design) 53 l
Toolbox
!Elm ) Microsoft C

&F = .
¢ TestDriveForm
=I OpenEdge C

Cirl+S g -
# ProBindings

‘iﬁWindDwEant

) OperEdge

Sawve
Close Yisual Designer Cirl+F4

Yiew Source

PEste i [ 3

Lock Controls

Froperties and Events

s, st ., Ml

pag L
| _“,..hm\dIQgSl{lL_JE'iA_,m“ A e e o it A

continued on next page
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Lab 10 — Using the Visual Designer, continued

Writing Code for the Data Source, continued

2. Add the code shown below to define the ProDataSet and provide a method for
populating the ProDataSet with data. You can copy the code from the box below.

*TestDriveForm.cls £2 l

& *TestDriveForm.cls (Design) i
17 CLASE TestDriveForm INHERITS Form i
13 !
19 DEFINE FPRIVATE WARIAELE components LS System.ComponentModel,. IContainer.

Z0
21 DEFINE FPRIVATE WARIAELE hindingSourcel A% Progress.Data.BindingSource NO-TNDO.
2z
B (’{_dsTestDrive.i} _\
Bk DEFINE PRIVATE WARIAELE hlatalource A3 HLNDLE NO-TNDO.
Z5
ZE METHOD FPRIVATE WVOID attachDataSource() :
z7
Z8 DEFIME DATAL-SOURCE sreCustomer FOR
8 DEFINE DATL-3OURCE srcTestDriwve FOR EET3 (customerID).
30 DEFINE DATL-3OURCE srcCar FOR EETS (carID).
31
32 BEUFFER ttlustomer: ATTACH-DATL-30URCE (DATL-30URCE srcCustomer:HANDLE] .
S BEUFFER ttTestDriwve:ATTACH-DATA-SOURCE (DATA-30URCE srcocTestDrive:HANDLE) .
34 BEUFFER ttlar:ATTACH-DATA-ZOURCE (DATA-30OURCE srocCar:HANDLE] .
35
36 DATASET dsTestDriwve:FILL().
37 hiatalfource = DATASET dsTestDrive:HALNDLE.
358
39 I\LEND METHOD .
40 I }
41 CONZTRUCTOR PUELIC TestDriveForm | ):
4z
. ‘-u—ﬁﬂﬂw R A I

Program: TestDriveForm.cls

{dsTestDrive.i}
DEFINE PRIVATE VARIABLE hDataSource AS HANDLE NO-UNDO.

METHOD PRIVATE VOID attachDataSource():
DEFINE DATA-SOURCE srcCustomer FOR
DEFINE DATA-SOURCE srcTestDrive FOR KEYS (customerlD).
DEFINE DATA-SOURCE srcCar FOR KEYS (carlD).
BUFFER ttCustomer:ATTACH-DATA-SOURCE(DATA-SOURCE srcCustomer :HANDLE).
BUFFER ttTestDrive:ATTACH-DATA-SOURCE(DATA-SOURCE srcTestDrive:HANDLE).
BUFFER ttCar :ATTACH-DATA-SOURCE(DATA-SOURCE srcCar:HANDLE).

DATASET dsTestDrive:FILL(Q).
hDataSource = DATASET dsTestDrive:HANDLE.

END METHOD.

continued on next page
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Lab 10 — Using the Visual Designer, continued

Writing Code for the Data Source, continued

3. Add the code shown below to run the method that populates the ProDataSet at
initialization and binds the ProBindingSource control to the ProDataSet. You can
copy the code from the box below.

&, *TestDriveForm.cls (Design) [ *TestDriveForm.cls &3 I

SE EUFFER trCustomer: ATTACH-DATA-SOURCE (DATA-ZO0OURCE sroCusto
33 BEUFFER ttTestDrive:ATTACH-DATAL-ZSOURCE (DATA-30URCE sroTest
=L EUFFER trCar:ATTACH-DATA-ZOURCE (DATA-3O0OURCE sroCar:HANDLE)
35
3G DATASET dsTestDriwve:FILL().
T hvataSource = DATAIET dsTestDrive:HLNDLE.
38
El=l END» METHOD.
40
41 CONITRUCTOR PUELIC TestDriwveForm ()@
42 j
43 ‘
44 SUPER() . y
45 Initiali=zeComponent () . :
E1
47 attachDatalSource () .
45 binding3ourcel:HANDLE = DATASET dsTestDrive:HLNDLE.
49
50 CATCH LS Progress.Lang.Error:
51 TNDo, THROW
52 END CATCH. I
53
54 END CONITRUCTOR.
55
56
S METHOD PRIVATE WOID InitializeComponent | 1:[]

L. x._“.il__\__‘__q,_. RO R R B N R

Program: TestDriveForm.cls

attachDataSource() .-
bindingSourcel:HANDLE = DATASET dsTestDrive:HANDLE.

continued on next page
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Lab 10 — Using the Visual Designer, continued

Working with Visual Controls

The Visual Designer offers many visual .NET controls that can be use to create a client
form. This section shows how to work with visual controls.

1. Select the TestDriveForm.cls (Design) tab to switch back to the visual editor.

@'DpenEdge Visual Designer - AutoEdgefsrc/TestDre

File Edit Design Mawigate Search Project OpenEdge R
JL=<J;7LD.| J{lJ%Jﬁvﬂv%vJQavJ -
£ |8, OpenEdge Visual Designer &5 OpenEdge Editor

: & *TestDriveForm.cls (Design) &2 *TestDrivaForm.cls

[s] 3
&

TestDrive Form

- M“E,ﬁ-—i__‘_“ﬂ ru,“ﬂuﬂu..h,*xw#m

2. Expand the OpenEdge Ultra Controls group in the Toolbox by clicking on the +

(Plus) button.
m.cls - OpenEdge Architect - C:\OpenEdgetW... M= E3
“ndow Help
i
F (_'::I - -
?
H = O || = Propetties 32| & 2L 80 ¥ =0
;L' ..... Toolbox a ITestDrivanrm: Progreszs Windows. Form ;I
I_.‘:J +| Microzoft Controls | Properties | Events I
?2 =| OperEdge Caontrals .E.qamezﬂ ; F’est?riveFurm -
5 - coeptButton hone
f; * Painter AccessibleDescrip J
"i d 4 ProBindingS ource AccessibleMame
; 46k windowContainer AccessibleRole | Default
i f AllowDirop Falze
B
g —'EEDPEHEEIQE =izl | AutoScaleMode | Inherit
\[ AutaS croll Falze
. e NS e T T N uhwnw—-tuwﬂn—‘
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Lab 10 — Using the Visual Designer, continued

Working with Visual Controls, continued

3. Scroll the Toolbox and find the UltraGrid control. Select the control.

.cls - OpenEdge Architect - C:\OpenEdge\W. .. [li[=] E3

)duw Help

b - -

p

4

¥ = O || = Properties 22 | & 2L B2 ¥ T O
" Toolbox a ITestDrivanrm . Progrezs \Windows. Farm ;I
j 2] UltraD ate T imeE ditar ;I | Properties I Everts |

H A UlraDayView Provw/inHandle | Progress. CiBridge. Pr=
*) r!‘ UltraDezktopdlert RightT oLeft Mo

4 5 UlraDockManager RightT oLeftLayoul False

-, 2 UlraDropD own Showloan True

k3 5 UltraDropDiownButtan ShowlnT askbar | True

% “IUIraE spandableGroupk: Size 433, 335

% Il ltraE splorer ar SizeGrpShyle Auto

L : = UltraFlowl ayouthd anage: StartPosition WindowsDefaultlLocz
4 . T UltraFontt ameE ditor s Tag :

4 A UlraF ormattedLinkLabel Teut TestDriveForm

P [zb | LlltraF ormattedT extE di Taphost False e
i e UlraGauge Text

d The text aszociated with the contral.

4

3

g

~aik,

13 UlraGridBaglayoutPans
|_1'£| UltraGridCalumnChoozer

LapibibssbridlocumentE xpor,

0 Qutline 52 * - T O

m=
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Lab 10 — Using the Visual Designer, continued

Working with Visual Controls, continued

4. Click on the form to place the control. The control’s start wizard will be shown.

5. In the wizard, select Bind the control to an existing DataSource now option
from the pull-down menu. Then, select the bindingSourcel option from the
DataSource pull-down menu.

UltrawinGrid Quick Start

UltraWinGrid Quick Start

Data Schema Presets Features
1 Specify the schema that will be used to 2 Select a preset look andfor behawior 3 Select one or more major features
generate bands and columns
Appearance Browser Band and Column Properties Finish
4 Clstomize the look. 5 Customize settings on specific bands and 6 Confirm the changes you've made
columns
To specify the data schema the control should use to generate bands and columns, I want to...
Bind the conkrol ko an existing DataSource now 4‘_ -
SelectaDataSource tobindto... Preview of the selected D ata5 ource’s schema
DataSource [none] =
- Q
il bindinESou;iﬂ
Maote
abow
A < Previous Mexk = Finish

6. Click the Next button.

g —
In"#v-,-d—""v"‘-«fnr\#f hH-—"_"ﬂ"'\-’TH.wrﬂ'—-+ ﬁ#’"ﬁ-‘-‘"wr-

rJ

}'i-

1:‘ Preview of the selected D ata5 ource’s schema

(5:: ;I El--'g Band [0] - "ttCustomer' -

J [& CustomerLastMame

| [& CustomerFirsth ame

.;E [& CustomerMiddleMame

£ [& CustomerBirthdate

jfare listed o [ CustomerBirthCountry j

z_ pv

I % Previous | Mext = %J Finish |

j

continued on next page
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Lab 10 — Using the Visual

Designer, continued

Working with Visual Controls, continued

7. In the Look Presets pull-down select the WindowsXP — Blue Theme option and

then click the Finish button.

¥ Select separate 'Look! and ‘Behavior' presets

™ Select a combined 'Look! and 'Behavior' preset

Preferences. ..

P A T NI S S i
m ant ko use, click Mext' to proceed.

R T e g S e e A e M

IDrag a column header here to group by that calurmn. _

< Previous Mext = | [: Finish |

8. Back in the form, resize the visual control to fit in the form.

G =

*“TestDriveForm.cls |

% TestDriveForm

Click 'Start!' to begin designing the UlraGri

249 bindingSourcel

- .t w--x*—ﬂwﬂ-wwmwﬂ‘“mhh'
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Lab 10 — Using the Visual Designer, continued

Working with Visual Controls, continued

9. Click the Smart Tag button for the control.

\akilealRiiaRaunaladRasianeisy ) “TestDriveFom ol
EB TestDrive Form - o] x|

'm’

Cme sl TIs

-
+

—

i € =] 1" 5 [

f3a:

idaal
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Lab 10 — Using the Visual Designer, continued

Working with Visual Controls, continued

10. In the Smart Tag pop-up box, select the Dock drop-down and click on the bottom

button to dock the visual control to the bottom of the form.

S,

g PSS e _—— -

£, d ¥ .. - — e a
g & UltraDropD awn e emtle —

§ DataSource bindingSourcel

" UltraironD owrB uttan

UltraGrid T asks Plapkayout -
: Hame | ultraGndi |  UlraGrd Designer... . Lapout
! d.... Beset Layout...
Dezigner Malog...
Data
1 ......................... = Data Sounce bindin
§ g5ource] -
i | " J' aylL apout
{:& a Drata Mermber | \‘ ||ain laypout of the grid.
r Layout
Caption Yizsible | Falze R Hine 52 T =
q% ............................ 2
i Daock ztDriveFormn  Progress windows. Formn
% View Style ultraGridl  Infrag fin UltratwfiniGr
! dingSourcel  Progress. D ata BindingS
{i Wrap Header Test
i A Ulhral
) A
'i A [lkrall N ||
& = Ulkral] N b ||
H oo e || MoOne
3 i
bﬁritable
[
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Lab 10 — Using the Visual Designer, continued

Working with Visual Controls, continued

11. Resize the control to be similar to the image below.

[ OpenEdge Visual Designer - AutoEdge/srcfTestDriveForm.cls -
File Edit Design Mawigate Search Project OpenBEdge Run  Window  He
e [ LW [$r0-Qr|5r [ /v v G
%’|3§| OpenEdge Yisual Designer & OpenEdge Editar
- kasRiamsRale ) “To-0re o o
oE Toe
i B (] TestDrive Form _ o x| -
| J |
=
;IDrag a colurmn header here to group by that calumn. _ %
Last [Family] MName Firzt Mame tiddle Mame [rate of Birtk b _
:L )
o
=0
£
Click 'Start!' to begin designing the UlraGrid "%
i :@ ]
I'I-x_-‘--I .
A

~ M\\\W"‘M‘“*M -“AM--‘._“-‘U‘#-\- ﬂ.ﬂﬁr-—.‘.-l.k

12. Save the file.

13. Run the file using the Generic Run configuration.
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Lab 10 — Using the Visual Designer, continued

Working with Visual Controls, continued

14. Test the form by clicking on some of the nodes in the grid.

8 TestDrive Form _ O] x|

IDrag a column header here to group by that column. _

Drate of IS

Patrick. M. 0313418
Eric M. DE/0B3A¢

T estdrive Date-Time Drealer Id MHeed Eval? Approve

.§05329£2009 f305c74d-1385- .

L Dezcription Added
EEru:uwn Hinda Civo.  10/24/2003

v fa06e7e _
4| | 3

15. Close the program when finished.

[? Car D

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating User Controls

You can extend existing .NET controls by combining them to form a new control. This
section shows how to create a user control.

1.

Select the down-arrow beside the New button and select ABL User Control.

@'DpenEdge Visual Designer - AutoEdgefsrc/TestDriveFor’
File Edit Design Mawvigate Search Project OpenEdge  Bun Wi

Pl L @5 = 0= G 5t ) v Lo
F = OpenEdge Project bpenEdge Editar

=- A
- [ Project. TestDriveForm.cls

. |57 ABL Class
| [ ABL Interface I _ ||:||

\F ABL Procedure

i ABL Include
[ Faolder —
“ Fila Lo by that column.
=4 ABL Form lame Middle Marme Drate of Bir

ABL Dialog

ABL MO Form

B ABL User Control

| | ABL Inherited Contrg

= Other .. Citrl+M

K

Click 'Start!' to begin designing the UltraGrid

L. e, s, e AP
g At g graappte A

262
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Lab 10 — Using the Visual Designer, continued

Creating User Controls, continued

2. Inthe New ABL User Control wizard, enter \AutoEdge\src for the Package root
and QueryFilter for the User Control name. Select the Finish button.

[ New ABL User Control =11

Create a User Control Class
o,

Enter & name for the user control. Do not usgespaces or special characters.

b

Package root: I\P\UtDEdgE\SrC Browse...

Fackage: | / Browse...

ser Control name: IOueryFiIter{ K

il

bodifiers: ™ Final ™ “Widget pool
Inherits: IProgress.WindDws.UserCDntrDI Eerwse...l
Implements: Add.

Bt

H

Selectwhich code elements you would like to generate:
¥ | Generateidetault constrstr ¥ | Generate destristar
™ Generate super class constructars
™ Add routine level erar handling

Selectwhich style of method code you would like to create:

% Generate exceptions for required methads
 Generate default values for required methods

Description: ;l
=
Furpose: LI
=
(7) Finish Cancel

3. Expand the Microsoft Controls group in the Toolbox.

continued on next page
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Lab 10 — Using the Visual Designer, continued

Creating User Controls, continued

4. Place and align a Label, TextBox, and Button control in the form and resize as
shown below.

&,| TestDriveForm.cls (Design) | TestDriveFarm.cls [3;| *QueryFilter.cls (Design) &2

Toolbox

labell | buttand | D e e
&

-\% Backgroundwiorker

(3] Buttan
L. -u---ﬂ-le\.‘-.,_.-.__.wlw-‘l.._L ‘_ﬁr-.‘-\«l.."\ -._\_\T“‘._Mnl..‘ ol [ - an \r.,_

5. Click on the labell control in the form. In the Properties view, scroll to find the
Text property and enter Filter for the property.

[HopenEdge Vvisual Designer - AutoEdge/srciQueryFilter.cls - OpenEdge Architect - C:\0penEdgeVwRKY. . [HI[=] E3!
File Edit Design MNawvigate Search Project OpenEdge  Fun  Window Help
[fetmpa et NES R SRS A R
T | &) OpenEdye Visual Designer €3 OpenEdge Editor
— |&,] TestDriveForm.cls (Design) | TestDriveForm.cls [3} *QueryFilter.cls (Design) 2 } = B ||C] Properties 2 I =3 EY.0 |
&
o | Toolbox n Ilabe\‘l : Systemn Windows. Forms. Label LI
& gFiIter [ 5 button - X |
DG =) Merosaft Carirls | Properties | Everts |
Modifiers Frivate =
Padding 0,000
,\%' Backgroundworker RiightToLeft No
(32) Button Size 100, 23
CheckEiox Tablndex 0
[B%] CheckedListBox Tag
%] ColoDialog Filter | =l
ComboBox Texthlign Topleft
FE| ContesttenyStip UseCompatibleTe: True
[ DataGridview b UseMremaonic | True
T DateTimePicker Useiw'aitCursor | Fake Z
E DirectoryE ntr Text
il e dpemi | st s p——— e o anadintn sl g apomes sl o ‘_‘..fn et al J_IWL_#M‘W__A

6. Select the TextBox control in the form and set the Name property to FilterBox.

7. Select the Button control in the form and set the Text property to GO and set the
Name property to FilterButton.
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Lab 10 — Using the Visual Designer, continued

Creating User Controls, continued

8. The User Control should look like the following:

3 OpenEdge Visual Designer - AutoEdge/srcfQueryFilter.cl

File

Edit Design MNavigate Search Project OpenEdge

=

Bun Wi

Iti~E LB | ~-0-@- || v A
&, OpenEdge Yisual Designer £2° OpenEdge Editor
o) TestDiiveForm.cls *Llueny

&

[s] 3
&

ﬁTestDriveFurm Cls (Desion]

Filter |

.

9. Right-click on the form and select the View Source option.

hnebalhn g, N e i St o i, e B2
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Lab 10 — Using the Visual Designer, continued

Creating User Controls, continued

10. Change the FilterBox and FilterButton variables to PUBLIC.

& TestDriveFaorm.cls.. |3;| *CueryFilter.cls .. I “CuaryFiltercls &3 l»1 =0
1 s
2 lI." A e e e —
3 File oueryFilter
4 Purpose
= Syntax
[ Description
7 Luthor (=) r Jwillis
=1 Created : Mon Dec 22 03:09:45 E3T 2005 o
=l Iotes

10 | ===
11

12 UTSING Progress.Lang. .

13 USING Progress.Windows.UserControl.

14

15

16

17 CLAZS QueryFilter INHERITS UseriControl

15

12 DEFINE PRIVATE VARIAELE components L3 Svstem.ComponentModel. ICont:
20

21 DEFINE PEIVATE WARIAELE lakbell AZ Systew.Windows.Forms.Lsbhel NO-UF
22 DEFINEf PUBELICYVARTAELE FilterBox 43 System.Windows.Forms.TextBox T
23 DEFINEN PUELICAVARTAELE FilterButton A% Systew.Windows.Forms.EBEuttor
z4

25

26

-
«| | 3

11. Save the QueryFilter file and close both the ABL and Visual Designer editors for
the control.
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Lab 10 — Using the Visual Designer, continued

Working with User Controls
The following section shows how to create a Toolbox entry for the new User Control,
place it in a form, and write code for it.

1. Collapse all the control groups in the Toolbox.

2. Right-click on one of the control groups and select the Add Control Group
option.

'm.cls - OpenEdge Architect - C:\OpenEdge\w. .. [Mi[=] F3

ndow  Help
b
I\II <]j - -
o
¥
- { e | [=—| H = (=]
. O | = Properties 2 | & 2L B0 ¥ T O
Toolbox # || ulraGrid? : Infragistics.win Ultrahw/inGrid Ult: = |
4l Micrazaft Contr | Properties | Everts I
) OpenEd [DataBindings) _ =
[Mame] ultraGndl1 I
Al One ne | ra Contralz PRI I S
Add Cantrals...
Feset Toolbox D efault -
Lock Toolbox e [l et
L..
Add Control Group
2 Delete Contral Group Del
Fename Contral Group Fz
Expand all Cantrol Groups he contral,

|
—-\Mmm% g _ﬂv_*m ‘R.Fl_l

continued on next page
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Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued

3. Type User Controls and press Enter.
=8

Toolbox 1

Hil | Microzoft Controls
I +| OpenEdage Controls
+| OpenEdage Ultra Contralz

Uszer Controld k

continued on next page
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Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued

4. Right-click on the new control group and select the Add Controls option.

bis - OpenEdge Architect - C:\OpenEdge\w.... [RI[=l E3

1 Help

|

I} = O || Properties 32 | & L 82 ¥ =0
L;' T oolbox n IultraGrid1 :Infragistics.Win.UItraWinErid.LIItreLI
: i -

% | 2 Microsoft Contrals | Properties | Events |

'E - "
+ | #l OpenEdge Contrals [DataBindings] ;

2 [Marme) ultraGrid1 R
a} 4l OpenEdge Ultra Controlz AccessibleDescrp

I.?‘ = Uzer Contrals AccessibleMame

}* W AcceszibleRole | Default -
{ 4 Cut Cirl+X Ijl—u‘“——l_ —
' ezigner... . Layou

i =2 Copy il Lavout.

"'LL_ 3 Paste Crl+

; ~ Delete =]

i

! Fename Fz

i :

bdake Sticksy for the contral.

: Add Controls... I

J} 15

i Reset Toolbox I + - =08
“‘- Lock Toolbox ProgressWindows. Form

¥ gistics. win LliawinG
'; Add Contral Group Progresz.Data Binding5

i

e PNl ity e By A ALY by ot A1

OpenEdge Architect Tutorial 2009
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Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued

5. Select the ABL Controls tab. Check the box next to the QueryFilter control and
select the OK button.

& Add Controls

Cantrol Group: |U$er Cantrols ;I

Filter: I = |

Browsed Assemblies I Global Azsemblies  ABL Controls /

[~ | Control Mame 4| Mamespace | Directomy
[ | GuenFilker QueryFilter C:/0penE dge

Erowse, . b QK Cancel

continued on next page
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Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued

6. Select the QueryFilter control in the Toolbox and place and position it in the form
as shown below:

okiasiRiukamaaRasinlaisy © TesDrveromds | =0

T oolbox L

|+] Microsoft Controls

|+| DpenEdge Contrals

|+| DpenEdge Ultra Contrals
|=I User Contrals

L Painter

Start! Click 'Start!' to begin designing the UltraGrid

24 hindingS ource

continued on next page
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Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued

7. While the placed control is selected in the form, select the Events tab in the
Properties view. Scroll to find the Load event and type HandleFilterLoad for its
method value. Press the Enter key.

[@openEdge Visual Designer - AutoEdgeisrciTestDrive Form.cls - OpenEdgehrchitect - C:AOpenEdgetw. . [Mi=1 3
File Edit Design Mavigate Search Project OpenEdge Bun ‘Window Help
[Far sl FEO R RN s
E’|3;| OpenEdge Visual Designer & OpenEdge Editor
| & *TestDrieForm ols (Design) 22 TestDriveForm.cls | = B || Properties &2 I w4l ?v =g
&
ot Toolbox n IqueryFiIteﬂ : ClueryFilter LI
iy "
e o= ) Microzoft Controls Properties | Events
& Filter | GO | & =) OpenEdge Corirals GiveFeedback -
C HelpRequested
o +| DpenEdge Ultra Cantrols ImeM odeChangee
Drag a column header hete to group by that calumn = User Controls KeyDown
—
= KepPress
L. Painter Keyllp
'iﬁ QueryFilker Layout
Leave
HandleFilter nad =]
LocationChanged
 arginChanged hd
Load
Oceurs whenever the user control loads.
RS, - . -
continued on next page
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Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued

8. Architect will create a new method using the method name you just entered. You
also will be taken to the editor for the form. Enter the following code in the new
method to set the Text property for the FilterBox and subscribe to the
FilterButton’s click event. You can copy the code from the box below.

&, *TestDriveForm.cls (Design) [ *TestDriveForm.cls 23 l

53
59
ald
61
(25
63
a4
65
ab
a7
[at]
69
70
71
TE
73
74
75
7 6
433

E |
END CCNITRUCTOR.
I —_ —_ —_ e —_ —_ —_
Purpose:
Notes:
®f

BVizualDesigner. /

METHOD PRIVALTE VOID HandleFilterLoad| INPUT sender 43 3ystem.Chject, INFPUT A3
9

gqueryFilterl:FilterBox:Text = "Enter filter for Customer Last Name".
gueryFilterl:FilterButton:Click: Subscribe (THIS-OBJECT:HandleFilterChanged) .

RETUEN. !
END» METHOD.
METHOD FRIVATE VOID InitializeComponenti |:[]
ENI» METHOD.[]

i s, . f.t.-A_AA iy g b, -..w*‘ LN ST T Y W W _-—h._.!._r" et sk

Program: TestDriveForm.cls

queryFilterl:FilterBox:Text = "Enter filter for Customer Last Name".
queryFilterl:FilterButton:Click:Subscribe(THIS-OBJECT:HandleFilterChanged).

OpenEdge Architect Tutorial 2009

Copyright © 2008 PSC

continued on next page

273



Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued

9. Create a new method as shown below to handle the FilterButton’s click event.
You can copy the code from the box below.

ala

&, *TestDriveFaorm.cls (Design) l *TestDriveForm.cls &2 l

a7

1] queryFilterl:FilterBox:Text = "Enter filter for Custower Last Nsae™.

(1] queryFilterl:FilterButton:Click: Subscrikbe (THIS-OBJECT: HandleFilterChanged) .
70

71 RETURN.

7z

73 ENI» METHCD.

74 (f" "‘\
75 METHOD PRIVATE WOID HandleFilterChanged

76 [sender A% CLASS System.Chject, L3 CLASE System.Eventlirgs):

77 DEFINE WARIAELE cFilter A% CHARACTER MNO-UNDGC.

78

79 cFilcer = gueryFilcerl:FilterBox:Text.

80 IF cFilter NE ™" THEM cFilter =

51 "WHERE ttlustomer.CustomerlLastNsmwe BEGINS '™ + cFilter + "'F,

82

53 hhataSource: TOP-NAV-QUERY (1) : QUERY-FPREPARE ("FOR ELCH ttcCustomer " + cFilter).
54 hhataSource: TOP-NAV-QUERY (1) : QUERY-OFPEN.

55

(=141 RETURN.

g7 END' METHCD.

AN J
83 |

=1k METHOD PRIVATE VOID InitializeComponent | [HE
447 END METHCD.[]
445

--_..-1—|_.,.—-~~-_; Tl A —————. R ——

Program: TestDriveForm.cls

METHOD PRIVATE VOID HandleFilterChanged
(sender AS CLASS System.Object, AS CLASS System.EventArgs):
DEFINE VARIABLE cFilter AS CHARACTER NO-UNDO.

cFilter = queryFilterl:FilterBox:Text.
IF cFilter NE """ THEN cFilter =
"WHERE ttCustomer.CustomerLastName BEGINS "' + cFilter + """.

hDataSource: TOP-NAV-QUERY (1) : QUERY-PREPARE("'FOR EACH ttCustomer " + cFilter).
hDataSource: TOP-NAV-QUERY (1) : QUERY-OPEN.

RETURN.
END METHOD.

continued on next page
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Lab 10 — Using the Visual Designer, continued

Working with User Controls, continued
10. Save the file.
11. Select the TestDriveForm.cls (Design Form) tab.
12. Run the program using the Generic Run launch configuration.

13. Test the new functionality by entering W in the Filter box and selecting the GO
button. Make sure the filter worked by showing only customers with a last name
that starts with W. Also, select some of the nodes.

TestDriveForm _ O] x|
Filter [ x DGD |

Drag a column header here to group by that colummn.

Last [Farily] Mame Firgt Mame kiddle Mame Drate of IS
— wallace Secatt 0742318
il Margaret M. 017201
£ #ashingtan Alice k. 05419/1¢
Testdrive Date-Time Drealer Id MHeed Eval? Approve
[_]_ 05/23/2009 F305:744-1385- . r [
L Dezcription Added Car D
i Green Potomoc A 11/18/2008

; v fa06e7e _
4| | 3

14. Close the application.

15. Close Architect.
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